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1	�  
Description

GeneMarker®HID Software for Spectrum CE Systems (GMHID-Spectrum) is designed for 
analysis of short tandem repeat (STR) data generated by capillary electrophoresis (CE) systems, 
including the Spectrum CE Systems*. GMHID-Spectrum allows genotyping using an allelic 
ladder and is optimized for human identification applications including forensic casework 
analysis, databasing, missing persons and relationship testing. GMHID-Spectrum provides a 
suite of integrated post-genotyping applications, including: 

•	 expert system review

•	 database creation and profile searching

•	 contamination check

•	 kinship analysis

•	 population statistics calculation 

GMHID-Spectrum is compatible with commercial STR chemistries, including PowerPlex® and 
GenePrint® Systems from Promega and custom STR chemistries. The software supports CE 
instrument data files from numerous platforms, including Promega (.promega, .fsa) and Applied 
Biosystems (.fsa, .hid). GMHID-Spectrum is developed by SoftGenetics, LLC, and is sold and 
supported by Promega Corporation. Please review the end user license agreement (EULA) 
during installation or view it at: www.softgenetics.com/gmhid-spectrumeula

*GMHID-Spectrum also supports analysis of STR data from Applied Biosystems 3130, 3130xl, 3500 and 3500xL Genetic 
Analyzers.

1.A.	 Product Listing 

P R O D U C T 	 C AT. #

GeneMarker®HID Software for Spectrum CE Systems, Local	 CE3001

GeneMarker®HID Software for Spectrum CE Systems, Network	 CE3010

GeneMarker®HID Software for Spectrum CE Systems, Client	 CE3011
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2	� Installing GeneMarker®HID Software for 
Spectrum CE Systems

2.A.	 Computer System Requirements

Promega recommends the following computer configuration for installation and use of  
GMHID-Spectrum:

•	 Windows® 10 Operating System

•	 Dual-core processor

•	 ≥4GB RAM and 256GB of available disk storage

Computer systems with lower specifications can operate GMHID-Spectrum but have not been 
tested at Promega.

2.B.	 Installation and Licensing Options

GMHID-Spectrum is available for download at: www.promega.com/gmhid/

A Software Registration Document will be provided following the purchase of GMHID-
Spectrum. The document will provide instructions to download the software along with license 
password(s) to register the software following installation.

There are two licensing options available for GMHID-Spectrum: local and network (with client 
installation(s)). With a local license, each license is installed on and registered to a specific 
computer. With a network license, GMHID-Spectrum client installations share their licensing 
information with a central License Server Manager over a network. Further information and 
installation instructions for each setup are described below.

GMHID-Spectrum can be installed as a 35-day trial version without purchasing a license.
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2.B.1	 Installing and Activating GMHID-Spectrum in 35-Day Trial Version
Installing GMHID-Spectrum

1.	 The software will download as a compressed folder. Extract the contents of the folder to 
the desired location, then open the folder. 

2.	 Double-click the GeneMarker HID [VX.x.x] Spectrum Installer executable file (.exe).

3.	 The setup wizard will launch, displaying the ‘License Agreement’ window (Figure 1).

Figure 1. 
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‘License Agreement’ window. 

4.	 Read the SoftGenetics End User License Agreement (EULA) and select the I Agree 
button. The EULA can also be reviewed at:  
www.softgenetics.com/gmhid-spectrumeula

5.	 Select Main in the ‘Select components to install’ field of the ‘Choose Components’ 
window (Figure 2), then select Next.

Figure 2. 
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 Selecting Main in the ‘Choose Components’ window.

6.	 Select the Destination Folder for the software in the ‘Choose Install Location’ window  
(Figure 3), then select Next. 

	 Note: The default location is C:\Program Files (x86)\SoftGenetics\GeneMarker_HID\
[VX.x.x]. To choose a different location, select the Browse… button and navigate to the 
desired location.
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Figure 3. ‘
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Choose Install Location’ window. 

7.	 Choose the Start Menu Folder for the software’s shortcuts in the ‘Choose Start Menu 
Folder’ window (Figure 4), then select Install. 

	 Note: If you do not want software shortcuts, select the “Do not create shortcuts” check 
box. 

Figure 4. 
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‘Choose Start Menu Folder’ window.

8.	 Select Close in the ‘Installation Complete’ window (Figure 5).

Figure 5. 
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‘Installation Complete’ window.
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Activating a 35-Day Trial Period

1.	 Double-click the GeneMarkerHID desktop icon or navigate to the destination folder 
location selected during installation and double-click GeneMarker_HID.exe to launch the 
software. 

2.	 Select Run Validation in the ‘Configure’ window (Figure 6).

Figure 6. 
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‘Configure’ window.

A ‘Trial License’ window indicating the number of trial days remaining, is displayed each time 
the software is launched during the trial period (Figure 7). At the end of the trial period, the 
‘Trial License’ window will indicate the trial period is over and the software will not open without 
registration of a local or network license. To purchase a GMHID-Spectrum license to continue 
use after the trial period, please contact your Promega representative or e-mail:  
genetic@promega.com 

Once you receive your license password, follow the registration instructions for your purchased 
license setup (see Section 2.B.2 for a local license or Section 2.B.3 for a network license). 

Figure 7. 
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52

5T
A

‘Trial License’ window.

2.B.2	 Installing and Registering GMHID-Spectrum with a Local License
Installing a Local License

1.	 The software will download as a compressed folder. Extract the contents of the folder to 
the desired location, then open the folder. 
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2.	 Double-click GeneMarker_HID [VX.x.x] for Spectrum CE Systems_setup executable file 
(.exe).

3.	 The setup wizard will launch, displaying the ‘License Agreement’ window (Figure 8).

Figure 8. 
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‘License Agreement’ window. 

4.	 Read the SoftGenetics End User License Agreement (EULA) and select the I Agree button. 
The EULA can also be reviewed at: www.softgenetics.com/gmhid-spectrumeula

5.	 Select Main in the ‘Select components to install’ field of the ‘Choose Components’ window 
(Figure 9), then select Next.

Figure 9. 

17
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 Selecting Main in the ‘Choose Components’ window.

6.	 Select the Destination Folder for the software in the ‘Choose Install Location’ window  
(Figure 10), then select Next. 

	 Note: The default location is C:\Program Files (x86)\SoftGenetics\GeneMarker_HID\
[VX.x.x]. To select a different location, select the Browse… button and navigate to the 
desired location.
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Figure 10. 
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‘Choose Install Location’ window. 

7.	 Choose the Start Menu Folder for the software’s shortcuts in the ‘Choose Start Menu 
Folder’ window (Figure 11), then select Install. 

	 Note: If you do not want software shortcuts, select the “Do not create shortcuts” check 
box. 

Figure 11. 
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‘Choose Start Menu Folder’ window.

8.	 Select Close in the ‘Installation Complete’ window (Figure 12).

Figure 12. 
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‘Installation Complete’ window.
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Registering a Local License

1.	 Double-click the GeneMarkerHID desktop icon or navigate to the destination folder location 
selected during installation and double-click GeneMarker_HID.exe to launch the software.

2.	 Select Register Now in the ‘Configure’ window (Figure 13).

Figure 13. 
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 ‘Configure’ window.

3.	 Select Register Local Text-based Key in the ‘Choose Registration Method’ window  
(Figure 14). This opens the ‘GeneMarker HID Registration’ window (Figure 15). The Request 
Code is automatically generated by the software. 

Figure 14. ‘
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Choose Registration Method’ window.

Figure 15. ‘G
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eneMarkerHID Registration’ window.

4.	 Locate the password in your Software Registration Document.
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Online Registration 

1.	 If you installed GMHID-Spectrum on a computer with an internet connection, enter your 
Account (GMHIDSPECTRUM), password and e-mail address, then select Register. 

2.	 A confirmation e-mail will be sent once registration is complete.

3.	 A ‘Registration Success’ window appears upon successful completion of registration. 
Select OK to close the window.

Notes: 

a.	� Some characters can commonly be misread. If you get an error trying to register, check 
for possible confusion between number “1” and lowercase letter “L” or number “0” and 
uppercase letter “O”.

b.	� For internet connections that use a proxy server, proxy information can be entered to aid 
connection for Online Registration. 

1.	 Select Proxy Settings from the File menu of the ‘GeneMarker HID Registration’ window 
(Figure 16) to open the ‘Proxy Settings’ window (Figure 17).

Figure 16. 
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Accessing the ‘Proxy Settings’ window from the ‘GeneMarker HID Registration’ window.

Figure 17. 
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‘Proxy Settings’ window.
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2.	 Select the “Enabled” check box to activate proxy connection for registration.

3.	 Select the proxy type from the drop-down list. Selecting “Default Proxy” will use the proxy 
settings for the Windows® connection and does not require the other settings in this 
window to be completed.

4.	 Enter the host, port, username, password and any needed exceptions for the proxy 
connection. 

5.	 Select Save to apply the proxy settings and return to the ‘GeneMarker HID Registration’ 
window. 

Manual Registration

If the Online Registration process failed, select the “Manual Registration” check box in the 
‘GeneMarker HID Registration’ window (Figure 18). 

Figure 18. 
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Selecting ‘Manual Registration’ from the ‘GeneMarker HID Registration’ window.

1.	 If the computer does not have an internet connection, select the Copy button to the right of 
the RequestID field. Then, from a computer with internet connection, navigate to the web 
site: https://softgenetics.com/releasereg/ng_register.jsp to access the Website 
Registration form (Figure 19).

Figure 19. 
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The Website Registration form.
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	 Alternatively, if the computer does have an internet connection, select Open Website 
Registration from the File menu of the ‘GeneMarker HID Registration’ window (Figure 20) 
to open the Website Registration form in an internet browser (Figure 19).

Figure 20. 
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Accessing Website Registration from the ‘GeneMarker HID Registration’ window.

2.	 Select GeneMarker HID from the Product drop-down field. Paste the Request ID into the 
form, type your Account (GMHIDSPECTRUM), password and e-mail address, then select 
Register.

	 Note: The Product name and Request ID are automatically populated when the Open 
Website Registration command is used.

3.	 A Registration Code will appear on the web page and a confirmation e-mail will be sent. 

4.	 Copy the Registration Code from the web page. 

5.	 Select the Paste button to the right of the Registration Code field of the ‘GeneMarker HID 
Registration’ window.  

	 Note: When completing Manual Registration, the Account, Password and Email fields of 
the ‘GeneMarker HID Registration’ window do not need to be completed.

6.	 A ‘Registration Success’ window appears when registration is successfully completed. 
Select OK to close the window.
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If registration via the Website Registration form fails, a Registration Code for Manual 
Registration can be obtained by contact ing Soft Genetics’ Technical Support.

1.	 Select the Copy button to the right of the RequestID field from the ‘GeneMarker HID 
Registration’ window (Figure 18). Paste the ID and type your Account (GMHIDSPECTRUM) 
and password into the body of an e-mail and send it to: tech_support@softgenetics.com

2.	 A Registration Code will be sent to you, via e-mail, within one business day. 

	 Note: The Registration Code is unique to this registration event and must be used within 4 
days.

3.	 Copy the Registration Code from the e-mail. 

4.	 Select the Paste button to the right of the Registration Code field of the ‘GeneMarker HID 
Registration’ window.  

	 Note: When completing Manual Registration, the Account, Password and Email fields of 
the ‘GeneMarker HID Registration’ window do not need to be completed.

5.	 A ‘Registration Success’ window appears when registration is successfully completed. 
Select OK to close the window.

2.B.3	 Installing and Registering GMHID-Spectrum for Network and Client Use 
With a network/client license, GMHID-Spectrum installations share their licensing information 
over a local network. GMHID-Spectrum can be installed on multiple computers, but the 
maximum number of simultaneous users equals the number of purchased client licenses. 
The computer where the License Server Manager (LSM) Program is installed is considered the 
Server computer. Computers on the network other than the Server are called Client computers. 
GMHID-Spectrum must first be installed and registered on the Server computer before it can be 
installed on Client computers. 

Note: The LSM controls which computers can access GMHID-Spectrum. If the computer 
running the LSM is turned off, no computer will be able to access GMHID-Spectrum, as the 
LSM will be nonfunctional. For this reason, we recommend that the LSM be installed on a 
computer that is always on, or always on during working hours.

Installing the LSM will require you to restart the system to complete installation. Save all work 
and close all applications before installing the LSM. The LSM uses text-based registration—no 
hardware is required. Both software components are installed from the same executable file 
(.exe). 
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2.B.3.A	 Installing and Registering a Network License

Installing a Network License

1.	 The software will download as a compressed folder. Extract the contents of the folder to 
the desired location, then double-click the folder. 

2.	 Double-click GeneMarker_HID [VX.x.x] for Spectrum CE Systems_setup executable file 
(.exe). 

3.	 The setup wizard will launch, displaying the ‘License Agreement’ window (Figure 15).

Figure 21. ‘

17
10

3T
A

License Agreement’ window.

4.	 Read the SoftGenetics End User License Agreement (EULA) and select I Agree (Figure 15). 
The EULA can also be reviewed at: www.softgenetics.com/gmhid-spectrumeula

5.	 Select License Server Manager in the ‘Select components to install’ field of the ‘Choose 
Components’ window (Figure 16), then select Next.

Figure 22. 

17
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‘Choose Components’ window.
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6.	 The setup wizard will first install GMHID-Spectrum. Choose the Destination Folder for the 
software in the ‘Choose Install Location’ window (Figure 17), then select Next. 

	 Note: The default location is C:\Program Files (x86)\SoftGenetics\GeneMarker_HID\
[VX.x.x]. To choose a different location, select the Browse… button and navigate to the 
desired location.

Figure 23. 

17
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‘Choose Install Location’ window.

7.	 Choose the Start Menu Folder for the software shortcuts in the ‘Choose Start Menu Folder’ 
window (Figure 24), then select Install. 

	 Note: If you do not want software shortcuts, select the “Do not create shortcuts” check 
box. 

Figure 24. 

18
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‘Choose Start Menu Folder’ window.
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8.	 Select Close in the ‘Installation Complete’ window (Figure 25).

Figure 25. 
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‘Installation Complete’ window.

9.	 The SoftGenetics License Server Setup wizard will launch after GMHID-Spectrum 
installation is complete (Figure 26). Select Next.

Figure 26. 
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‘Welcome to the SoftGenetics License Server [VX.x.x] Setup’ window.
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10.	 Read the SoftGenetics End User License Agreement (EULA) and select the I Agree button 
in the ‘License Agreement’ window (Figure 27). The EULA can also be reviewed at:  
www.softgenetics.com/gmhid-spectrumeula

Figure 27. 

18
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‘License Agreement’ window.

11.	 Choose the Destination Folder for the software in the ‘Choose Install Location’ window 
(Figure 28), then select Next.

	 Note: The default location is C:\Program Files (x86)\SoftGenetics\License Server. To 
choose a different location, select the Browse… button and navigate to the desired 
location. 

Figure 28. 
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‘Choose Install Location’ window.
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12.	 Choose the Start Menu Folder for the software’s shortcuts in the ‘Choose Start Menu 
Folder’ window (Figure 29), then select Install. 

	 Note: If you do not want software shortcuts, select the “Do not create shortcuts” check 
box. 

Figure 29. 
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‘Choose Start Menu Folder’ window.

13.	 Select Next in the ‘Installation Complete’ window (Figure 30).

Figure 30. 

18
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‘Installation Complete’ window. 
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14.	 Select Finish in the ‘Completing SoftGenetics License Server [vX.x.x] Setup’ window  
(Figure 31).

Figure 31. 
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‘Completing SoftGenetics License Server [vX.x.x] Setup’ window.

Registering a Network License

1. 	 The LSM should launch after installation. If the LSM did not launch, double-click the LSM 
icon in your system icons tray (Figure 18) or navigate to the destination folder location 
selected during installation and double-click the LicenseServer.exe.

Figure 32. 
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‘LSM’ icon.

2.	 Select the Register menu in the ‘SoftGenetics License Server Manager’ window (Figure 19).

Figure 33. 

17
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‘SoftGenetics License Server Manager’ window.
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3.	 Select GeneMarker HID from the ‘Register Product Name’ drop-down list of the 
‘SoftGenetics Product Registration' window (Figure 34). The Request Code is automatically 
generated by the software. 

4.	 Locate the password in your Software Registration Document.

Figure 34. 

17
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‘SoftGenetics Product Registration’ window.
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Online Registration

1.	 If you installed the LSM on a computer with an internet connection, enter your Account 
(GMHIDSPECTRUM), password and e-mail address under the ‘Register Online’ tab, then 
select Register.

2.	 An ‘Info’ window will appear indicating the registration succeeded. Select OK. An ‘Action 
Info’ window will appear indicating the LSM will reload the license data. Select OK.

3.	 GeneMarkerHID is now in the ‘Registered Products’ list of the LSM (Figure 21). The server 
name or IP address of the computer where the LSM is installed is displayed in the lower 
left corner of the LSM in the format ‘servername or IPaddress:portnumber’. Record the 
server name or IP address for use in configuring client computers (Section 2.B.3.B). 
Note: Some characters can commonly be misread. If you get an error when trying to 
register, check for possible confusion between the number “1” and lowercase letter “L” or 
number “0” and uppercase letter “O”. 

Figure 35. 
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Registered Products and server name or IP address in the ‘SoftGenetics License Server Manager’ 
window.
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Note: For internet connections that utilize a proxy server, proxy information can be entered to 
aid connection for Online Registration. 

1.	 Select Proxy Settings from the ‘File’ menu of the ‘SoftGenetics Product Registration’ 
window (Figure 36) to open the ‘Proxy Settings’ window (Figure 37).

Figure 36.  
18
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Accessing the ‘Proxy Settings’ window from the ‘SoftGenetics Product Registration’ window.

Figure 37. 
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‘Proxy Settings’ window.

2.	 Select the “Enabled” check box to activate proxy connection for registration.

3.	 Select the proxy type from the drop-down list. Selecting Default Proxy will use the proxy 
settings for the Windows® connection and does not require the other settings in this 
window to be completed.

4.	 Enter the host, port, username, password and any needed exceptions for the proxy 
connection. 

5.	 Select Save to apply the proxy settings and return to the ‘SoftGenetics Product 
Registration’ window. 
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Manual Registration 

If the Online Registration process failed, select the “Manual Registration” check box  in the 
‘SoftGenetics Product Registration’ window (Figure 38). 

Figure 38. 
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Selecting ‘Manual Registration’ from the ‘SoftGenetics Product Registration’ window.

1.	 If the computer does not have an internet connection, select the Copy button to the right of 
the ‘RequestID’ field. Then, from a computer with internet connection, navigate to the 
website: https://softgenetics.com/releasereg/ng_register.jsp to access the Website 
Registration form (Figure 39).

Figure 39. 
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The Website Registration form.
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	 Alternatively, if the computer does have an internet connection, select Open Website 
Registration from the File menu of the ‘SoftGenetics Product Registration’ window  
(Figure 40) to open the Website Registration form in an internet browser (Figure 39).

Figure 40. 
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Accessing Website Registration from the ‘SoftGenetics Product Registration’ window.

2.	 Select ‘GeneMarker HID’ from the Product drop-down field. Paste the Request ID into the 
form, type your Account (GMHIDSPECTRUM), password and e-mail address, then select 
Register.

	 Note: The Product name and Request ID are automatically populated when the Open 
Website Registration command is used.

3.	 A Registration Code will appear on the webpage and a confirmation e-mail will be sent. 

4.	 Copy the Registration Code from the webpage. 

5.	 Select the Paste button to the right of the ‘Registration Code’ field of the ‘SoftGenetics 
Product Registration’ window.  

	 Note: When completing Manual Registration, the Account, Password and Email fields of 
the ‘SoftGenetics Product Registration’ window do not need to be completed.

6.	 A ‘Registration Success’ window appears upon successful completion of registration. 
Select OK to close the window.

If registration via the Website Registration form fails, a Registration Code for Manual 
Registration can be obtained by contacting SoftGenetics’ Technical Support.

1.	 Select the Copy button to the right of the ‘RequestID’ field from the ‘SoftGenetics Product 
Registration’ window (Figure 38). Paste the ID and type your Account (GMHIDSPECTRUM) 
and password into the body of an e-mail and send it to: tech_support@softgenetics.com

2.	 A Registration Code will be sent to you, via e-mail, within one business day. 

	 Note: The Registration Code is unique to this registration event and must be used within 4 
days from generation.

3.	 Copy the Registration Code from the e-mail. 
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4.	 Select the Paste button to the right of the ‘Registration Code’ field of the ‘SoftGenetics 
Product Registration’ window.  

	 Note: When completing Manual Registration, the Account, Password and Email fields of 
the ‘SoftGenetics Product Registration’ window do not need to be completed.

5.	 A ‘Registration Success’ window appears upon successful completion of registration. 
Select OK to close the window.

2.B.3.B	 Installing and Configuring on a Client Computer
After an LSM has been installed and registered on a Server computer, GMHID-Spectrum must 
be installed on client computers, and then configured to the LSM. When configured as a Client, 
GMHID-Spectrum can be installed on as many computers as desired.

1.	 Install GMHID-Spectrum on the Client computer as described in Section 2.B.1.

2.	 Double-click the GeneMarkerHID desktop icon or navigate to the destination folder 
location selected during installation and double-click GeneMarker_HID.exe to launch the 
software.

3.	 Select Configure Network Client in the ‘Configure’ window (Figure 41).

Figure 41. 
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‘Configure’ window.

4.	 Select Configure Connection to License Server Manager in the ‘Choose Network 
Configuration’ window (Figure 42).

Figure 42. 
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‘Choose Network Configuration’ window.
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5.	 Enter the Server Name or Server IP Address of the computer where the LSM is installed 
(Figure 43).  
Note: This information is located in the lower left corner of the ‘SoftGenetics License 
Server Manager’ window (Figure 35).

Figure 43. 
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Entering server information in the ‘Choose Network Configuration’ window.

6.	 Select the ‘Configure’ button. An ‘Info’ window will appear indicating the registration 
succeeded. Select OK. A confirmation window appears if the configuration was successful. 
Select OK.

2.B.4	 Updating Software Version
When new versions of GMHID-Spectrum are made available, you can update licenses and 
install the latest version. 

Updating the Software Version of a Local License Installation

To update the version of a local license installation, follow the instructions outlined in “Installing and 
Registering GMHID-Spectrum with a Local License” using the updated version setup file  
(Section 2.B.1). 

When using a local license, each version of GMHID-Spectrum will be installed in its own 
version-specific directory. Thus, installing a new version of the program will not overwrite any 
previous installations. Custom panels, size standards and other files can then be transferred 
from the old version to the new version, if desired.

Updating the Software Version for a Network/Client License Installation

When using a network license and client installations, the LSM software installation must first 
be updated before each client computer is updated. 

To update the LSM, open the ‘License Server Manager’ application and follow ‘Registering a 
Network License’ (Section 2.B.3.A). After the LSM is updated, update each Client computer 
by following the instructions outlined in ‘Installing and Configuring a Client License’ 
(Section 2.B.3.B). If the network configuration for the LSM has not changed, the client 
installations of the software should activate without configuring the IP address of the LSM. 



30      GeneMarker®HID Software for Spectrum CE Systems | TM555 | Revised 1/23

Installing GeneMarker®HID Software for Spectrum CE Systems

User Management of Client Installations

While the number of client installations for a Network License is unlimited, the number of 
concurrent active users is defined by the number of purchased “seats”. To ensure continued 
access to the available client seats, we recommend enabling the ‘Overtime Protection’ setting 
in the User Manager (Section 6.F), which automatically logs out an inactive user after a 
specified period of time.

2.C.	 Managing Program Template Files

GMHID-Spectrum uses configuration settings files (.ini) for a series of program templates. 
These program template files can be shared across software installations for consistency. The 
software reads and writes to the program template files from their default file location  
(C:\Users\Public\SoftGenetics; see Table 1). 

Table 1. Program Template File Locations.

Program Template
Configuration  

Settings (.ini) file

CODIS CMF (Section 6.D) codis.ini

Positive Controls (Section 6.E) PositiveControls.ini

Run Wizard (Section 4.A) RunWizardTemplates.ini

Sample and Allele Comments  
(Sections 3.C.1 and 5.B.3)

CommentsTemplates.ini

Preferences (Section 6.B) Preferences.ini

Print (Section 9) PrintTemplates.ini

The location of the CODIS CMF, positive controls, Run Wizard, sample and allele comments 
and print program templates are managed from the ‘Program Data Folders’ section of the 
‘Others’ tab of the ‘Preferences’ window (Section 6.B). Copies of the factory-default settings 
of these five program template files are stored in the C:\Program Files (x86)\SoftGenetics\
GeneMarker_HID\VX.x.x folder. To restore the factory-default settings of these program 
template files, copy the appropriate files from the x86 folder and paste them into the ‘Program 
Data Folders’ location. 

Notes:

a.	 The sample and allele comments and print program template files are written to the 
default file directory the first time a comment and print template are saved in the program.

b.	 You may need to delete the GeneMarker_HID_Spectrum.ini file stored in the  
C:\Users\[user name]\AppData\Roaming\SoftGenetics\GeneMarker_HID folder to reset 
the Preferences template.
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2.D.	 Uninstalling the Software

To uninstall GMHID-Spectrum navigate to  
C:\Program Files (x86)\SoftGenetics\GeneMarker_HID\VX.x.x for Spectrum CE Systems 
and run the GeneMarker_HID_Uninstall.exe application. Program template files saved in the 
C:\Program Files (x86)\SoftGenetics\GeneMarker_HID\VX.x.x for Spectrum CE Systems 
location will be deleted during the uninstall process. Program template files saved outside of 
this location will be retained and must be deleted by the user if no longer needed.
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Preparing for STR Analysis

3.A.	 Getting Started: Overview

After installing GMHID-Spectrum, a shortcut icon will be displayed on the desktop. 

Double-click the icon to open the software. Alternatively, navigate to the ‘Start’ menu (of the 
Windows® 10 operating system) and select GeneMarker®HID Software for Spectrum CE 
Systems from the list of programs. 

Upon starting GMHID-Spectrum, the launch screen will appear (Figure 44). This screen has 
a Menu Bar, a Toolbar Ribbon, a File Navigator and a Splash Screen. If the Magic Wizard 
is enabled as the Run Method for Start up (Section 6.B), the ‘Start Your Project’ window 
(Section 3.B) will also be displayed.

Figure 44. GMHID-Spectrum launch screen. 

Menu Bar Toolbar RibbonFile Navigator Splash Screen
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The Menu Bar provides access to the six menu options (‘File’, ‘View’, ‘Project’, ‘Applications’, 
‘Tools’ and ‘Help’) that remain static throughout the program and are described in following 
sections. The Toolbar Ribbon provides shortcut icons to several menu actions. The toolbar 
icons displayed in the ribbon vary, depending on the state of analysis. Before STR data files 
are imported, six shortcuts are available for use in the Toolbar Ribbon: Open Data, Show/Hide 
Navigator, Show/Hide Report, Preferences, Event Log and Magic Wizard. The File Navigator 
displays an untitled folder when the program is in this state.
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3.B.	 Importing Data Files

To begin fragment analysis, you must upload raw data files to the program. Table 2 shows the 
list of file types supported by GMHID-Spectrum. 

Note: GMHID-Spectrum analyzes one STR chemistry per project. STR data from different 
chemistries (e.g., PowerPlex® Fusion 6C and PowerPlex® Y23 Systems) must be imported 
separately into their own projects. 

Table 2.  File Types Supported by GMHID-Spectrum.

Instrument Provider File Format

Promega .fsa, .promega

Applied Biosystems .fsa, .hid

Data files are imported into the software using the ‘Open Data’ command. There are three 
places to access the ‘Open Data’ command: The ‘Start your project’ window of the Magic 
Wizard, the ‘Open Data’ icon in the Toolbar Ribbon and the ‘Open Data’ option under the ‘File’ 
menu (Figure 45).

Figure 45. 
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‘Open Data’ options.
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If the Magic Wizard (Section 6.E) is enabled as the Run Method for Start up (Section 6.B), the 
‘Start your project’ window will be displayed when the software is launched. To import data 
files, select Open Data from the ‘Start your project’ window. Alternatively, Open Data can be 
selected from the toolbar or the ‘File’ menu. This will launch the ‘Open Data Files’ window 
(Figure 46). The ‘Open Data Files’ window provides several features that streamline the file 
importing process and customize how the data is processed upon import.

There are four buttons along the right side to define which raw data files will be imported: ‘Add’, 
‘Remove’, ‘Remove All’ and ‘Add Folder...’ (Figure 28). The ‘Dyes...’ button at the bottom allows 
you to define dye color names.  

Figure 46. 
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‘Open Data Files’ window.

Dyes: Opens the ‘Chemistry Dye Set’ window (Figure 29), which allows you to define the names 
for the dye channels in a given kit. The dye names as defined in this window will be displayed in 
the ‘Main Analysis’ screen and in any report where the dye display is selected in the print report 
settings (Section 9, Printing). Chemistry dye sets are organized by the number of dye colors 
in a kit: 4 Colors, 5 Colors, 6 Colors or 8 Colors. Select the appropriate tab at the top of the 
window to view or edit chemistry dye sets. The default setting for each tab is ‘Universal’. Under 
this setting the dye names are listed as dye colors. Alternatively, dye names can be defined for 
specific manufacturers (e.g., AB and Promega) using the drop-down menu under the ‘Default’ 
heading (Figure 47). 

Figure 47. 
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 ‘Chemistry Dye Set’ window showing dye names listed as dye colors.
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Alternatively, a new chemistry dye set can be created by selecting the Create New icon to the 
right of the drop-down menu. This opens a ‘User Chemistry’ window. Enter the chemistry name 
in the provided field and select OK. The new dye set will now appear in the drop-down menu. 
Enter the appropriate dye names in the ‘Name’ fields. Edits to the dye names are automatically 
saved. To delete a user-defined chemistry dye set, select the chemistry dye set from the drop-
down menu and click the Delete button to the right of the drop-down menu.  
Note: Only user-defined chemistry dye sets can be edited or deleted. Pre-installed chemistry 
dye sets, which are marked with an asterisk, cannot be edited or deleted.

Add Folder: Opens a browser window that allows you to navigate to a folder from which raw 
data will be selected for import. The default folder location is set in Preferences (Section 6.B).

Add: Opens the ‘Open’ window that allows you to designate a folder from which raw data will 
be selected for import when the ‘Add’ button is selected. Select all files with CTRL + A, use 
CTRL to select individual files or use Shift to select groups of files. Select Open to close the 
browser and add the selected files to the ‘Data File List’ field in the ‘Open Data Files’ window. 
This process can be repeated to import files from different folders to the same project. The 
default folder location is set in Preferences (Section 6.B). This folder location can also be 
modified using the ‘Add Folder’ button.

Note: The four most recently accessed directories can be opened via the arrow next to the ‘Add’ 
button. 

Remove: Removes selected files from the Data File List so that they are not imported.

Remove All: Removes all files from the Data File List. 

Alternatively, you can copy files from a folder outside of GMHID-Spectrum and paste via  
Control + V or right-clicking and selecting Paste From Clipboard. You can also remove 
samples from the Data File List via this right-click menu. 

When the desired files are listed in the ‘Data File List’ field, select OK to import the raw data files 
into the software. A ‘Loading Files…’ processing window will appear as the files are uploaded. 
Files that are successfully loaded will be marked Completed (Figure 48). Files that are corrupt 
or cannot be loaded will be marked Failed. The ‘Loading Files…’ window will automatically close 
once all files are processed.
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Figure 48. 
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 Completed status of ‘Loading Files...’ window.

3.C.	 Raw Data Analysis

Once the raw data files are uploaded, the ‘Main Analysis’ window appears showing raw data 
(Figure 49). The File Navigator now contains a Sample File Tree listing the imported raw data 
files. These raw data files remain accessible via the ‘Raw Data’ folder in the File Navigator 
throughout the analysis process. 

Figure 49. ‘
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Electropherogram

Sample File Tree

Project Summary Bar

Main Analysis’ window showing raw data.
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The raw data electropherogram charts or electropherograms of selected samples are 
displayed in the center of the screen. If no samples are selected this area will be blank. A 
Project Summary Bar that summarizes project information by state, number of samples, and 
quality status, is now available at the bottom of the screen. Quality metrics are not applied until 
the data files are analyzed (Section 10). Additional shortcuts are now available in the toolbar 
ribbon to assist with raw data analysis. 
Table 3. Toolbar Ribbon Icons of the ‘Raw Data Main Analysis’ window.
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Open Data: Opens the ‘Open Data Files’ window to begin analysis. 

16
70

3T
A Run Project: Opens the Run Wizard to process the data.

16
70

4T
A Show/Hide Toggles: Displays or hides the File Navigator, Gel Image and 

Report Table, respectively.

Preferences: Opens the ‘Preferences’ window of the View menu (Section 6.B).

16
70

6T
A Show Dye: Select specific dye channels, show all dye channels or hide all 

dye channels by selecting the down arrow. To cycle through individual dye 
channels, click on the icon. 

16
70

7T
A Zoom In: Zooms in on the center point of the electropherogram.

16
70

8T
A Zoom Out: Zooms out from the center point of the electropherogram. 

16
71

0T
A Set Axis: Provides options to set x and y axes of the electropherogram. The 

default setting automatically sets the y axis according to the maximum 
peak intensity (Auto Fit Y) and the x axis according to the analysis range 
(Auto Fit X). Set specific ranges for the x and y axes by selecting Fixed X 
and Fixed Y (Figure 38, Section 3.C.2).

16
71

1T
A Browse by All Colors: Opens the All Color Browser, which displays sample 

electropherograms with dye colors separated by individual dye channels 
(Section 5.C).

16
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Open Charts Group: Allows the user to toggle between sets of open 
electropherograms displayed in the ‘Main Analysis’ window. This option 
is most useful when the number of samples in the dataset exceeds the 
computer’s ability to display all at once. This typically occurs when several 
plates of data are uploaded to the project.

16
71

2T
A Event Log: Opens the ‘Events’ window, which displays the status of the last 

event performed for each sample while loading files and data processing. 

16
71

3T
A Magic Wizard: Activates the ‘Start your project’, ‘Run’ or ‘Report’  

windows, depending on the current stage of data processing (Section 6.E).
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3.C.1	 Navigating the Sample File Tree
The ‘Raw Data’ folder in the File Navigator section contains a ‘Sample File Tree’ list of all 
imported sample files. By default, the first sample in the tree is selected and its raw data plot is 
displayed in the electropherogram window. To select or deselect individual samples for review, 
double-click the samples in the Sample File Tree.

Right-clicking the sample file name provides additional viewing and analysis options (Figure 50).

17
11

0T
A

Figure 50. Navigating the Sample File Tree.

Select Page: Opens electropherograms for the number of samples specified in the ‘Max # in 
Page’ field in the ‘Display’ tab of the ‘Preferences’ window (Section 6.B). Use Page Up/Page 
Down at the bottom of the File Navigator for shortcuts to this process.

Select Next Group: Opens the next group of electropherograms. The number of 
electropherograms opened as a group is based on the current number of selected samples, 
regardless of the method of selection (Select Page, Select Max, Sample Grouping (Section 12) or 
double-clicking individual samples). 
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Select Max: Opens electropherograms for the number of samples specified in the ‘Max # of 
Open Charts’ field in the ‘Display’ tab of the ‘Preferences’ window (Section 6.B). If Max # of 
Open Charts is not selected in the ‘Preferences’ window, all electropherograms in the project 
will open when Select Max is chosen.

De-select All: De-selects all selected samples in the ‘Sample File Tree’ list and closes the 
electropherograms.

Search File: Opens the ‘File Search’ window (Figure 51), which allows you to begin entering 
a file name to search for the sample. Enter the text to be searched in the ‘Match String’ field. 
Check the box next to Case Sensitive if a distinction between uppercase and lowercase letters 
should be applied to the search criteria. Select Search to execute the search. Matching files will 
be displayed in the ‘File Name’ list. Left-click and use the Control or Shift key to select samples 
from the list, then select Open Selected. The electropherograms of the selected samples will 
be displayed. 

Use Shortcut = Control + F to launch the ‘File Search’ window.

Figure 51. 
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‘File Search’ window.

Set Sample Type: Allows you to assign a sample type to the selected sample. Hovering over 
this option provides a pop-out list of the available sample types (Normal, Ladder Sample, 
Positive Control #1, Positive Control #2, Negative Control, Mixture). Selecting a sample type 
will designate the selected sample as that type. You can select a ladder from the dataset from 
which all samples will be assigned alleles. You can also allow the software to Auto Identify 
sample types based on specified sample file name identifiers. To use this function, you must 
complete the ‘Sample Type Identifier in Filename’ fields in the ‘Forensic’ tab of the ‘Preferences’ 
window (Section 6.B). Alternatively, .promega file identifiers designated in the Spectrum Control 
Software during sample setup will be retained in GMHID-Spectrum. Ladder and control sample 
types should be set before data is processed.
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Sort Samples: Opens the ‘Sort Sample Options’ window (Figure 52). First, Second and Third 
Order sorting options can be selected from the drop-down menu for each field. The options 
include: Sample Type, File Name, Lane Number, Well ID and Size Score. The check boxes below 
the ‘Order’ fields provide additional sorting options:
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Figure 52. ‘Sort Sample Options’ window.

	 Ascend Sort: Sorts samples by ascending order.

	 Disabled to Bottom: Moves samples marked as Disabled (see below) to the bottom of 
the list.

	 Case Sensitive: Makes a distinction between the use of uppercase and lowercase 
letters when the sort criteria are applied

	 Ordered by Group: Sorts samples by group when Sample Grouping is applied (Section 
12).

	 Ignore Separators in File Name: Ignores separators entered into the adjacent field 
when sorting rules are applied.

	 Ordered by Reference Ladder: Sorts samples by their respective reference ladder (if 
multiple ladders are included and used for bin offsetting). 

	 Special Sample to Top: Moves samples designated as Ladder, Positive Control or 
Negative Control to the top of the Sample File Tree.  
Note: If this option is selected and these sample designations are made after sorting 
was applied, sorting will need to be re-applied to bring these samples to the top of the 
list.

	 Use Shortcut = F3 to launch the ‘Sort Sample Options’ window.
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Disable (or Enable): Allows you to disable or enable a sample from analysis. When a sample 
is disabled, the ‘Reason Sample is Disabled’ window opens (Figure 53), allowing you to enter 
information in the ‘Comments’ field. Recent comments will be stored and can be subsequently 
selected from the ‘Reason Sample is Disabled’ comments list for future samples. Stored 
comments can be managed and shared across software installations via the ‘Sample 
Comments’ program template file (Section 2.C). A comment is not required to disable a 
sample. Selecting OK marks the sample with a red strike-through. A disabled sample cannot be 
selected for display in the electropherogram of the ‘Main Analysis’ window and will not appear 
in the Report Table if Show Disabled Samples in Report in the ‘Report’ tab of the ‘Preferences’ 
window is deselected (Section 6.B). 

A disabled sample can be enabled by right-clicking the sample name and selecting Enable.

Use Shortcut = Control + Delete to launch the ‘Reason Sample is Disabled’ window (Figure 53).

Figure 53. 
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‘Reason Sample is Disabled’ window.

Edit Comments: Opens the ‘Edit Sample Comments’ window, which allows you to enter 
information in the ‘Comments’ field. Recent comments will be stored and can be subsequently 
selected for future samples. Stored comments can be managed and shared across software 
installations via the Sample Comments program template file (Section 2.C). Comments 
assigned to a sample are viewable in the ‘Sample Comments’ column of the Peak Table 
(Section 5.B.2) of the analyzed data and printable via the ‘Print Report’ window (Section 9.A) 
and the ‘All Color Browser Setting’ window (Section 9.C). 

Use Shortcut = F4 to launch the ‘Edit Sample Comments’ window.

Sample Info: Opens the ‘Sample Information’ window for the selected sample (Figure 54). 
There are three tabs in the ‘Sample Information’ window: ‘Sample Info’, ‘Consumable Report’ 
and ‘Log Messages’. The ‘Consumable Report’ and ‘Log Messages’ tabs are only populated 
when data files are in the .promega format from the Spectrum CE System. 
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Figure 54. Three tabs in the ‘Sample Information’ window. 

	 Sample Info: Displays a list of properties collected from the instrument data collection 
software, including: Sample Name, Well Name, Lane Number (capillary number), 
Machine (instrument name) and run information. The list of properties varies 
depending on the file type. 

	 Consumable Report: Displays the list of consumables and their respective RFID 
information recorded by the instrument at the beginning of a run. 

	 Log Messages: Displays the list of instrument events log messages recorded during 
the run. 

	 Use Shortcut = F2 to launch the ‘Sample Information’ window.

3.C.2	 Navigating the Electropherogram Charts
Raw data electropherograms for selected samples will be displayed in the electropherogram 
chart area of the main window. If multiple samples are selected, individual electropherograms 
can be closed using the X in the upper right corner. The electropherograms display fluorescent 
signal intensities for the selected dye color(s). The signal intensities, recorded in Relative 
Fluorescent Units (RFU), are plotted along a camera frame scale for the raw data displayed in the 
‘Main Analysis’ window (Figure 55). The largest sized fragments are on the far right of the plot. 
The dye channels displayed in the plot can be chosen by using the ‘Show Dye’ icon in the toolbar. 
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Select the arrow next to the ‘Show Dye’ icon and select the dye channels from the drop-down 
list to display in the electropherogram. Select Show All or Hide All to view or hide all dye 
channels, respectively. Alternatively, select the Show Dye icon to cycle through dye channels in 
the order in which they appear in the drop-down list.

Show Dye Slider Bar Mouse Axes Position
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Figure 55. Raw data in the ‘Main Analysis’ window.

To move along the x axis of the selected electropherogram(s), use the top slider bar (below the 
toolbar) to scroll the image in either direction, or hold down the right mouse button within the 
electropherogram and drag the plot right or left.

By default, the y-axis scale is set automatically according to the maximum peak intensity of the 
data within a given view. To adjust the x and/or y axis to a fixed setting, use the ‘Fixed X’ and 
‘Fixed Y’ functions by selecting the Set Axis icon in the toolbar. This will display the ‘Set Axis’ 
drop-down menu (Figure 56).
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Figure 56.  ‘Set Axis’ menu.

The x- and y-axis position of the mouse pointer in the electropherogram is displayed in the 
upper right corner of the electropherogram.
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Zooming in or out of the electropherogram can be accomplished via two methods. To zoom 
in to a specific area within the electropherogram, hold down the left mouse button and drag a 
box from upper left to lower right around the area. To zoom back out, hold down the left mouse 
button and drag a box in the opposite direction from lower right to upper left. To zoom in to or 
out from the midpoint of the plot, select the appropriate zoom icon in the toolbar (Table 3). 

3.C.3	 Navigating the Gel Image 
In addition to the electropherogram display, a synthetic gel image may be viewed for all 
samples in a dataset (Figure 57). To view the image, select the Show/Hide Gel Image icon 
from the toolbar ribbon (Table 3) or select Show Gel Image from the ‘View’ menu. 

Figure 57. 
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‘Gel Image’ window.

The gel image displays the unprocessed data in a traditional gel format with larger fragments 
located on the right. Each sample within the dataset has its own lane within the gel image. 
Samples are ordered vertically down the gel based on the order listed in the Sample File Tree. 
To identify which sample is in a specific lane within the gel image, hover over the lane and a 
tool tip will display the corresponding file name. Any modifications to the view (e.g., zooming in 
or out or changing the displayed dye channels) will automatically apply to both the gel image 
and the electropherogram. 

Options to copy, save or view the gel image in a separate window are available in the ‘Image 
Utilities’ menu. To access this menu, select the Image Utilities icon in the upper left corner of 
the gel image. A pop-out menu will appear with the following options: 

Copy to Clipboard: Copies the gel image to the Windows® clipboard to paste into other 
applications such as Microsoft® PowerPoint.

Save Image: Allows the user to save the gel image as a .png, .jpeg, .bmp or .pdf image file.
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Show In Window: Displays the gel image in its own window within the software. 

The brightness and contrast of the bands within the gel image can be adjusted using the slide 
bars on the left side of the gel image (Figure 39). The upper slide bar adjusts the brightness 
of the gel image, with the top of the slide being the brightest. The lower slide bar adjusts the 
contrast of the gel image, with the top of the slide being the highest contrast. 

The gel image can be further adjusted by navigating to the ‘Gel Image’ section of the ‘Display’ tab 
of the ‘Preferences’ window.

Select Gray for Single Dye to change the single dye gel image to black and white when only a 
single dye color is selected (when multiple dye colors are selected the fragments will appear in 
their respective colors). Select the Background in White option to reverse the black and white 
exposure for single-dye color gel images.

3.C.4	 Navigating the ‘All Color Browser’ Window
In addition to the electropherogram within the main window, which provides an overlay view of 
the plots when multiple colors are selected, the ‘All Color Browser’ window provides a view of 
the same data with separate charts for each selected color (i.e., dye channel charts). To access 
the ‘All Color Browser’ window, select the Browse by All Color icon 
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 in the toolbar ribbon. 

The ‘All Color Browser’ window contains its own toolbar ribbon that provides options to change 
the display (Table 4). The displayed dye channels can be individually selected or deselected 
using the ‘Show Dye’ icon in the toolbar. Zooming in and out of the data occurs in the same 
manner as in the ‘Main Analysis’ window. Right-clicking in the electropherogram provides a 
shortcut for switching between Fixed Y and Auto Fit Y.

When the Mouse Cross Lines are shown (Table 4), grid lines for the x and y axes will be shown 
as the cursor moves over the plot. For raw data, the numbers displayed correspond to the 
frame (x axis) and peak intensity (y axis). All imported samples are displayed in this window 
whether or not they are selected in the Sample File Tree in the ‘Main Analysis’ window. To 
display only those samples that are selected in the ‘Main Analysis’ window, check the box in the 
toolbar next to “Show Selected Samples”. 

You can select specific samples using the drop-down list in the toolbar. Alternatively, the scroll 
bar on the right can be used to scroll through samples. When the ‘Max Chart Numbers’ field 
(Table 4) is set to a value less than the total number of dyes in a kit (e.g., four charts for a six-
dye kit), a second, inner scrollbar is made available. This inner scrollbar allows the user to scroll 
within a sample, while the outer scrollbar maintains the function of scrolling through samples. 

To close out of the ‘All Color Browser’ window and return to the ‘Main Analysis’ window, select 
the [X] in the upper right-hand corner.

Note: The software will not close if the ‘All Color Browser’ window is open and minimized.
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Table 4. Toolbar Ribbon of the ‘All Color Browser’ Window.
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Show Dye: Allows you to select the displayed dye channels.
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Zoom In: Zooms in on the center point of the electropherogram
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Zoom Out: Zooms out from the center point of the  
electropherogram 
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Set Axis: Provides options for setting the x and y axes of the 
electropherogram charts. The default setting automatically sets the  
y axis according to the maximum peak intensity of the samples 
(Auto Fit Y) and the x axis analysis range (Auto Fit X). You can also 
set specific ranges for the x and y axes by selecting Fixed X and 
Fixed Y.
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Show/Hide Mouse Cross Lines: When selected, displays x- and 
y-axis grid lines at the tip of the cursor along with the cursor  
position on both the x and y axes.

Max Chart Numbers: Provides a choice of how many dye  
channels to display in the window. 

Show Selected Samples: When checked, displays only the 
sample(s) selected in the Sample File Tree of the ’Main Analysis’ 
window in the All Color Browser.

Sample Selection Drop-down List: Provides a list of available 
samples to view in the All Color Browser. 
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Processing Data

After the raw data files are uploaded to GMHID-Spectrum, you can conduct a brief review of the 
raw data as described in Section 3 or proceed directly to data processing. The processing step 
includes applying a sizing standard and analytical parameters, as well as comparing sample 
data to a known allelic panel. GMHID-Spectrum combines all of these steps into one tool called 
the Run Wizard. To access the Run Wizard, select the Run Project icon 
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 in the main toolbar 
ribbon. Alternatively, select Run from the ‘Project’ menu or select the Magic Wizard icon (Section 
6.E) from the toolbar ribbon. 

Note: Ensure all ladder and control samples are appropriately designated before proceeding 
with data processing.

4.A.	 Template Selection 

The first screen of the Run Wizard is the ‘Template Selection’ window (Figure 58) where an 
analysis run template can be selected or created. These templates store all of the parameters 
set in the Run Wizard that are needed to process raw data files. GMHID-Spectrum contains 
preloaded templates for many Promega STR kits. Run Wizard templates are saved in the Run 
Wizard program template file (Section 2.C). Templates can be deleted by selecting a template 
from the list and selecting Delete at the bottom of the window. Templates saved outside of the 
Program Data Folder location in the ‘Others’ tab of the ‘Preferences’ window (Section 6.B.6), 
including pre-installed templates, can be restored following the instructions in Section 2.C. To 
exit the Run Wizard at any time without applying analysis settings, select Cancel in the lower 
right corner of the window.

The ‘Template Selection’ window allows editing of the Template Name as well as selection 
of the Analysis Panel, Size Standard Template and Size Standard Color. Preloaded and saved 
templates include this information. 

Before analyzing STR data, verify that the correct panel and size standard templates exist for 
your specific STR kit(s). These files contain information needed to perform data analysis such 
as: marker size range and dye channel, stutter percentages, peak amplitude thresholds and 
sizes of size standard fragments.
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Figure 58. 
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 ‘Template Selection’ window of the Run Wizard.

4.A.1	 Panels

To assign an allele designation to a peak, the software uses a panel file, which defines the dye 
channel and expected size range for each marker in an STR kit. Within each marker, the panel 
defines the expected bin size range for each allele within that marker. Panels are also where 
peak amplitude thresholds and stutter filters are defined. Preloaded and saved panel files are 
known as panel templates. 

The Panel Editor is where all panel templates are managed. GMHID-Spectrum comes 
preloaded with panel templates for many Promega STR kits. To view or edit an existing panel 
from the Run Wizard, select an analysis panel using the drop-down list in the panel field, then 
select the Panel Editor icon to the right of the panel selection drop-down list (Figure 58). This 
will open the Panel Editor with the selected ‘Project Panel’ highlighted. 

Note: Do not edit the Project Panel. Edits should be made to the Panel Templates. 

Outside of the Run Wizard, the Panel Editor can also be accessed from the ‘Tools’ menu 
(Section 8). 

If you are using a Promega STR kit and you do not see a preloaded panel, contact Promega: 
genetic@promega.com. If a panel for a kit from another vendor is needed, contact 
SoftGenetics: tech_support@softgenetics.com 

To import a panel from the ‘Template Selection’ window of the Run Wizard, use the ‘Import A 
Panel’ tool next to the ‘Panel’ field (Figure 58). This tool can also be accessed from the ‘File’ 
menu of the Panel Editor (Section 8.D).  

The following section describes selecting, viewing and editing panels for sample analysis. A 
more detailed description of the Panel Editor, including creating custom panels, is provided in 
Section 8.D.
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Viewing and Editing Panel Templates for Analysis

The Panel Editor has a Menu Bar, Toolbar Ribbon, Panel File Navigator, Chart Overlay, Sample 
File Tree and Panel Table (Figure 59). 

Figure 59. 

Menu Bar Toolbar Ribbon Chart Overlay

Panel File 
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Panel Table
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‘Panel Editor’ window.

The ‘Panel File Navigator’ window includes a list of Project Panels and Panel Templates. The 
Project Panels include the panel assigned for the currently open project. Editing a panel listed 
in the ‘Project Panel’ tree will only apply changes to the open project. To make changes that 
will apply to all future uses of the selected panel, edit the corresponding panel in the ‘Panel 
Templates’ list. 

Analysis parameters of a panel are set at the marker level. To view or edit these parameters for 
a selected panel, double-click the Marker Bar above the electropherogram in the Chart Overlay 
section or right-click the Marker Bar and select Edit Marker (Figure 60). 
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Figure 60. Accessing ‘Edit Marker’ from the Chart Overlay.
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Alternatively, the ‘Edit Marker’ window can be accessed from the Panel File Navigator. To do 
this, expand the desired panel in the Panel File Navigator by selecting the + button next to the 
panel name. This will reveal the list of all markers in the kit. Select a marker name, then right-
click and select Edit (Figure 61) to open the ‘Edit Marker’ window (Figure 62). 

The ‘Edit Marker’ window contains information about the selected marker (Name, Nucleotide 
Repeats and Boundary) as well as analysis parameters that will be applied to peaks that fall 
into the selected marker size range (Figure 62). 
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Figure 61.  Accessing the ‘Edit Marker’ window from the Panel File Navigator.
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Figure 62. ‘Edit Marker’ window.

Marker Name: Displays how the marker will be labeled in the panel. 

Nucleotide Repeats: Displays the length of the repeat motif for the marker.

Boundary: Displays the left and right boundaries (in base pairs) of the marker. 
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The Marker Name, Nucleotide Repeat and Boundary fields are defined when a panel is created 
and are generally not edited before applying a panel to a dataset.

Peak amplitude thresholds are set separately for homozygous and heterozygous events (Figure 62). 
The minimum intensity of both can be set to the same value. 

Min Homozygote Intensity: Sets the minimum RFU value at which the software will call a peak 
if it is the only peak in a marker. The number of peaks in a marker is the number of peaks above 
the Min Heterozygote Intensity threshold. 

Min Heterozygote Intensity: Sets the minimum RFU value at which the software will call peaks 
if there is more than one peak in a marker. The number of peaks in a marker is the number of 
peaks above this minimum intensity threshold. 

Inconclusive Range (Stochastic Range) Flagging: Like the minimum intensity thresholds, this 
value is set separately for homozygous and heterozygous events, and the inconclusive value 
of both can be the same. For both homozygous and heterozygous conditions, peaks above the 
minimum intensity threshold but below the inconclusive range, will be flagged with the quality 
reason ‘Inconclusive Heterozygous’ (IHE) or ‘Inconclusive Homozygous’ (IHO)  
(Section 10). If you do not wish to use this quality flag, set the inconclusive values to match the 
minimum intensity thresholds for the homozygous and heterozygous events/conditions.

Note: If the minimum homozygote intensity and minimum heterozygote intensity thresholds 
are different from each other, a single peak above the ‘Min Heterozygote Intensity’ but below 
‘Min Homozygote Intensity’ will be called and labeled with a yellow “Check” quality flag, with the 
quality reason of “Low Intensity” (LO) (Section 10) if a second peak is detected above the ‘N–x 
Stutter Filter’ value. The second peak will not be called, however, because the peak is below the 
‘Min Heterozygote Intensity’ threshold. In the example shown in Figure 63, the 16 allele is above 
the ‘Min Heterozygote Intensity’ threshold of 200RFU but lower than the ‘Min Homozygous 
Intensity’ threshold. This allele is marked with a yellow “Check” quality flag with the quality 
reason of ‘Low Intensity’ (LO). The other peaks in the marker are not labeled as they fall below 
the ‘Min Heterozygote Intensity’ threshold. 



52      GeneMarker®HID Software for Spectrum CE Systems | TM555 | Revised 1/23

Processing Data

Figure 63.  
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Example of ‘Min Heterozygote Intensity’ exception.

Max Heterozygote Imbalance Flagging: Flags peaks within a locus that do not meet the 
laboratory’s minimum peak height ratio for a heterozygous locus. All peaks in a locus are 
compared to the peak height of the highest peak found in the locus and a ratio is calculated. 
Peaks that fall below the maximum imbalance setting are marked with a yellow ‘Check Quality’ 
flag with a quality reason of ‘Imbalance’ (IMB) (Section 10). If you do not wish to use this quality 
flag, set both the maximum and minimum heterozygote imbalance settings to zero.

Note: The value set for the Max Heterozygote Imbalance Flagging must be greater than that of 
the Min Heterozygote Imbalance Filter.

Min Heterozygote Imbalance Filter: Applies a minimum heterozygote imbalance filter to a 
locus. All peaks in a locus are compared to the height of the highest peak found in the locus 
and a ratio is calculated. Peaks that fall below the minimum heterozygote imbalance filter are 
not called. This filter acts as a global filter at the marker level, such that no peaks with ratios 
below the calculated ratio will be called as alleles.

Note: All minimum intensity, inconclusive and imbalance settings for one marker can be 
applied to all markers within a dye channel or all markers within a kit by using the respective 
check boxes below the imbalance settings (Figure 62). 
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Stutter Filter: Forward and reverse stutter peaks commonly produced in PCR amplification can 
be filtered. Stutter filters can be defined for the following positions: N – 2x, N + x, N – x,  
N + 0.5x and N – 0.5x, where N is the primary peak and x is the number of nucleotide repeats 
for the selected marker. Peaks in these positions are compared to the peak height of the peak 
at the N position and a ratio is calculated. Peaks that fall below the stutter filter for that position 
will not be called. If stutter filters are not desired, set the values for all positions to 0.

Note: Partial stutter filters (N + 0.5x and N – 0.5x) do not apply to trinucleotide and penta-
nucleotide repeat markers. 

There are two options for setting stutter filters: marker-specific and allele-specific. 

To use marker-specific stutter filters, select Use Marker-Specific Values and enter the 
appropriate stutter filters for the listed positions of the ‘Edit Marker’ window (Figure 62). 

Note: Stutter filters for one marker can be applied to all markers in a kit by checking the box 
‘Apply Stutter Settings to All Markers’.

To use allele-specific values, select the radio button next to Use Allele-Specific Values (From 
Panel) in the ‘Edit Marker’ window, then enter the appropriate stutter filters in the Panel Table of 
the ‘Panel Editor’ window (Figure 64). 

Note: Allele-specific stutter is additive. If a peak is in a shared stutter position between two 
other peaks, the stutter peak must exceed the total stutter filter for the flanking alleles before it 
is called. Peaks that are within the inconclusive range or are themselves filtered out as stutter 
will not be used to influence stutter determination of other peaks.
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Figure 64. Allele-specific stutter values in the ‘Panel Editor’ window.
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When the marker parameters are set to the desired values, select OK to close the ‘Edit Marker’ 
window and return to the Panel Editor. When the parameters for all markers in a panel are set 
to the desired values, the user may Save Changes to the selected panel or Save As New Panel 
via the ‘File’ menu. To return to the Run Wizard or main screen, close the Panel Editor.

For additional Panel Editor functions, refer to Section 8. 

4.A.2	 Size Standards
A size standard template is needed for each internal size standard that will be used for data 
analysis. Each size standard template defines the fragment sizes for a specific internal size 
standard. 

GMHID-Spectrum comes preloaded with size standard templates for Promega internal 
size standards. All size standard templates are managed from the ‘Size Template Editor’ 
window (Figure 66). The ‘Size Template Editor’ window can be accessed through the Run 
Wizard or from the ‘Main Analysis’ window menu bar under ‘Tools’. To view or edit an existing 
size standard template from the Run Wizard, select it using the drop-down list in the ‘Size 
Standard’ field, then select the Size Template Editor icon to the right of the ‘Size Standard’ field 
(Figure 65). This will open the ‘Size Template Editor’ window with the selected size standard 
highlighted and displayed (Figure 66). 
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Figure 65. Size Template Editor accessed from the Run Wizard.

Figure 66. 
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 ‘Size Template Editor’ window.
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If the size standard you are using is not present, a new size standard template can be created 
(Section 7) or imported. If you are using a Promega STR kit and you do not see a preloaded 
size standard template, contact Promega: genetic@promega.com If a size standard template 
for a kit from another vendor is needed, contact SoftGenetics: tech_support@softgenetics.com To 
import a size standard, use the ‘Import Size Standard’ option from the ‘File’ menu (Section 7.A.5) 
in the ‘Size Template Editor’ window.

Viewing Size Templates for Analysis

The ‘Size Template Editor’ window has a Menu Bar, Toolbar Ribbon, Size Standards File 
Navigator, Expected Size Standard Chart, Sample Size Standard Chart, Sample File Tree and 
Expected Size Standard Table (Figure 66).

The Size Standards File Navigator includes a list of size standard templates. For more 
information on managing size standard templates, including creating new templates, editing 
existing templates, and deleting templates, see Section 7. 

The dye channel that contains the size standard to be used for analysis is set in the ‘Template 
Selection’ window of the Run Wizard (Figure 58). When the appropriate size standard template 
is verified, close the ‘Size Template Editor’ window to return to the Run Wizard. 

4.B.	 Data Process – HID Analysis 

After a ‘Run Template’ is selected, select Next on the ‘Template Selection’ window (Section 4.A, 
Figure 58) to proceed to the ‘Data Process - HID Analysis’ window (Figure 67). The ‘Data 
Process – HID Analysis’ window includes the ‘Raw Data Analysis’, ‘Size Call’ and ‘Allele Call’ 
parameters that can be reviewed or edited. You can also return to the ‘Template Selection’ 
window by selecting Back at the bottom of the window.
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Figure 67. ‘Data Process - HID Analysis’ window of the Run Wizard.
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4.B.1	 Raw Data Analysis 
Raw Data Analysis Field: Allows you to define the camera frame range used to analyze the raw 
data, the degree of smoothing applied to the baseline and the amount of baseline subtraction 
and correction. 

Auto Range (frame): When selected, the software automatically determines the range of 
camera frames that include data and uses that range to analyze the raw data. If ‘Auto Range’ 
is not selected, you can manually enter the start and end frame numbers of the dataset for 
analysis. Frame numbers are displayed in the raw data electropherograms. 

Note: If the Auto Range function fails due to high saturation of the primer peak, deselect Auto 
Range and manually input the required data range to exclude that area of saturation.

Smoothing 

There are two options for peak smoothing, ‘Smooth’ and ‘Enhanced Smooth’. The result of both 
options is reduced sharpness of peaks, thus smoothing the baseline by eliminating low-level 
noise peaks.

Smooth: Applies a standard amount of smoothing, resulting in a smoother baseline with 
minimal loss of resolution. This is the setting used for typical data analysis.

Enhanced Smooth: Applies an increased amount of smoothing, resulting in an even smoother 
baseline but also an increased loss of resolution. This setting is typically only used in research 
applications and is used for select samples to compensate for excess noise. This setting is not 
recommended for forensic casework samples.

Note: Peaks with low peak heights may be lost when this setting is applied since the 
broadening of peaks caused by smoothing can lead to loss of resolution.

Baseline Subtraction

There are three options for baseline subtraction (Figure 68 and Figure 69). The settings differ 
by the camera frames used in the subtraction calculation. If none of these options are selected, 
no baseline subtraction is applied to the raw data, resulting in higher peak heights in the 
processed data along with higher baseline noise.

Superior: Sets the baseline to 20% of the lowest value detected in 100 camera frame sections 
to perform baseline subtraction. This setting is used for typical data analysis and is the 
recommended baseline subtraction setting. 

Classic: Sets the baseline to 20% of the lowest value detected in 500–600 camera frame 
sections to perform baseline subtraction. This setting removes the baseline completely so that 
the y axis will be raised above the noise level.   

Enhanced: Uses the second derivative of the absolute value for every 30 data points in 300 
camera frame sections to perform baseline subtraction. This setting is used only in cases 
where the data have excessive baseline noise in one or more of the dye channels or the primer 
peaks slope into the region of lower-molecular-weight markers, interfering with baseline 
subtraction.
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Figure 68. Comparison of classic baseline subtraction (top panel) and superior baseline subtraction (bottom panel) 
for a sample with raised baseline.
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Figure 69. Comparison of classic baseline subtraction (top panel) and superior baseline subtraction (bottom panel) 
for a sample with sloping primer peaks. 



58      GeneMarker®HID Software for Spectrum CE Systems | TM555 | Revised 1/23

Processing Data

Corrections

There are four settings for detection and correction of common artifacts: Pull-Up Correction, 
Spike Removal, Saturation Detection and Saturation Repair. The Pull-Up Correction, Spike 
Removal and Saturation Repair settings are not recommended for forensic casework samples.

Pull-Up Correction: Removes peaks caused by bleedthrough (pull-up) of signal from one dye 
channel into another. Only pull-up peaks with peak heights up to 20% of the main peak are 
removed.

Spike Removal: Removes peaks from voltage spikes caused by micro-air bubbles or debris in 
the laser path. Spikes are typically less than a base pair wide.

Saturation Detection: Applies an algorithm to the data to identify areas of potential signal 
saturation beyond what is detected by the data collection software. To flag saturation detected 
by the collection software, select Show Saturation Alert Line from the ‘Chart settings’ section 
of the ‘Display’ tab in the ‘Preferences’ window (Section 6.B).

Saturation Repair: Analyzes saturated data points and creates a synthetic estimate of the 
peak shape based on the peak height and shape of pull-up peaks under the saturated peak. 
The results will be less accurate than that for nonsaturated peaks for DNA quantification, 
such as when evaluating mixtures by peak ratios. Saturation Repair is only active if Saturation 
Detection is selected. 

In the example shown in Figure 70, the top panel shows saturation detected, but not repaired. 
The saturated peak in the blue dye channel is split at the top and a pull-up peak is present in the 
green dye channel. The bottom panel shows the same data where saturation is both detected 
and repaired. The pull-up peak in the green dye channel has been removed and its peak height 
added to saturated peak in the blue dye channel. The top of the peak in the blue dye channel is 
no longer split.
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Figure 70. Saturation detection and repair. The top panel shows a peak where saturation is detected. The bottom 
panel shows the same peak detected but repaired.

4.B.2	 Size Call
GMHID-Spectrum offers two sizing methods: 

Local Southern: Commonly used sizing algorithm for STR analysis. This method overlays a 
plot of size versus time and a plot of size versus 1/time graph to determine sizing linearity. The 
size of the two peaks on either side of an unknown peak are used to calculate the size of the 
unknown peak. For unknown peaks that do not have two size standard peaks on either side, 
a modified Local Southern method is applied. (Southern, E.M. (1979) Measurement of DNA 
Length by Gel Electrophoresis. Anal. Biochem. 100, 319–23.)

Cubic Spline: An alternative method, similar to the Local Southern method; however, the 
sizing curve is fit to all known points. This method uses a cubic equation to connect known 
points on the size versus time graph. (Akerlof, C. et al. (1994) An example of a cubic equation: 
ax3+bx2+cx+d. Astrophys. J. 436 787–94.) 
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4.B.3	 Allele Call 
The ‘Allele Call’ field allows you to set the allele-calling range as well as the detection thresholds 
and filters for peaks outside the panel ranges.

Auto Range (bps): When selected, the software automatically locates the data range in base 
pairs used to identify peaks. If Auto Range is not selected, you can manually enter the start and 
end range of the dataset for peak calling. Peaks outside this set range will not be called.

Max Intensity: Peaks above this intensity (in RFU) will have the quality designation of ‘Pass’, 
but the quality reason of ‘High Intensity’ (HI; Section 10).

Peak Detection Threshold

Note: The ‘Peak Detection Threshold’ parameters are only applied to peaks outside of the panel 
marker ranges. To adjust settings for peaks within panel marker ranges, see Section 4.A.1.

Min Intensity: Minimum peak height at which the software will call a peak that migrates 
outside of a panel marker range. 

Percentage > Global Max: All peaks that migrate outside of a panel marker range will be 
compared to the peak height of the 5th highest peak in the corresponding dye channel. Peaks 
that fall below the percentage global max setting will not be called. 

Min Intensity for Standard Color: Minimum peak height at which the software will call a peak 
in the size standard dye channel. 

Apply Nearest Marker Settings: The software applies the allele-calling threshold settings of 
the nearest marker (defined in the panel selected in the ‘Template Selection’ window) to peaks 
that migrate outside of panel marker ranges.

Dye Specific: The user defines the peak detection threshold by individual dye channel. When 
selected, a table with fields for each dye channel is displayed in the ‘Allele Call’ section of 
the Run Wizard (Figure 71). The ‘Min RFU’ column allows the Min Intensity (see above) to be 
applied by dye channel. The ‘Min RFU%’ column allows the Percentage Global Max (see above) 
to be applied by dye channel.

Note: ‘Min Intensity’, ‘Percentage > Global Max’ and ‘Dye Specific’ options are only available if 
Apply Nearest Marker Settings is not selected.
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Figure 71. 
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Setting dye-specific peak detection threshold in the Run Wizard.

4.C.	 Additional Settings - HID Analysis

Select Next on the ‘Data Process - HID Analysis’ window to proceed to the  
‘Additional Settings - HID Analysis’ window (Figure 72). 
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Figure 72. ‘Additional Settings - HID Analysis’ window of the Run Wizard.
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4.C.1	 Allelic Ladder
One allelic ladder from the dataset can be selected from the ‘Allelic Ladder’ drop-down list 
for use in assigning alleles to all samples in the project. Alternatively, GMHID-Spectrum can 
automatically select the best ladder for each sample in the dataset by checking the box next to 
Auto Select Best Ladder. Allelic Ladder files must be designated as ladders for this function to 
work (Section 3.C.1).

Allow Match # Variance: Sets the number of unmatched bins allowed between a sample and 
ladder. The recommended setting is zero. Increasing this number decreases the matching 
stringency applied when passing ladders are compared to each sample. 

Max Average Size Diff: Sets the allowable average size difference between a peak in a sample 
and the center of the corresponding bin. The recommended setting is 0.40. Decreasing this 
number increases the matching stringency between a sample and a ladder.

Use Ladder Library: When this box is checked, the ‘Min Heterozygosity’ field is available. The 
‘Min Heterozygosity’ field defines the minimum number of detected peaks per marker for a 
sample to be matched to a ladder by the auto select process. This setting may be needed if a 
ladder library, a set of ladders not run concurrently with the imported sample set, will be used 
to auto-select the best ladder. The default setting is 0.5, which requires a sample to have a 
minimum of one peak per marker to be automatically matched to a ladder. 

4.C.2	 Auto Panel Adjustment
Choosing this feature allows the software to automatically align the markers and bins of the 
chosen panel with the peak positions of the ladder fragments within a dataset (within a 5 base pair 
shift). This will allow for migration differences due to electrophoresis conditions (e.g., room 
temperature, polymer age).

4.C.3	 Positive Control Template
Positive control files must be designated as controls for this function to work (Section 3.C.1). 
Select the corresponding template from the ‘P.C. Template 1’ drop-down list (Figure 72). 
If a second positive control template is needed, select the appropriate template from the 
‘P.C. Template 2’ drop-down list. A positive control template lists the expected alleles of the 
positive control samples for profile accuracy. GMHID-Spectrum is preloaded with the positive 
control profiles for many Promega STR kits. If the control DNA or chemistry is not present in 
the template list, you can create a new positive control template using the Positive Control 
Template Editor (Section 6.E).
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4.C.4	 Allele Evaluation
The ‘Allele Evaluation’ field allows the user to define a confidence level of an allele call using the 
peak score. Peak score is an algorithm that takes into account signal-to-noise ratio and peak 
morphology (Section 5.B.2). You should evaluate data to determine the appropriate values for 
rejecting and passing peak scores. Samples that fall between these values will be marked with 
a yellow “Check” quality flag with a quality reason of ‘Low Score’ (LS). Rejected peaks within 
bin ranges will be marked with a red “Undetermined” quality flag and a quality reason of ‘Low 
Score’ (LS). Rejected peaks outside of bin ranges will not be labeled. Peaks with a passing peak 
score will not be marked (Section 10).

In the example in Figure 73, the ‘Reject <’ peak score was set to 1.00 and the ‘< Pass’ peak 
score was set to 3.00. As a result, the peaks with a peak score below 1.00 have allele labels 
displayed in red and are marked “Undetermined” in the ‘Quality’ column. Peaks with scores 
between 1.00 and 3.00 have allele labels displayed in yellow and are marked “Check” in the 
‘Quality’ column. In both instances, the quality reason is ‘LS’. The allele call for the peak with a 
score above 3.00 is displayed in gray and marked “Pass” in the ‘Quality’ column. 
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Figure 73. Allele Evaluation in the ‘Additional Settings - HID Analysis’ window.

4.C.5	 Mixture Evaluation
You can define criteria to identify the presence of potential mixture samples. To activate and 
edit the two Mixture Evaluation criteria fields, check the Mixture Evaluation box. 

Valid Mixture Peak Percentage: Applies a filter to samples with the mixture sample type 
designation. All peaks in a locus will be compared to the peak height of the second highest 
peak found in the locus and a ratio will be calculated. Peaks which fall below the valid mixture 
peak percentage will not be called. This filter acts as a global filter at the marker level, meaning 
that all peaks, including stutter peaks, that do not reach this percentage will not be called. This 
overwrites the ‘Min Heterozygote Imbalance’ set in the applied panel (Section 4.A.1).

Min Mixture Marker Number: Defines the minimum number of markers that meet the mixture 
criteria before the whole profile is flagged as a mixture. These criteria are determined by the 
Min and Max Heterozyote Imbalance and ploidy settings in the selected panel. Profiles that 
meet or exceed the minimum number of markers identified as possible mixtures will be flagged 
as a mixture sample in the Sample File Tree (MX:[filename]). 
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4.C.6	 Sample Quality Peak(s)
The ‘Sample Quality Peak(s)’ field allows you to define quality indicator peaks for STR kits that 
contain up to two synthetic DNA templates to aide in sample quality assessment. To activate 
and select quality indicator peaks, check the “Sample Quality Peak(s)” box. 

Small Allele: Left-click on the field and select the locus and allele for the small allele quality 
indicator from the pop-out list. If the STR kit does not contain a small allele quality indicator, 
leave the field blank.

Large Allele: Left-click on the field and select the locus and allele for the large allele quality 
indicator from the pop-out list. If the STR kit does not contain a large allele quality indicator, 
leave the field blank.

The threshold for quality indicator flagging is defined in the ‘Preferences’ window (Section 6.B).

Note: The ‘Sample Quality Peak(s)’ option is available in GMHID-Spectrum software 
version 3.2.0 or later. 

4.D.	 Process Data

When each of the three screens of the Run Wizard have been reviewed and the desired settings 
applied, select the Save button in the bottom left to save any changes to the selected analysis 
template (selected on the ‘Template Selection’ window of the Run Wizard). To apply the Run 
Wizard settings to the imported data, select OK.

A ‘Data Processing Event Log’ window will appear and record the analysis events as the 
software applies the analysis settings to the imported data. Samples that are successfully 
processed are labeled “Completed” in blue. Samples that fail the process are labeled “Failed” 
in red. Further review of all samples is done in the ‘Main Analysis’ window. The total number of 
samples processed and the analysis time are recorded at the end of the Event Log (Figure 74). 
When analysis is complete, select OK to proceed to the ‘Main Analysis’ window.  

Figure 74. 
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 ‘Data Processing Event Log’ window.
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Once the raw data files are processed through the Run Wizard, the ‘Main Analysis’ window 
displays processed data (Figure 75). The Sample File Tree displays a listing of the processed 
data files in the ‘Allele Call’ folder. 

The Electropherogram Chart (also Electropherogram) displays the processed data of selected 
samples. If no samples are selected this area will be blank. 

The Project Summary Bar at the bottom of the screen is updated with a summary of the quality 
metrics applied to the data.

A Report Table is now available on the right side of the screen. This displays the allele table for 
the project samples. 

Additional shortcuts are now available in the toolbar ribbon to assist with processed data 
analysis (Table 5). 

Many of the features and functions of the ‘Main Analysis’ window for raw data (Section 3.C) are 
available in the ‘Main Analysis’ window for processed data. Features only available in the ‘Main 
Analysis’ window for processed data are described below. 

Sample File
Tree

Project 
Summary
Bar

Electropherogram Chart Report Table
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Figure 75.  ‘Main Analysis’ window with processed data.
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Table 5. Additional ‘Main Analysis’ Toolbar Icons for Processed Data.
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Print Report: Opens the ‘Print Report’ window, which allows a choice of 
print display options (Section 9).
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Size Calibration: Opens the ‘Calibration Charts’ window, which allows  
review and editing of size standard calibrations for the dataset (Section 7.B).
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Show Chart/Table: Toggles the display window to show only the Peak 
Table, the Peak Table and Electropherogram or just the Electropherogram.

Save Peak Table: Exports the Peak Table as an Excel (.xlsx), tab-delimited 
text (.txt) or CSV (.csv) file. The arrow allows selection or deselection of two 
table options. ‘Filter Delete Peaks’ removes deleted peaks from the saved 
table. ‘Exclude Report Header’ removes the report header from the saved 
table.
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Call Allele: Opens the ‘Recall Allele’ window, which allows slight 
modifications to the samples without having to activate the Run Wizard 
again. The drop-down menu allows you to define how the re-analysis will be 
applied: by sample(s), by marker or by dyes (Section 5.F).
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Marker Drop-Down Menu: Displays the selected marker. This menu is  
available after samples have been compared to a panel. 

5.A.	 Navigating the Sample File Tree 

After raw data files are processed, the Sample File Tree will contain a second folder, ‘Allele Call’, 
in addition to the ‘Raw Data’ folder (Section 3.C.1). The ‘Allele Call’ folder contains a list of all 
project samples in their processed form. By default, the first sample in the tree is selected and 
its processed data electropherogram is displayed in the electropherogram window. The same 
viewing and analysis options available in the ‘Raw Data’ view are available in the ‘Processed 
Data’ view. 
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Samples listed in the ‘Allele Call’ folder are assessed for quality measures applied during data 
processing and flagged if necessary. These flags (Table 6) provide a quick assessment of 
profile quality. 

Table 6. Quality Measure Flags in the Sample File Tree. 
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Size Match Score: Provides an assessment of the size standard compared 
to the applied size standard template (Section 10.A.1).

Quality Indicator (Q): Indicates the Quality Intensity Ratio is below 
the minimum value set in the ‘Preferences’ window (Section 6.B). This 
flag is only applied when the “Sample Quality Peak(s)” box is selected 
in the ‘Additional Settings - HID Analysis’ window of the Run Wizard 
(Section 4.C.6).
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met for that sample. Details of the parameter(s) not met, including quality 
reasons, are listed in the allele label and the Peak Table (Section 10). 
This indicator also marks samples with null marker(s) and samples with 
amelogenin and Y-STR marker conflict(s). The amelogenin and Y-STR 
marker conflict assessment is only applied when set in the ‘Preferences’ 
window (Section 6.B). 
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in the size standard (e.g., assessing broad peaks) or samples in which at 
least one expected size fragment is not called. This flag is only applied 
when set in the ‘Preferences’ window (Section 6.B). The ‘Size Quality’ flag is 
described in detail in Section 10.A.2.

5.B.	 Navigating the Electropherograms with Peak Table

Electropherograms for selected samples will be displayed in the electropherogram chart 
area of the ‘Main Analysis’ window. The sample file name will be displayed at the top of 
each electropherogram. The allelic ladder used to determine allele calls for the selected 
sample will be displayed in parentheses after the sample name. A Peak Table (Section 5.B.2) 
can be added to the electropherogram plot view of the ‘Main Analysis’ window. This table 
contains information for all called peaks displayed in the selected dye channel(s) of the 
electropherogram. 
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5.B.1	 Electropherogram Features
The electropherograms display fluorescent signal intensities as a single line plot for the 
selected dye color(s). The signal intensities, recorded in RFU, are plotted along a base pair 
scale. The ‘Show Dye’ icon in the toolbar can be used to view different dye channels as 
explained in Section 3.C.2. 

The x axis of the electropherogram is set to reflect the range defined in the ‘Data Process’ 
window of the Run Wizard (Section 4.B). By default, the y axis is set to auto scale according to 
the maximum peak intensity of the displayed data (Figure 76). The ‘Fixed X/Y’ and ‘Auto Fit X/Y’ 
functions described in Section 3.C.2 are available in the ‘Main Analysis’ window for processed 
data. The Auto Fit Y By Allele feature automatically adjusts the y axis to reflect the highest 
intensity allele regardless of the height of peaks outside of the marker ranges (i.e., the primer 
peaks). 
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Figure 76. ‘Set Axis’ menu.

Just as with the raw data, you can zoom in or out of the electropherogram using the mouse or 
the Zoom In and Zoom Out icons in the toolbar.  

The marker, bin and allele settings of the selected analysis panel are applied to the processed 
data and labeled in the electropherogram (Figure 75). The marker ranges associated with the 
applied analysis panel are displayed in gray bars above the region for each marker. Bin ranges 
appear as dye-colored brackets at the top and bottom of the electropherogram area. Allele 
labels appear below the electropherogram and correspond to the center of each called peak, 
which is also marked by a light gray vertical line in the electropherogram. The color of the allele 
label reflects the Analysis Quality assessment of the peak as Pass (no color), Check (yellow) 
and Undetermined (red). Samples with a Q and/or SQ flag will have a Q and/or SQ label in the 
upper left corner of the electropherogram. Hovering the mouse pointer over the Q or SQ label 
will display the quality reason for the flag. The Q flag is only applied when the “Sample Quality 
Peak(s)” box is selected in the ‘Additional Settings - HID Analysis’ window of the Run Wizard 
(Section 4.C). The SQ flag is only applied when set in the ‘Preferences’ window (Section 6.B). 
For more details on Quality Assessment, see Section 10. 

If a panel was not applied during data analysis, then marker and bin regions are not labeled and 
alleles will only be labeled with the peak size (in base pairs). 

Electropherograms can be reviewed by marker. Scroll through individual markers by selecting a 
marker from the ‘Marker’ drop-down list in the main toolbar. To view subsequent markers, use 
the Up or Down arrow keys on the keyboard. Use either the mouse or Zoom Out icon to return 
to full range view. 
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5.B.2	 Features of the Peak Table
The Peak Table can be added to the chart area of the ‘Main Analysis’ window to 
provide detailed information on all peaks displayed in the selected dye color(s) of the 
electropherogram. To show the Peak Table, select the Show Chart/Table icon in the toolbar 
(Table 5). Use this icon to scroll through views showing both the electropherogram and Peak 
Table, just the Peak Table or just the electropherogram. Each peak in a dye color is listed in the 
Peak Table by size from smallest to largest and counted by number, which is displayed in the 
No. column of the table (Figure 77). The No. column is fixed and always displayed. There are 21 
other columns of information available for display in the Peak Table. Each column is described 
below. To display certain columns, right-click in the Peak Table, select Show Columns and then 
select the desired columns from the list. Alternatively, expanding the headers next to hidden 
columns will display the hidden columns. 
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Figure 77. ‘Peak Table’ menu options.

File Name: Displays the full file name of the data file.

Sample Name: Displays the sample name recorded in the data file.

Dye: Indicates the dye name of the peak as defined in the ‘Chemistry Dye Set’ window (Figure 47).

Size: Indicates the size of the peak in base pairs (x axis).

Height: Indicates the peak height in RFUs (y axis).

Height Ratio: Displays the value obtained when the peak height is divided by the height of the 
highest peak in the dye color (when a panel is not applied) or marker (when a panel is applied).

FWHM (Full Width Half Max): Displays the width of a peak (in base pairs) at half the maximum 
height of the peak.
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Area: Displays the area under the curve of the peak. The area calculation begins and ends 
along the x axis as indicated by the values in the ‘Start’ and ‘End’ columns of the Peak Table, 
respectively.

Area Ratio: Displays the value obtained when the peak area is divided by the area of the 
highest peak in the dye color (when a panel is not applied) or marker (when a panel is applied).

Score: Displays the peak quality score calculated based on signal-to-noise ratio and peak 
shape or morphology. The score value is based on an exponential curve. A score of 500 
represents a perfect score. Lower scores indicate poorer quality peaks. You should evaluate 
the quality of peaks with these lower scores (typically less than 1.0000) to determine if a peak 
score filter should be applied (Section 4.C.4). 

Start: Indicates the beginning of the area calculation for the peak.

End: Indicates the end of the area calculation for the peak.

Allele Comments: Displays user comments applied at the allele level in the electropherogram 
or Peak Table (Section 5.B.3). 

Sample Comments: Displays user comments applied at the sample level in the Sample File 
Tree (Section 3.C.1).

Comment: Displays comments recorded for the sample in the instrument collection software.

The following columns are available only when a panel is applied to data: 

Marker: Indicates the marker (locus) in which the peak is located. 

Allele: Indicates the bin in which the peak is located. 

Difference: Indicates the absolute value in base pairs of the distance between the peak center 
and bin center.

Quality: Displays a “Pass”, “Check” or “Undetermined” quality designation for each peak based 
on the peak score filter (if applied) in the Run Wizard (Section 4.C.4), the Analysis Quality 
parameters (Section 10) and/or software editing of the original raw data, such as correction of 
saturated peaks (SAT Repaired; Section 4.B.1).

Quality Reasons: Displays the two or three letter code quality reason (Section 10) for peaks 
that are assigned a “Check” or “Undetermined” quality designation.

Note: Peaks that exceed the maximum peak intensity threshold set in the ‘Data Process - HID 
Analysis’ window of the Run Wizard (Section 4.B.3) are assigned a “Pass” quality designation; 
however, they will be denoted as “HI” for the quality reason.

Plate ID: Displays the plate name recorded in the data file.
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5.B.3	 Editing Peaks in the Electropherogram and Peak Table
You can edit peaks from the electropherogram and Peak Table. When peaks are edited, the 
corresponding cell in the ‘No.’ column of the Peak Table will be highlighted in a pink-orange 
color. Additionally, edited peaks can be labeled at the top of the peak when ‘Mark Deleted/
Edited Peaks with Symbols’ is selected in the ‘Forensic’ tab of the ‘Preferences’ window 
(Section 6.B).

Selecting Alleles

To select a single allele from an electropherogram, select the gray bar centered over the allele 
or the allele label. A selected allele will have a red triangle below the base of the peak and the 
gray bar will change to teal (Figure 78). In addition, the selected allele will be highlighted gray 
in the corresponding Peak Table. To select a single allele from the Peak Table, select the row 
in which the allele is represented. The selection will also be reflected in the corresponding 
electropherogram. 

      

16
76

0T
A

Figure 78.  Electropherogram and Peak Table with selected alleles.

To select a group of consecutive alleles from an electropherogram, use Control + left mouse 
click to drag a highlighted area across the desired alleles. A teal box will display during the 
select and drag, indicating the area being selected. Repeat the select and drag across an area 
with selected alleles to deselect the alleles. To select alleles from within the Peak Table, use 
Shift + select. 

To select a group of nonconsecutive alleles from an electropherogram or the Peak Table, use 
Control + left mouse click to select specific alleles. 

With desired allele(s) selected, right click anywhere in the electropherogram or Peak Table to 
view a menu of options: 
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Set/Unset Reference Peak Height: Allows you to set a reference peak within the marker for 
calculating the height ratio. By default, the highest intensity peak in a marker is set as the 
reference peak. 

Edit Allele: Opens the ‘Edit Allele’ window (Figure 79). You can change values in the ‘Allele’ and 
‘Size’ field. The ‘Allele’ field will be blank if no panel was applied to the dataset. Select Confirm 
the Allele to automatically give the peak a quality designation of “Pass” (green).
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Figure 79.  ‘Edit Allele’ window.

Edit Comments: Opens the ‘Edit Allele Comments’ window (Figure 80). Select a comment from 
the ‘Comments Template’ list, or enter a new comment in the ‘Comments’ field. Choose OK to 
assign the comment to the selected allele. Comments assigned to an allele are viewable in the 
‘Allele Comments’ column of the Peak Table. Only one user comment can be added to a peak. 
Recent comments will be stored and can be subsequently selected from the displayed list for 
future samples. Stored comments can be managed and shared across software installations 
via the Sample Comments program template file (Section 2.C). 
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Figure 80. ‘Edit Allele Comments’ window.
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Insert Allele: Inserts a peak label at the selected location by right-clicking within the 
electropherogram. This option is not available if an allele already exists at the chosen location. 
If the allele is to be inserted outside a marker range, a warning box will appear asking if you 
intend to add an allele outside of a marker. When selected, the ‘Insert Allele Peak’ window opens, 
displaying the allele designation and base pair size that will be assigned to the peak (Figure 81).

Figure 81. 
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‘Insert Allele Peak’ window.

You can choose a different allele designation from the drop-down list in the ‘Allele’ field and 
adjust the size in the ‘Size’ field. The ‘Confirm the Allele’ check box is automatically checked 
and cannot be unchecked. When the desired information is entered, select OK to add the 
allele to the profile. The peak specifications will be calculated and displayed in the Peak Table. 
“Confirmed” and “Inserted” will be displayed in the ‘Allele Comments’ column.

Delete/Undelete Allele: Deletes selected allele(s) (Shortcut = DEL). To undo a deletion, choose 
the peak(s), right-click and select Undelete (Shortcut = Shift + DEL). 

Confirm/Unconfirm Allele: If a peak is marked with a yellow “Check” or red “Undetermined” 
quality flag, you can confirm the allele to give it a “Pass” (green) quality designation. To do this, 
right-click the center bar of the desired peaks and select Confirm (Shortcut = CTRL + M). The peak 
will be marked “Pass” (green) and receive a “Confirmed” comment in the ‘Allele Comments’ 
column of the Peak Table. To unconfirm the allele, select Unconfirm from the right-click menu 
(Shortcut = CTRL + ALT + M). This will revert the quality designation of the peak to its original 
state (“Check” or “Undetermined”).

Confirm/Unconfirm All: ‘Confirm All’ and ‘Unconfirm All’ options perform the same actions as 
the ‘Confirm/Unconfirm Allele’ function for all peaks marked “Check” (yellow) or “Undetermined” 
(red) in the selected dye color for the selected sample.

Undo: Undoes the last edit made to the selected allele.

View History: Opens the ‘Show Edit History’ window, which displays a record of all manual edit(s) 
of the selected allele(s) (Figure 82). To view the details of a specific change, select the edit of 
interest from the ‘Edit History’ list. The ‘Current/Old Values’ field will populate with the recorded 
information for the allele for both before the edit was made (old value) and after the edit was 
made (current value). The cells that represent the edited element will be highlighted in red. 

This record can be printed or saved as a jpeg, png, or pdf, by selecting Print at the bottom of 
the ‘Show Edit History’ window (Figure 82).  
Note: The ‘Show Edit History’ window is only active when the Help/User Management/
Settings/Record Data Edit History option is selected (Section 6.F).
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Information recorded in the ’Current Value’ row can be changed back to the previously recorded 
(old) value by right-clicking the edit in the ‘Edit History’ list and selecting Recover Old Value. A 
checkmark will appear next to the number of the edit in the list. Select OK at the bottom of the 
window, and a confirmation box will appear. Select Yes to revert the edit back to the original 
state, add the recover operation to the ‘Edit History’ list for the allele and return to the ‘Main 
Analysis’ window.  

A version of this window displaying all edits to all samples in a project is accessible by 
selecting View Project History from the ‘View’ menu (Section 6.B).
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Figure 82. Edits recorded in the ‘Show Edits History’ window. Top Panel. A peak at 100.4 bases was deleted as 
indicated by the “x” in the electropherogram and in the allele comments in the Peak Table. Bottom Panel. The ‘Show 
Edit History’ window resulting from the peak deletion shown in the top panel.

Copy Table: Copies the displayed Peak Table information onto the Windows® clipboard  
(Shortcut = CTRL+C). This feature is only available in the right-click menu of the Peak Table. 
You can then paste the information into a spreadsheet or word processing program. 
Alternatively, you can save the Peak Table for all project samples for all displayed dye channels 
as an Excel® (.xlsx), text (.txt) or CSV (.csv) file by selecting the Save Peak Table icon 16
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 in the 
toolbar (Table 5). Save the file in the desired location with the desired file name from the ‘Save 
Peak Table’ window. A confirmation box will appear after the table is successfully saved. 
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5.C.	 Navigating the ‘All Color Browser’ Window 

When reviewing processed data, select the Browse by All Colors icon in the toolbar to view the 
electropherograms with separate charts for each selected color (Figure 83). This functionality 
is similar to use of the ‘Browse by All Colors’ icon in the ‘Main Analysis’ window for raw data 
(Section 3.C.4) to view a separate electropherogram for each selected dye color. 
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Figure 83. ‘All Color Browser’ window with processed data.
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The same icons and functions used to view raw data in the ‘Browse by All Colors’ window 
(Table 4) can be used to view the processed data. Several additional icons are available when 
reviewing processed data (Table 7).

Table 7. Additional All Color Browser Icons and Functions Available for Processed Data.

Show/Hide Bin Ranges: Toggles between a view where the bin brackets 
are displayed at the top and bottom of the electropherogram and a view 
where the bin brackets are not visible.

Auto Scale Markers: When selected, adjusts the RFU intensities of low 
peaks to match the intensity of the highest peak in the dye color. When 
low peaks are increased, the intensity magnification factor is noted in the 
marker (2X–8X).
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Print: Opens the ‘All Color Browser Settings’ window to print or save the 
display of a single sample from the ‘All Color Browser’ window with the 
specified settings (Section 9).

The ‘Show Chart/Table’ is the same icon as in the ‘Main Analysis’ window (Table 5). The same 
right-click menu is available in the electropherogram chart of the ‘Main Analysis’ window and 
the ‘All Color Browser’ window, with the additional ‘Set Axis’ option. The ‘Set Axis’ option allows 
you to adjust the scale of the y axis. 

To close the ‘All Color Browser’ window and return to the ‘Main Analysis’ window, select the X in 
the upper right-hand corner.

Note: The software will not close if the ‘All Color Browser’ window is open and minimized.

5.D.	 Navigating the Profile Comparison View

In addition to the standard electropherogram view (Section 5.B) and the ‘All Color Browser’ 
window (Section 5.C), you can view processed data using the ‘Profile Comparison View’ 
application. This application allows you to graphically display any combination of selected 
samples and dye colors in a 2-dimensional (2D) or 3-dimensional (3D) view. The Profile 
Comparison View can be accessed through the ‘Applications’ menu. 
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Figure 84. ‘Profile Comparison View’ window.

The toolbar within the ‘Profile Comparison View’ window (Figure 84) provides options for 
changing the display of the electropherograms. Many of these tools function the same or 
similarly to those found in the ‘Main Analysis’ window (Section C.3.2). 

Table 8. Icons and Functions of the Profile Comparison View.
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Show Dye: Allows you to select the displayed dye channels.
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Zoom In: Zooms in on the center point of the electropherogram
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Zoom Out: Zooms out from the center point of the electropherogram 
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Option: Provides display options for the application. By default all 
viewing options are selected. Deselect options that are not needed or 
desired.
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Save: Opens a ‘Save’ window to save the ‘Profile Comparison View’  
image as a bitmap (.bmp) file.
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Show 3D: When selected, displays the electropherograms of the 
selected samples in a 3D view. 

17
63

3T
A 2D Offset: Changes the offset of displayed electropherograms. By 

default, the electropherograms are overlaid; sliding the bar to the right 
separates the plots to the desired degree, from 0–100%.
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Table 8. Icons and Functions of the Profile Comparison View (continued). 

3D Percent: Indicates the depth of field when in 3D mode. The ‘2D  
Offset’ slider bar becomes the ‘3D Percent’ slider bar when the ‘Show 
3D’ box is checked.
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Marker Drop-down Menu: Allows you to select a marker to view. This 
menu functions the same as in the ‘Main Analysis’ window (Table 5).

Samples contained within a project are listed on the left of the ‘Profile Comparison View’ 
window. There are two display options: ‘Sample List’ and ‘Line List’. ‘Sample List’ lists all 
samples in the project with check boxes next to the sample file names. ‘Line List’ displays only 
the samples selected from the ‘Sample List’.

To compare electropherograms across samples, select the desired samples from the ‘Sample 
List’ by checking the box next to the sample file name and selecting OK at the bottom of the 
list. An overlay of the electropherograms for all selected samples will be displayed in the 
electropherogram area. 

You can choose the dye channels displayed in the electropherogram using the Show Dye icon 
in the toolbar (Table 8). 

Just as in the ‘Main Analysis’ window, users can zoom in or out from the electropherogram 
using the mouse or the ‘Zoom In’ and ‘Zoom Out’ icons in the toolbar. 

By default, all the available display options are turned on. Specific options can be deselected 
using the ‘Option’ icon. 

	 Auto Y: When selected, the y axis is set to auto scale based on the maximum peak 
intensity of the data within a given view.

	 Mouse Zoom: When selected, the mouse can be used to zoom in and out from the 
electropherogram. 

	 Show Grid: When selected, grid lines for x- and y-axis labels appear.

	 Use Dye Color: When selected, electropherograms are displayed in their assigned dye 
channel colors. When not selected, electropherograms are displayed in black, 
regardless of assigned dye color channel.

	 Show Panel: When selected, the electropherogram displays the marker labels for all 
displayed dye channels.

	 Show File Names in 2D: When selected, the sample file names are displayed below the 
electropherograms of selected samples. 

	 Note: When this option is used, set the 2D offset above 0% to ensure the sample file 
names do not obscure each other. 

To close the ‘Profile Comparison View’ window and return to the ‘Main Analysis’ window, select 
X in the upper right-hand corner. 
Note: The software will not close if the ‘Profile Comparison View’ window is open and minimized.
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5.E.	 Navigating the Report Table

The Report Table displays peak information for each sample in a project based on defined 
settings for the table. Additional settings for the Report Table are accessed via the ‘Report’ tab 
of the ‘Preferences’ window (Section 6.B).

Note: Modifications to the report settings will automatically be saved.

Table 9. Report Table Toolbar Icons. 
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Report Settings: Opens the ‘Allele Report Settings’ window where you can 
define the report style and other features displayed in the report .
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Save Report: Opens a ‘Save Report’ window to save the Report Table as 
an Excel (.xlsx), text (.txt) or CSV (.csv) file. The arrow allows you to choose 
between a standard report and a LIMS report. Additional settings options 
are available when the LIMS report is selected (Section 5.E.2).
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Help: Provides a list of Report Table actions as well as definitions for all  
quality reasons.

A peak selected in the Report Table will also be selected in the Peak Table and 
electropherogram. There are three options to select a peak in the Report Table: 

1. 	 Double-click on the desired peak.

2. 	 Use the arrow keys to move to the cell of interest within the Report Table, and press 
the Enter key.

3. 	 Use Alt + Arrow keys to move to different cells within the Report Table.

Note: A marker selected in the ‘Marker Drop-down’ menu in the main analysis toolbar will 
update to display information from the selected marker in the Report Table, Peak Table and 
electropherogram. To return to full display, select None from the ‘Marker Drop-down’ menu. 

The rules by which the Report Table and other frames in the ‘Main Analysis’ window are linked 
can be changed in the ‘Report’ tab of the ‘Preferences’ window (Section 6.B).
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5.E.1	 Features of the Report Table
Display Options

You can change the display of the Report Table to suit your needs. To view or change the 
display, select the Report Settings icon in the Report toolbar. This will open the ‘Allele Report 
Settings’ window (Figure 85). 
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Figure 85. ‘Allele Report Settings’ window.

There are five options for report style (Figure 85) that affect the Report Table display: Allele 
List, Forensics, Bin Table, Peak Table and Allele Count. Each style has a different set of options 
for further customizing the information displayed. These styles and associated options are 
discussed in more detail below.

In addition to the ‘Report Style’ and ‘Options’ sections, the ‘Allele Report Settings’ window has 
several other options that affect display of samples in the Report Table. Some of these options 
are disabled for certain report styles, as noted below in the description of each report style. 
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Table 10. Options for Allele Report Settings. 

Show File Name: Displays the sample file name for each sample in the report.

Show Sample Name: Displays the sample name for each sample in the report. 

Orientation: Determines whether the report is displayed horizontally or 
vertically. 

•	 “Horizontal”: Displays sample names on the left in rows and 
markers at the top in columns.

•	 “Vertical”: Displays sample names in the far left column in 
rows with markers listed in the second column. Alleles, in 
order of base pair size, appear in subsequent columns.

Exclude Sample Index: GMHID-Spectrum automatically assigns each line in the Report 
Table a consecutive number (sample index), displayed in the left-
most column. Select the Exclude Sample Index box to exclude 
this column from the exported Report Table.

Exclude Report Header: Excludes the report header from the exported table. This can be 
beneficial for import into some LIMS systems.

Show [__] When No 
Allele Call: 

Inserts a symbol or short word into the cells of the Report Table 
when no peaks are detected by the software at that marker. The 
default symbol is **. If this option is not selected, these cells will 
be blank.

Show Only Uncertain 
Alleles:

Displays only the peaks that did not pass the Analysis Quality metrics 
set in the Run Wizard and ‘Preferences’ window (Sections 4.C, 6.B 
and 10).

Show Rejected Low 
Score Alleles:

Displays peak scores below the settings found in the ‘Peak Score 
Reject’ setting in the ‘Additional Settings - HID Settings’ window of 
the Run Wizard.

Hide Extra Sample 
Names:

Displays the sample name once in the first row associated with 
that sample. If this option is not selected, the sample names 
are repeated for each row of data associated with that sample. 
This option is only available when “Vertical” is selected as the 
‘Orientation’.

Show Selected  
Samples:

Includes only samples selected in the Sample File Tree in the 
Report Table.

Each report style provides different advanced options.
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‘Allele List’ Report Style

The most basic report style is ‘Allele List’ (Figure 86). This style displays the allele label (or just 
the base pair size, if a panel is not applied) of the called peaks in horizontal orientation. The 
‘Show [__] When No Allele Call’ and ‘Hide Extra Sample Names’ options are disabled. All other 
basic options can be changed (Figure 86). 

Figure 86. 
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 ‘Allele List’ Report Style.

‘Quality’ flags at the marker level (Table 11) are automatically displayed in the ‘Allele List’ report 
style. These flags provide a quick assessment of profile quality from the Report Table. Details 
of the parameter(s) not met, including quality reasons, are listed in the allele label and the Peak 
Table (Section 10). 

The quality metrics in Table 11 are not viewable for samples listed in the ‘Bin Table’ or ‘Allele 
Count’ report styles.

Table 11. Quality Metrics Flags.

Flag Quality
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Pass
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Undetermined
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‘Forensics’ Report Style

The default report style of GMHID-Spectrum is ‘Forensics’ (Figure 87). This style displays the 
‘Quality’ designation and ‘Allele Label’ of each called peak (Section 10.A.3). As in the Sample 
File Tree, samples that do not to meet the ‘Analysis Quality’ settings defined in the Run Wizard 
and ‘Preferences’ menu are flagged with a red question mark in the sample index column.

 
When the ‘Forensics’ report style is selected, additional display options are available in the 
‘Options’ section of the window depending on the chosen orientation (i.e., “Horizontal” or 
“Vertical”) of the table (Figure 87 and Figure 88). 

Note: The ‘Forensics’ report style requires that a panel is applied to the data (Section 4.A.1). 

Figure 87. 
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 Horizontal orientation of the ‘Forensics’ report style.

Figure 88. 
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Vertical orientation of the ‘Forensics’ report style.
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Options for ‘Forensics’ Report Style

	 Extend Diploid Homozygous: When selected, homozygous alleles are reported as a 
genotype (two alleles), not a phenotype (one allele). This option is only active when the 
‘Edit Panel Ploidy’ option is set to 2-Diploid (Section 4.A.1 in the panel file). 

	 Note: When the Orientation is set to horizontal, the ‘Extend Diploid Homozygous’ 
option is the only advanced option available and ‘Show Allele Name’ is on by default 
and cannot be disabled (Figure 87).

	 Split Items: When selected and when more than one of the Show Allele Name, Show 
Size, Show Height, Show Area or Show Score options are selected, the values are 
displayed in individual columns. When Split Items is not selected and the Show Size, 
Show Height, Show Area or Show Score options are selected, these values are 
displayed in parentheses in the Allele # columns of the report. 

	 Note: When one or more of the Show Allele Name, Show Size, Show Height, Show 
Area or Show Score options are selected, these values are all displayed within the 
same cell of the ‘Forensics’ report. Parentheses separate the ‘Allele Name’ from any 
other peak attributes displayed in the same cell.

	 Show Allele Name: When selected, the Allele Name is displayed in the ‘Forensics’ 
report.

	 Show Size (0.1bp): When selected, the Size is displayed in the ‘Forensics’ report.

	 Show Height: When selected, the Peak Height is displayed in the ‘Forensics’ report.

	 Show Score: When selected, the Quality Score is displayed in the ‘Forensics’ report.

	 Quality flags at the marker level (Table 11) are automatically displayed in the 
‘Forensics’ report style. These flags provide a quick assessment of profile quality from 
the Report Table. Details of the parameter(s) not met, including quality reasons, are 
listed in the allele label and the Peak Table (Section 10).
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To export data for downstream use in STRMix™ and MaSTR™ software, ensure the ‘Forensics’ 
report style is used with the selected options shown below (Figure 89). 
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Figure 89. Configuration of ‘Allele Report Settings’ window for STRMix™ and MaSTR™ software compatibility. 

‘Bin Table’ Report Style

The ‘Bin Table’ report style displays the presence or absence of a peak at every bin location for 
the samples in the dataset. The use of this style requires at least one peak in one sample to be 
detected. When the ‘Bin Table’ report style is selected, additional display options are available in 
the ‘Options’ section of the screen (Figure 90).

Figure 90. 
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 ‘Bin Table’ report style.
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Options for ‘Bin Table’ Report Style

	 Abide By Panel: When selected, the Bin Table shows only called alleles within panel 
marker ranges. This option is only active when a panel is applied to the data.

	 Show Type Symbol: When selected, the specified symbols are displayed to indicate 
when a peak is present at the bin site (Positive), absent at the bin site (Negative) or did 
not pass a quality metric (Suspected) (Section 10.A.3).

	 Show Intensity (Raw): When selected, displays the peak intensity (RFU) value for all 
‘Positive’ and ‘Suspected’ bin sites. A “0” value is given to ‘Negative’ bin sites. Selecting 
Raw will show the raw data peak intensity values for all bin sites including ‘Negative’ 
bin sites.

	 Show Area: When selected, displays the peak area value for all ‘Positive’ and ‘Suspected’ 
bin sites. 

	 Show Score: When selected, displays the peak score for all ‘Positive’ and ‘Suspected’ bin 
sites.

	 Note: When more than one ‘Bin Table’ display option is selected, dollar signs ($) 
separate these values in the ‘Bin Table’ report. 

‘Peak Table’ Report Style

The ‘Peak Table’ report style displays user-defined peak statistics in horizontal orientation. All 
other options can be changed. When the ‘Peak Table’ report style is selected, additional display 
options are available in the ‘Options’ section of the window (Figure 91).
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Figure 91. Peak Table report style.
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Options for ‘Peak Table’ Report Style

	 Size Range (bps): When selected, allows you to define a specific base pair range from 
which the peak information will be displayed.

	 Abide By Panel: When selected, displays information for each bin in the panel 
regardless of whether a peak is detected in a bin or not. If no peak is detected in a 
marker, the symbol designated in the ‘Show [__] When No Allele Call’ setting is 
displayed in the cell. This ‘Abide By Panel’ option is only active when a panel is applied 
to the data.

	 Grouped by Markers: When selected, displays each marker in its own row per sample 
and lists the information from all peaks within the marker consecutively across the 
columns at the top of the table. Under this setting, ‘Abide By Panel’ is locked and not 
applied. This option is only active when a panel is applied to the data. 

	 When neither Abide By Panel nor Grouped by Markers is selected, each peak detected 
within a marker is represented in its own row.

	 Columns: Opens the ‘Set Peak Table Columns’ window (Figure 92) to select the 
columns to display in the Report Table. The columns displayed in the Peak Table report 
are similar to those available in the Peak Table of the ‘Main Analysis’ window 
(Section 5.B.2). The ‘All Columns’ field on the left lists the available columns not yet 
selected to be listed in the report. The columns currently being displayed in the Report 
Table are listed in the ‘Selected Columns’ field on the right. 

	 Note: The order of the columns displayed in the ‘Selected Columns’ field is the order 
displayed in the Report Table.
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Figure 92. ‘Set Peak Table Columns’ window.

	 Adding Columns to the Report Table: Columns can be added to the Report Table 
individually or as a group. To add columns individually, select the desired column 
header in the ‘All Columns’ field and select the Add button. To add more than one 
column, hold down the Shift key and select the desired consecutive columns or hold 
down the Ctrl key and select the desired columns; select the Add button. To add all the 
columns listed in the ‘All Columns’ field to the Report Table, select the Add All button. 
Added columns will appear in the ‘Selected Columns’ field.
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	 Removing Columns from the Report Table: Columns can be removed from the Report 
Table in the same manner as adding columns. Select the column(s) to be removed 
from the ‘Selected Columns’ field and select the Remove button to move the column(s) 
to the ‘All Columns’ field. To remove all columns listed in the ‘Selected Columns’ field 
from the Report Table, select the Remove All button. Removed columns will appear in 
the ‘All Columns’ field.

	 Quality flags at the marker level (Table 11) are automatically displayed in the ‘Peak 
Table’ report style. These flags provide a quick assessment of profile quality from the 
Report Table. Details of the parameter(s) not met, including quality reasons, are listed 
in the allele label and the ‘Quality’ and ‘Quality Reason’ columns of the Peak Table  
(Section 10).

‘Allele Count’ Report Style

The ‘Allele Count’ report style displays the number of called alleles marked with a ‘Pass’ quality 
designation in each marker. Peaks marked as ‘OB’ or with a ‘Check’ or ‘Undetermined’ quality 
designation will not be counted. A ‘Total Number’ column lists the number of peaks detected in 
the sample (Figure 93).

Note: Allele Count requires that a panel is applied to the data (Section 4.A.1).

The ‘Show Only Uncertain Alleles’, ‘Show Rejected Low Score Alleles’ and ‘Hide Extra Sample 
Names’ options are disabled in this report style. The ‘Show Rejected Low Score Alleles’ is on by 
default and cannot be changed. All other options are available for edit.
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Figure 93. ‘Allele Count’ report style.
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5.E.2	 Sorting, Editing and Saving the Report Table 
A variety of sorting and editing options are available depending on which report style is 
selected. The available options are accessible by right-clicking within the Report Table. 

Table 12. Sort Option Availability by Report Style. 

Sort Option Report Style Orientation

Sort by Marker Forensics Horizontal and Vertical

Peak Table

Allele Count

Sort by Column Allele List Horizontal

Forensics 

Bin Table

Peak Table

Allele Count

Sort by Marker: Table is sorted based on the Peak Quality Score of the selected marker in 
ascending or descending order. Ascending order moves lower quality peaks to the top of the 
table; descending order moves lower quality peaks to the bottom of the table. This option is 
only available with ‘Forensics’, ‘Peak Table’ or ‘Allele Count’ report styles.

Sort by Column: Table is sorted based on the values in the selected column in ascending or 
descending order. If ascending is chosen, then lower values will be sorted to the top of the 
table and higher values to the bottom the table. If descending is chosen, higher values will be 
sorted to the top of the table and lower values to the bottom the table. This option is available 
with all report styles when viewed in the horizontal orientation. 

Editing Peaks

Peaks can be edited from the Report Table. To edit a peak, first select the peak of interest 
by clicking on the cell that contains the peak; this selects the allele in the Report Table. 
Alternatively, select the peak by double-clicking the cell that contains the peak; this selects the 
allele in the Report Table, electropherogram and Peak Table. With the desired allele selected, 
right-click and select the appropriate editing function or use the shortcut described below. All 
changes made to peaks from the Report Table will be reflected in the electropherogram and 
Peak Table as described in Section 5.B.3.

	 Delete Peaks: Removes the peak from the profile (Shortcut = DEL). 

	 Confirm Peaks: Acts in the same manner as the ‘Confirm Allele’ option within the 
electropherogram and Peak Table (Shortcut = CTRL+M). Confirmed alleles can be 
unconfirmed in the electropherogram or Peak Table as described in Section 5.B.3.
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	 Peak Information

	 To view information about a peak, press the ALT key and select the peak cell of 
interest. The ‘Allele Peak Info’ window appears, displaying the ‘Sample’, ‘Dye’, ‘Size’, 
‘Marker’, ‘Allele’, ‘Score’ and ‘Comments’ information (Figure 94). The information in 
these fields cannot be edited. This option is available in all report styles except ‘Allele 
Count’.

16
79

0T
A

Figure 94.  ‘Allele Peak Info’ window.

	 The ‘Bin Table’ report style offers additional options when a cell in the table is right-
clicked.

	 Insert a Peak at this Bin Site

	 The ‘Insert a Peak at this Bin Site’ option is available only at bin sites where a peak is 
not present (i.e., Negative bin sites). To use this option, right-click the Negative bin site 
and select Insert a Peak at this Bin Site. A ‘Confirmation’ window will appear 
describing the location of the new peak. Select Yes to insert a peak at the selected bin 
site. The ‘Negative Type Symbol’ will change to the ‘Positive Type Symbol’. The peak 
specifications will be calculated and displayed in the Peak Table. “Confirmed and 
Inserted” will be displayed in the ‘Allele Comments’ column of the Peak Table.  
(Shortcut = INS).

	 Delete Bin Columns

	 When the orientation is set as “Horizontal” in the ‘Allele Report Settings’ window  
(Figure 87), selecting the Delete Bin Columns option deletes the selected bin column 
in the Report Table. When the orientation is set as “Vertical”, selecting this command 
deletes the bin row in the Report Table rows (not the columns that contain the sample 
information).



91      GeneMarker®HID Software for Spectrum CE Systems | TM555 | Revised 1/23

Reviewing Processed Data

Saving the Report Table

The Report Table can be saved in the displayed format or as a LIMS Report.

	 Save Report Table

	 You can save changes to the Report Table as an Excel (.xlsx), text (.txt) or CSV (.csv) 
file by selecting the Save Report icon in the ‘Report Table’ toolbar.

	 	In the ‘Save Report Table’ window, browse to the desired file location and save the file with 
the desired file name. When the report has been successfully saved to the location, an 
information box will appear to notify the user. Select OK to close the box.

	 To export only selected cells in the Report Table, highlight the desired cells, then right-click 
on the highlighted cells and select Copy (Shortcut = CTRL + C). The information is saved to 
the Windows® clipboard and can be pasted into any common word processing or 
spreadsheet program. The row and column headers for those cells will be copied along 
with the highlighted cell information.

	 In addition to saving the Report Table in the displayed format, you also can save the table 
as a LIMS Report.

	 LIMS Report

	 The LIMS Report is a specialized function designed for LIMS exporting compatibility. To 
access the LIMS Report settings, first ensure that the “Show LIMS Report Settings Box” in 
the ‘Report’ tab of the ‘Preferences’ window is selected (Section 6.B). Then select the arrow 
to the right of the Save icon, and select Save LIMS Report (Figure 95). 
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Figure 95. Saving a LIMS Report.

	 The ‘LIMS Report Settings’ window will be displayed (Figure 96). Some of the same report 
options available in the Report Table are available in the LIMS Report: ‘Show File Name’, 
‘Show Sample Name’, ‘Show Deleted Peaks’, ‘Show [__] when no allele call’, ‘Show Only 
Uncertain Alleles’, ‘Show Rejected Low Score Alleles’, ‘Exclude Report Header’ and ‘Hide 
Extra Sample Names’. The advanced options available in the ‘Peak Table’ report style 
(Section 5.E.1) are also available in the LIMS Report. In addition, you can select which dyes 
are exported to the LIMS Report using the check boxes in the ‘Dyes’ section of the window.

Figure 96. ‘
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LIMS Report Settings’ window.
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5.F.	 Re-Analyzing Processed Data

A project can be re-analyzed after the initial run template is applied by using one of three 
options. 

Note: Manual edits will be lost when data is re-analyzed.

1.	 Re-analyze with Run Wizard: To re-analyze with the ‘Run Wizard’ tool, select the Run 
Project icon in the ‘Main Analysis’ window toolbar. The Run Wizard will open and 
display the most recently selected parameters. Adjust parameters as necessary, and 
select OK in the ‘Additional Settings – HID Analysis’ window. The ‘Use Old Calibration’ 
window will appear with the option to ‘Call size again’ (Figure 97). Only select Call size 
again if the size standard template listed in the ‘Template Selection’ window of the Run 
Wizard was changed or any of the parameters in the ‘Data Process – HID Analysis’ 
window were changed. Select the Apply to All button to apply the chosen ‘Use Old 
Calibration’ window setting to all samples. Alternatively, select Apply to Current to 
choose and apply the setting on a sample by sample basis. The ‘Data Processing 
Event Log’ window will appear again, and the data will be re-analyzed with the new 
parameters.

	 Note: The ‘Use Old Calibration’ window has a countdown timer of 30 seconds after 
which the window will automatically close and re-analysis will continue. 
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Figure 97. ‘Use Old Calibration’ window.

2.	 Re-analyze with Auto Run: To re-analyze with Auto Run, select the Auto Run option in 
the ‘Project’ menu. This will apply the most recently used ‘Run Wizard’ template to the 
project data.

3.	 Re-analyze Individual Samples: To re-analyze an individual sample, dye color or 
marker, select the Call Allele icon 
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 in the ‘Main Analysis’ window toolbar to open 
the ‘Recall Allele’ window. 

	 The arrow next to the ‘Call Allele’ icon opens a pop-out menu, which allows you to 
choose the samples to re-analyze (Figure 98).
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Figure 98. ‘Call Allele’ menu options.

Call Allele-All Samples: Applies the new parameter settings to all samples in the project. 

Call Allele-Opened Samples: Applies the new parameter settings only to samples selected in 
the Sample File Tree. 

Call Allele-Current Sample: Applies the new parameter settings only to the sample highlighted  
in the Sample File Tree.

Call the Marker: Applies the new parameter settings to the marker selected in the ‘By Marker’ 
field of the ‘Call Allele By’ section of the ‘Recall Allele’ window (Figure 99).

Call the Dyes: Applies the new parameter settings to all markers in the selected dye channels 
in the ‘By Dyes’ field of the ‘Call Allele By’ section of the ‘Recall Allele’ window (Figure 99). 

The ‘Recall Allele’ window consolidates the main analysis parameters of the Run Wizard 
into one screen and allows the user to make adjustments that will be applied to the selected 
sample(s), dye color, or marker, serving as a helpful research tool when evaluating parameter 
settings (Figure 99). Once the desired changes to the ‘Allele Call’, ‘Ladder’, ‘Auto Select Best 
Ladder’, ‘Auto Panel Adjustment’, ‘Positive Control Template’, ‘Allele Evaluation’ or ‘Mixture 
Evaluation’ sections are made, select OK to apply the changes and re-analyze the selected 
data. The ‘Data Processing Event Log’ window will appear again and the data will be re-
analyzed with the new parameters. 

Note: When Call Allele–Opened Samples, Call Allele–Current Sample, Call the Dyes or Call 
the Marker is selected, the ‘Panel’, ‘Ladder’ and ‘Positive Control Template’ fields become 
inactive.

Figure 99. 
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‘Recall Allele’ window.
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The following options can be found in the menu bar of the ‘Main Analysis’ window.

6.A.	 ‘File’ Menu

The ‘File’ menu contains functions for opening, saving and closing raw and processed data as 
well as exiting the program (Figure 100).
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Figure 100. ‘File’ menu.

Open Data: Opens the ‘Open Data Files’ window, where you can select raw data files for 
uploading into the software. 

Open Project: Opens the ‘Open Project’ window, where you can select previously saved project 
files (.sgf).

Reopen Project: Lists the last four projects that were opened by GMHID-Spectrum and allows 
the user to select any one of those four projects to open.

Save Project: Saves a project (.sgf) to a specified directory. Raw data files and analyzed data 
files with edits are saved within a project file. Once a project is saved, the name of the folder in 
the Sample File Tree will change from “Untitled” to the project name. 

Save Selected Samples: Saves a project (.sgf) for the samples selected in the Sample File 
Tree to a specified directory. Raw data files and analyzed data files with edits for the selected 
samples are saved within the project file.

Close All: Closes a project without exiting the program. 

Exit: Closes the GMHID-Spectrum software.
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6.B.	 ‘View’ Menu 

The ‘View’ menu contains options for controlling how data are displayed in the ‘Main Analysis’ 
window (Figure 101).
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Figure 101. ‘View’ menu.

View Project History: Opens the ‘Show Edit History’ window for the entire project. This 
functions the same as the ‘Show Edit History’ window accessed via the ‘View History’ option 
within the Peak Table (Section 5.B.3). The project history displays all edits made to all samples 
in a project, including edits automatically applied by the software based on user preferences 
(e.g., auto-deleting variant alleles in allelic ladder samples; see Preferences below).

Show Navigator/Gel Image/Report: Opens and closes the ‘File Navigator’, ‘Gel Image’ or 
‘Report Table’ frames in the ‘Main Analysis’ window.

Preferences: Opens the six-tab ‘Preferences’ window (Figure 102). Changes made to any of 
these tabs are automatically saved to the Preferences program template file (Section 2.C). 
Selecting Import/Export in the bottom left corner of the window provides two options. The 
user can export the current ‘Preferences’ settings as a .ini file using Export to File or import a 
‘Preferences’ .ini file using Import from File.  
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Figure 102. ‘Start Up’ tab of the ‘Preferences’ window.

The six tabs of the ‘Preferences’ window (Figure 102) are described as follows:
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6.B.1	 The ‘Start up’ Tab 
The ‘Start up’ tab of the ‘Preferences’ window (Figure 102) allows you to select the Run Method 
and General Settings that will be applied when the software is launched. The ‘Start up’ tab also 
allows the user to set the file path directories for project file management.

Run Method: There are two options for run method operation within GMHID-Spectrum: Classic 
and Wizard.

1. 	 Classic: Disables the ‘Magic Wizard’ upon launch of the software. This allows the user 
to move through data importing, activating the ‘Run Wizard’ and saving a project 
without prompts.  

2. 	 Wizard: Activates the ‘Magic Wizard’ (Section 6.E) when the software is launched to 
guide the user though the Data Import, Run Wizard and Save Project functionalities. 
The Wizard radio button is checked by default.

General Settings: Determines which sections of the ‘Main Analysis’ window (‘Navigator’, ‘Gel 
Image’ and ‘Report Table’) are displayed upon launch of the software. 

	 Note: When Show Report is checked, the Report Table will automatically be displayed 
after the raw data are processed. 

Import Directories: Defines the default folder location for importing raw data and saved project 
files to decrease the amount of navigation required.

Export Directories: Defines the default folder location for exporting reports to decrease the 
amount of navigation required.
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6.B.2	 The ‘Display’ Tab
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Figure 103.  ‘Display’ tab of the ‘Preferences’ window.

The ‘Display’ tab of the ‘Preferences’ window defines how data are displayed in the 
Electropherograms, Gel Image and Sample File Tree (Figure 103).

The ‘Allele Label’ section defines how information is displayed in the Allele Label under peaks in 
the electropherogram.

Decimal Precision: Determines decimal places (0 to 2) to be displayed in peak size label.

Font Size: Sets the font size of the displayed text (also refers to size of text for print display).

Mark Off-Marker as “OL”: Labels peaks that are outside of the marker ranges as “OL”. 

Mark Off-Bin as “OB”: Labels peaks within a marker range, but outside of a bin, as “OB”. 

Use Size String for Label: Labels peaks according to size instead of allele call. To display the 
size string as an integer, set the ‘Decimal Precision’ to 0.

Flag Variant Alleles in Ladder: Marks peaks in virtual bins with higher than expected peak 
heights with yellow vertical bars and green allele labels in allelic ladder samples (Section 10).

Show All Allele Labels: Displays all allele labels for all selected dye channels. If more than 
one dye channel is displayed in the electropherogram and this check box is not checked, allele 
labels will be displayed only for the dye channel at the top of the electropherogram. 

Set Missed Allele as Single Line in Ladder: Places allele labels for missing ladder peaks one 
row above allele labels for ladder peaks that were called. 
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The ‘Chart Settings’ section defines how data are displayed in the electropherograms of the 
‘Main Analysis’ window. The ‘Max Allele Label Layers’, ‘Show Saturation Alert Line’ and ‘NOT 
Scale Y Axis for Negative Control’ settings will also apply to the electropherogram display in the 
‘All Color Browser’ (Section 5.C). 

Max # of Open Charts: Sets the maximum number of samples to be displayed in the 
Electropherogram and Peak Table area at one time (maximum = 96). To open the maximum 
number of samples specified here, right-click within the Sample File Tree and choose Select 
Max.

Max Chart # in Page: Sets the maximum number of electropherograms and Peak Tables to 
be displayed in the ‘Main Analysis’ window at one time (maximum = 8). To view other groups 
of samples, use the ‘Page Up’ or ‘Page Down’ links at the bottom of the Sample File Tree. If the 
‘Max Chart # in Page’ is lower than the ‘Max # of Open Charts’, and the maximum number of 
open charts is open, a scroll bar will appear to view additional electropherograms and Peak 
Tables.

Max Allele Label Layers: Sets the maximum number of layers (i.e., rows) for allele labels 
(maximum = 10). For example, if “1” is entered, all allele labels will be displayed as one row. 
This may lead to overlap of allele labels in samples with multiple alleles (such as allelic ladders 
and mixtures). If the maximum of “10” is entered, the allele labels will be staggered across 10 
rows below the electropherogram, minimizing the amount of label overlap.

Show Sample Name: When selected, displays the sample name as read from the data file 
above the electropherogram, in parentheses after the file name.

Show Saturation Alert Line: When selected, displays a purple vertical line through the regions 
of raw data where saturation was detected by the collection software.

Show Loci Box with Multi-line: When selected, displays the marker labels in a staggered 
format, rather than an overlaid format, when multiple dye channels are displayed in the ‘Main 
Analysis’ window. When this setting is applied, the marker labels are outlined in the color of the 
dye channel in which they’re located. 

Note: When Show Loci Box with Multi-line is selected, the marker labels in the red dye channel 
will mask allelic ladder quality flags for errors in bin shifting and peaks in virtual bins with 
higher-than-expected peak heights (Section 10). 

NOT Scale Y Axis for Negative Control: When selected, zooming in and out on an 
electropherogram will not affect y-axis scaling for samples marked as negative controls.
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The ‘Peak Label’ section defines information included in a peak label (if chosen) as well as 
layout options for the label (vertical or horizontal). Up to four labels (size, height, area and 
score) can be displayed for each peak in the electropherogram. If no labels are chosen, peaks 
are labeled with only allele calls as prescribed in the ‘Allele Label’ section.

Position: Sets the position of the peak label in relation to the peak: at the top, to the right side, 
or in the allele label in the electropherogram. 

Layout Style: Determines whether peak labels are displayed vertically or horizontally. 

The ‘Gel Image’ section defines the display of the synthetic gel image.

Gray for Single Dye: When selected, displays and prints the gel image with a black background 
and white bands instead of colored bands (depending on which dye channels are displayed).  
Note: When all dye colors are selected, the bands in the gel image are displayed in color 
regardless of whether this option is selected.

Background in White: Inverts the gel image so that the background is white and band 
fragments are black. This setting is available only when Gray for Single Dye is selected.

6.B.3	 The ‘Forensic’ Tab
The ‘Forensic’ tab of the ‘Preferences’ window is used to set additional Report Table and 
electropherogram settings, as well as the file naming conventions used by the laboratory for 
ladders and controls (Figure 104). 
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Figure 104. ‘Forensic’ tab of the ‘Preferences’ window.
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Show Ladder Samples in Report: Includes samples designated as ‘Ladders’ by the ‘Ladder’ 
identifier field in the Report Table. Select this option if data will be exported for use in 
probabilistic software programs, including STRMix™ and MaSTR™ software. 

Show Control Samples in Report: Includes samples designated as ‘Positive’ and ‘Negative’ 
controls by the ‘Positive Ctrl 1’, ‘Positive Ctrl 2’ and ‘Negative Ctrl’ identifier fields in the Report 
Table.

Mark Deleted/Edited Peaks with Symbols: Marks deleted peaks with an “X” at the top of the 
peak. Edited peaks are marked with an “E” at the top of the peak.

Auto-Delete Alleles in Virtual Bins in Allelic Ladder: Automatically deletes peaks in virtual 
bins with higher-than-expected peak heights in allelic ladder samples. 

Label Peak Ratio: Allows you to display the peak ratio, calculated using the height or area, in 
peak labels. This option is only applicable when the peak label setting is set to peak top or peak 
right (Section 6.B.2).

Sample Type Identifier in Filename: Allows the software to automatically identify allelic 
ladders, positive controls and negative controls using the laboratory’s file naming conventions. 
Entering the laboratory file naming convention in the fields provided allows the software to 
auto-identify these sample types. If the specified sequence of characters defined for a sample 
type is found anywhere in the sample name, the software automatically identifies the sample 
type. For example, if ‘Ladder’ is used as the identifier for the ladder sample type, samples 
named ‘Ladder’, ‘Allelic Ladder’ and ‘Ladder 1’ are all identified as ladders. Changes made to the 
identifiers are applied and samples containing these identifiers will be automatically identified 
when OK is selected in the ‘Preferences’ window.

Note: The ‘Identifier’ fields are not case-sensitive. To implement a change in the ‘Identifier’ 
fields without re-analyzing data with the Run Wizard, right-click any sample in the Sample File 
Tree and select Set Sample Type/Auto Identify (Figure 105). 

Ladder: Labels samples identified as ladders with the prefix “LD” before the sample name and 
changes the font color of the file name to blue in the Sample File Tree. Samples identified as 
ladders will be checked against the expected allelic ladder profile for the selected panel. This 
setting is required to use the ‘Auto Select Best Ladder’ and ‘Auto Panel Adjustment’ features of 
the Run Wizard (Section 4.C.1). The default setting is “LADDER”.

Note: The ‘Ladder’ option affects the operation of the ‘Auto Select Best Ladder’ and ‘Auto Panel 
Adjustment’ features in the ‘Additional Settings - HID Analysis’ window of the Run Wizard. After 
modifying the ‘Ladder’ field, re-activate the Run Wizard and proceed through the ‘Additional 
Settings - HID Analysis’ window (Section 4.C.1).
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Positive Ctrl 1 and Positive Ctrl 2: Defines up to two positive control identifiers, ‘Positive Ctrl 
1’ and ‘Positive Ctrl 2’. Labels samples identified as Positive Ctrl 1 with the prefix “PC1”. Labels 
samples identified as Positive Ctrl 2 with the prefix “PC2”. The font color of the file name will 
change to green in the Sample File Tree. Samples identified as positive controls will be checked 
against the expected genotype of the corresponding Positive Control Template selected in the 
Run Wizard. A ‘Positive Ctrl’ identifier is required to use the ‘Positive Control Template’ feature 
of the Run Wizard. If only one Positive Control Template is used, the ‘Positive Ctrl 2’ field can be 
left blank. The default setting for Positive Ctrl 1 is “POS“. 
Note: When using both positive control identifiers, each identifier must be mutually exclusive 
from the other. Identifiers cannot contain the same string of letters or characters. For example, 
if Positive Ctrl 1 is “POS”, Positive Ctrl 2 cannot be “POS2”, “Positive” or any variation that 
contains the letters POS as part of the string.

Negative Ctrl: Labels samples identified as negative controls with the prefix “NC” and changes 
the font color of the file name to red in the Sample File Tree. A ‘Negative Ctrl’ identifier is 
required for Negative Control samples to be automatically identified and checked for absence 
of called peaks. The default setting is “NEG”. 
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Figure 105. Selecting Auto Identify as the ‘Set Sample Type’ method.

Note: Allelic ladder, positive controls and negative controls for .promega files are identified 
automatically based on their assigned sample type in the plate record of the Spectrum Control 
Software. If .promega files do not contain assigned sample type information, GMHID-Spectrum 
identifiiers are applied on file import. To apply identifiers from GMHID-Spectrum to these file 
types (.promega files), open the ‘Preferences’ window after data import, then select OK to 
refresh the software auto-identify feature.  
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6.B.4	 The ‘Sample Quality’ Tab
The ‘Sample Quality’ tab of the ‘Preferences’ window is used to define additional criteria by 
which a sample is flagged for potential quality issues (Figure 106). 

Figure 106. 
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‘Sample Quality’ tab of the ‘Preferences’ window. 

Low ILS Quality Flag ‘SQ’: Selecting Flag sample if size calibration didn’t find all ILS peaks, or 
if in allele call ILS peaks are missing or have size shift >= 0.2bp. will flag samples with low-
quality size standard peaks with ‘SQ’ in the Sample File Tree. When this setting is selected, you 
can choose to automatically disable samples flagged as ‘SQ’ by selecting Auto-disable ‘SQ’ 
samples. 
Note: ‘Auto-disable ‘SQ’ samples’ is not a selectable option if Flag sample if size calibration... 
is not selected. See Section 10.A.2 for addition information on size calibration.

Quality Indicator Flag ‘Q’: Flags samples that do not meet the laboratory’s Large Allele to Small 
Allele quality indicator peak height ratio when the “Sample Quality Peak(s)” box is checked in 
the ‘Additional Settings - HID Analysis’ window of the Run Wizard. The peak height of the Large 
Allele quality indicator is compared to the peak height of the Small Allele quality indicator and a 
Quality Intensity Ratio is calculated. Samples with ratios below the “Minimum intensity ratio” are 
marked with a red Q over the Size Match Score in the Sample File Tree. Selecting “Flag sample 
if no allele is called” marks samples with the Q flag if a quality indicator allele is not called.

Note: The “Sample Quality Peak(s)” option is available in GMHID-Spectrum software version 
3.2.0 or later.

Allele Peak Issues Flag ‘?’: Selecting “Flag sample if Y-chrom alleles conflict with gender” 
marks samples that have Amelogenin and Y-STR marker conflict(s) with a question mark in the 
Sample File Tree and the Report Table.
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Chart Display: Outline a Marker in Red to Indicate Issues: Markers containing peaks which 
do not meet specific analysis parameters can be outlined in red to further aid in profile quality 
assessment. Select any or all of the following three criteria to trigger the red outline rule: 

	 Null marker: Marker does not contain a called peak. 

	 Peaks have red error flags (PL, OB, OL): Marker contains at least one peak with red 
Undetermined Quality flag (Section 10). 

	 Peaks have yellow check flags (IMB, IHE, IHO, SR, SD, LS, BC): Marker contains at least one 
peak with yellow Check Quality flag.

6.B.5	 The ‘Report’ Tab
The ‘Report’ tab of the ‘Preferences’ window allows you to select additional display preferences 
for the Report Table (Figure 107).

Figure 107. 
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‘Report’ tab of the ‘Preferences’ window.

Automatically Re-Sort Report: Sorts the report after edits are made to alleles. When 
unselected, you must select the right-click menu to sort the table. See Section 5.E.2 for report 
sorting options.

Automatically Scroll Chart to Alleles When Selected in Report: Allows the electropherogram 
display to automatically zoom in on a 60bp window around the peak selected in the Report 
Table.
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Show Disabled Samples in Report: When selected, samples that are marked disabled, either 
by the user or automatically by the software, appear in the Report Table.

Open Multiple Charts When Browsing Report: Allows simultaneous viewing of multiple 
electropherograms, one for each sample selected in the Report Table. To add an additional 
sample to the electropherogram chart area, select that sample by double-clicking that entry in 
the Report Table. 

Add Prefix to Saved File Name of Ladders and Controls: Adds the prefix “Ladders_” to the 
allelic ladder file names when saving a report, and the prefix “Controls_” to any samples 
designated as a positive or negative control (set in the ‘Forensic’ tab of the ‘Preferences’ 
window; Figure 104).

Show LIMS Report Settings Box: Opens the ‘LIMS Report’ settings window when the LIMS 
Report option is selected from the ‘Save Report’ icon. When not selected, the ‘LIMS Report’ 
settings window does not appear, you are taken directly to a navigation window to save the 
report. This allows you to save the LIMS Report but not modify the report content (Section 5.E.2).

6.B.6	 The ‘Others’ Tab 
The ‘Others’ tab of the ‘Preferences’ window is used to select additional project preferences, 
including CODIS export settings and folder settings (Figure 108).
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Figure 108. ‘Others’ tab of the ‘Preferences’ window.

Enable Sample Grouping: Activates Apply Sample Grouping in the ‘Project’ menu. Deselect 
Enable Sample Grouping to inactivate the ‘Apply Sample Grouping’ option. Information saved 
while ‘Apply Sample Grouping’ is active can be recalled by selecting Enable Sample Grouping 
(Section 12.A.1).
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Automatically Save Run Wizard Parameters to INI file: Saves the project Run Wizard 
parameters as an .ini file when the project is saved. The .ini file is saved to the same 
location as the saved project and given the same file name as the saved project, with the “_
RunWizardParameters.ini” suffix (e.g., SavedProjectName_RunWizardParameters.ini). 

Export CODIS Settings: Allows you to select which samples, based on quality assignment 
(‘Only Pass’, ‘Check & Pass’ or ‘All Sample’; Section 10.A.3), are exported to a CODIS report. 
Users can further filter exported results by checking Filter ‘OL’ Samples. When this option 
is selected, samples containing ‘OL’ peaks are not exported. For more information on CODIS 
reports, see Section 6.D.

Program Data Folders: Default folders can be defined individually by selecting the ... browse 
button next to each folder setting field and navigating to the desired location. Alternatively, a 
root folder for these settings can be defined. A root folder is the top-most folder in a specified 
directory. The default root folder for these settings is C:\Users\Public\SoftGenetics. Within 
that root folder, the default subfolder for panel templates is Panel, and the default subfolder for 
size standard templates is SizeStd. 
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Figure 109. Selecting Tools in the ‘Others’ tab of the ‘Preferences’ window.

The Tools button provides three options for defining the root folder: ‘Select Root Folder’, ‘Use 
Default User Folders’ and ‘Use Default Public Folder’ (Figure 109): 

	 Select Root Folder: Opens a ‘Browse For Folder’ window. Browse to the desired folder 
location, select the desired folder and select OK to close the window. Alternatively, to 
create a new folder, browse to the desired folder location and select the Make New 
Folder button.

	 Use Default User Folders: Uses the default SoftGenetics folder for the login user 
directory as the root folder: C:\Users\[User Name]\AppData\Roaming\SoftGenetics\
GeneMarker_HID\
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	 Use Default Public Folder: Uses the default SoftGenetics folder in the public user 
directory as the root folder: C:\Users\Public\SoftGenetics\

A fourth option under the ‘Tools’ button is ‘Import Previous Data from Folder’:

	 Import Previous Data from Folder: Opens a ‘Browse For Folder’ window. Browse to the 
desired folder location, select the desired folder and select OK to close the window. 

	 Note: File paths must be entered exactly and should not include any spaces (unless a file name 
has a space in it). Network locations are indicated by two back slashes ( \\ ).
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6.C.	 ‘Project’ Menu 

The ‘Project’ menu contains options for data processing and printing (Figure 110). 
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Figure 110. ‘Project’ menu.

Run: Activates the Run Wizard and begins the data processing setup. This allows you to select 
or adjust analysis settings in a sequential manner (Section 4).  

Auto Run: Automatically analyzes data based on the last set of parameters selected in the 
Run Wizard. To change one or more of the run parameters, select Run from the ‘Project’ menu, 
change the desired setting(s) and re-analyze the samples. 

Add Samples to Project: Allows you to add samples to a project that has already been 
processed. When selected, the ‘Open Data Files’ window will appear (Figure 46). To add 
individual files to the project, select the files, and select Add and then OK. The raw data file is 
processed with the same settings as the other files in the project and then added to the bottom 
of the Sample File Tree. 

Print Report: Opens the ‘Print Report’ window, which allows you to define display settings in 
the Print Report (Section 9).

Apply Sample Grouping: Opens the ‘File Name Group Editor’ window (Section 12), which is 
used to group samples by specific identifiers and is needed to use the Project Comparison 
Tool (Section 12.B) and Replicate Comparison Tool (Section 12.C). The settings defined in the 
File Name Group Editor are used to print and save a Print Report (Section 9.A.) for individual 
samples or groups of samples when ‘Print Samples with Grouping’ is applied. This tool can 
also be used to simplify sample review (Section 12.A). By default, this option is disabled; 
to enable it, check the Enable Sample Grouping box in the ‘Others’ tab of the ‘Preferences’ 
window.

Project Comments: Allows you to write comments regarding the analysis. These comments 
are saved with the project file and can be displayed in the Print Report (Section 9).

Contamination Check: Opens the ‘Contamination Check’ window to allow you to define 
parameters for checking contamination within a project as well as comparing profiles in the 
current project to saved profiles in the Contamination Database (Section 10.B). 
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6.D.	 ‘Applications’ Menu 

The ‘Applications’ menu contains individual modules for specific data and analysis types. 
These modules present advanced features and reporting options necessary for the particular 
application (Figure 111).
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Figure 111. ‘Applications’ menu.

Export CODIS: Opens the ‘CODIS Export’ window, which allows export of the CMF 3.2 (.xml), 
CMF 3.0 (.xml) and CMF 1.0 (.dat) files for upload into the FBI’s CODIS database. ‘Export CODIS’ 
settings can be managed and shared across software installations via the CODIS program 
template file (Section 2.C).
Note: Null Y-STR loci in samples with only an X allele at Amelogenin will not be marked null for 
CODIS export.

The ‘CODIS Export’ window is separated into three main sections: Export Format, Header and 
CODIS Marker. These areas allow you to specify the file export type, the information contained 
within the header and sample details (Figure 112). 
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Figure 112.  ‘CODIS Export’ window.

	 Export Format: You can select among the three different CODIS styles: CMF 3.2, CMF 3.0 
and CMF 1.0. An additional style, DAT (CMF 1.0 Style), is available and allows 36 loci per 
sample. CODIS CMF formats are saved in the CODIS CMF program template file (Section 2.C).
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	 Header: Each field within this section can be edited to reflect the laboratory’s information. 
The ‘PCR Kit’ and ‘Export Batch Identifier’ boxes have a drop-down menu for selections and 
each can be excluded from the header by deselecting the respective check box. The 
‘Specimen Type’ area allows you to specify the source of information in the ‘Specimen 
Number’ column—either the Sample Name or the Sample Index.

	 Note: The software will list locus names not recognized as CODIS-formatted names in the 
‘Unrecognized Locus Name’ drop-down menu. You can select the unrecognized name from 
the list, select the correct format from the ‘Valid Locus Name’ drop-down menu and then 
select OK next to the ‘Valid Locus Name’ drop-down menu. 

	 The ‘Edit Recognized Locus Name Category’ icon                                   allows you to enter  
lab-specific names for certain loci and convert them to the appropriate CODIS format 
(Figure 113). In the example below, the software will recognize ‘PentaD’, ‘Penta_D’, ‘PentaE’, 
‘Penta_E’ and ‘AM’ and convert them to ‘Penta D’, ‘Penta E’ and ‘Amelogenin’, respectively, 
for CODIS export. 
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Figure 113. ‘Edit Recognized Locus Name Category’ window.

	 CODIS Marker: For each row, you can change the selection in each column, except for the 
‘Specimen Number’ column. You can change the selections in the ‘Specimen Category’ and 
‘Partial’ columns as well as the column for each marker, using the drop-down menus. The 
available options for ‘Specimen Category’ can be edited by selecting the Edit Specimen 
Category icon 
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 in the column header. This will open the ‘Edit Specimen 
Category’ window where you can type in desired specimen categories  
(Figure 114). Categories listed in the ‘Edit Specimen Category’ window will appear in the 
drop-down menu in the ‘Specimen Category’ cells.
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Figure 114. ‘Edit Specimen Category’ window.

	 The ‘Case Identifier’ and ‘Comments’ columns are editable by selecting and typing within a 
cell. Samples can be selected for export using the check box next to the Sample File Name 
in the ‘Cap’ column. 

	 Once all information is updated in the ‘CODIS Export’ window, select OK and the option to 
save the CODIS file will appear. Select a location and save as either a CMF1.0 (.dat) , 
CMF3.0 (.xml) or CMF3.2 (.xml) file (as per US DOJ CODIS Interface Specification 
(CMF 3.0) CONTRACT NO. ITOP 97-0087 Sub Task Order 26CODIS and Interface 
Specification (CMF 3.2) Revision 14 DOJ-FBI-2005-C-2431). Select Save.  

Profile Comparison View: Allows you to graphically display any combination of samples and 
dye colors. This feature includes a 2-dimensional and a 3-dimensional view of the selected 
samples (Section 5.D).

Relationship Testing: Allows you to perform relationship calculations, build pedigree diagrams 
and search the relationship database for potential familial matches. The ‘Relationship Testing’ 
application calculates probabilities and likelihood ratios for the following relationship levels: 
parent-child, siblings, half-siblings, aunt-niece/uncle-nephew, grandparent-grandchild and 
cousins. For further information on using the ‘Relationship Testing’ application, contact 
Promega Technical Services: genetic@promega.com 

Mixture Analysis: Allows you to perform further analysis of mixture samples, including 
calculating statistics, deducing contributors and searching for potential matches within the 
software. For all mixture samples, the mixture analysis application automatically determines 
the number of contributors to a mixed sample and calculates PE, CPE, PI, CPI and RMNE. 
For two-contributor samples, the application reports all single-source files that are potential 
mixture contributors, automates repetitive calculations for all possible allele combinations, 
identifies major and minor contributor genotypes based on mixture ratios and calculates 
likelihood ratios for each locus as well as the combined likelihood ratio. For further information 
on using the ‘Mixture Analysis’ application, contact Promega Technical Services at:  
genetic@promega.com 
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6.E.	 ‘Tools’ Menu 

The ‘Tools’ menu contains several functions including those used for managing templates, 
comparing data and exporting information (Figure 115).
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Figure 115. ‘Tools’ menu.

Panel Editor: Manages all panel templates for data analysis. In addition to setting the analysis 
parameters as described in Section 4.A.1, the Panel Editor provides tools to adjust, edit and 
create panels. See Section 8 for advanced use of the Panel Editor.

Size Template Editor: Manages all size standard templates. Use to create new templates, 
modify existing templates and delete templates from this editor as well as to compare sample 
size standards to templates. See Section 7.

Positive Control Template Editor: Manages all positive control templates. Use this editor 
to create new templates, modify existing templates and delete templates. Several positive 
control templates are preloaded with the software. A list of available templates is accessible 
via the drop-down menu in the ‘Positive Control Standards’ field (Figure 116). Positive control 
templates listed here are available for selection in the ‘Additional Settings - HID Analysis’ 
window of the Run Wizard (Section 4.C.3).
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Figure 116. ‘Positive Control Template Editor’ window.

Listed templates can be edited by selecting the desired template from the drop-down menu, 
then selecting the Edit button to the right of the ‘Positive Control Standards’ field. This opens a 
second ‘Positive Control Template Editor’ window, where you can make the necessary changes 
(Figure 117). When all changes are made, select OK to return to the primary ‘Positive Control 
Template Editor’ window. 
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Figure 117. ‘Positive Control Template Editor’ window for edits.

New positive control templates can be added by selecting the Add button to the right of the 
‘Positive Control Standards’ field (Figure 118). This opens the ‘New Positive Control Standard’ 
window where you enter the name of the new Positive Control Standard (Figure 118). When 
you select OK, the primary ‘Positive Control Template Editor’ window displays the new name in 
the ’Positive Control Standards’ field and the corresponding genotypes field are blank. 
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Figure 118. Creating a ‘New Positive Control Standard’ window.

Use one of two methods to populate the ‘Genotypes’ field with the correct genotype: 

1. 	 Select the Edit button and enter the genotype by typing the Marker name, Allele 1 and 
Allele 2, using the Tab key to navigate from one column to the next. Alternatively, you 
can copy and paste the genotype information from a text (.txt) file, formatted in the 
same way as described above: Marker name, Tab, Allele 1, Tab, Allele 2. 

2. 	 Use the ‘Import Genotypes from Sample’ function. The drop-down menu in this field 
lists all samples in the current dataset. Select the sample that contains the profile to be 
saved as a positive control template. A ‘Confirm’ window will appear. Select Yes to 
copy the genotype for the selected sample into this new positive control template. 
After selecting Yes, the genotype field will contain the sample genotype. 

Positive Control Standards can be deleted by selecting the appropriate template from the drop-
down menu, then selecting the Delete button on the right. A ‘Confirm’ window will appear to 
confirm the deletion. 

File Conversion: Allows import of time and distance files from custom genetic analyzers for 
use with files formatted by the ‘Convert Text to Binary File’ tool (Figure 119).

Database Manager: Allows you to manage and submit profiles to the two databases contained 
within the software: Contamination DB and Relationship DB (Section 11).

Project Comparison: Allows you to compare the same dataset, analyzed in two different 
projects, and detect differences based on a number of parameters, including peak size and 
height, quality score and alleles with comments (Section 12.B).

Pedigree File Name Match: Allows you to automatically add additional files to a previously 
created pedigree diagram. This results in the export of a .smp file, which can be used in the 
‘Relationship Testing’ application. For further information on using the ‘Relationship Testing’ 
application, contact Promega Technical Services at: genetic@promega.com
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Convert Text to Binary Files: Allows you to upload raw data information in text (.txt) file format 
for conversion into a four-color SCF (.scf) or a five-color SG1 (.sg1) file. The SCF and SG1 files 
can then be read by GMHID-Spectrum and translated into electropherograms. This tool is 
useful for institutions developing their own fragment analysis instruments.

To upload files for conversion, select the Load Text File button in the ‘Convert Text to Binary 
File’ window (Figure 119), then select the desired text (.txt) file.
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Figure 119. ‘Convert Text to Binary File’ window.

The software will automatically calculate a Recommended Ratio to condense the number 
of frames into a single electropherogram. Enter this value (or another desired value) in the 
‘Condense Frames’ field, then select Export to SG1 if exporting five-color data or Export to SCF 
if exporting four-color data.

Replicate Comparison: Compares replicate samples within a project. This can be used to 
detect contamination, allelic dropout or a failed injection or amplification. This tool also 
assesses concordance among these replicates when reporting concensus profiles. See 
Section 12.C for details on using the ‘Replicate Comparison’ tool.

Validation Assistance: Provides three calculations related to internal validation of STR kits: 
‘LOD’, ‘Height Ratio’ and ‘Migration Precision’ (Section 13). 

Output Trace Data: Allows you to export the electropherogram plot information for raw data 
or sized data (i.e., processed data) for selected sample files without instrument information (e.g., 
instrument name, run conditions; Figure 120). 
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Figure 120. ‘Output Trace Data’ window.

There are three file format options available at the top of the ‘Output Trace Data’ window: text 
(.txt), SCF (.scf) or SG1 (.sg1). The location and file name of this file are indicated in the ‘Output 
File Name’ field. Data saved in .txt format can be saved in raw or sized form. Both the SCF and 
SG1 file formats will export an individual raw data file for each sample, which can be saved to 
the directory specified in the ‘Output Folder’ field. 

Note: The SCF format can only export data with four dye channels. 

The ‘Output Trace Data’ window is separated into four sections: ‘Output File Name’ (or ‘Output 
Folder’), ‘Select Samples’, ‘Select Dyes’ and ‘Data Type’. These areas allow you to specify which 
samples and dye channels are exported and, for .txt files, whether the export data are in raw 
or sized form. Select the desired file format by selecting the ‘Text File’, ‘SCF Files’ or ‘SG1 
Files’ tab. A default file location (and file name for text file exports) is displayed in the ‘Output 
File Name’ field. To edit the location and file name, select the Change directory button to the 
right of the ‘Output File Name’ field. Select the desired samples from the ‘Select Samples’ list. 
Select the desired dye channels to export from the ‘Select Dyes’ section. Select the desired 
data (for .txt files only), raw or sized from the ‘Data Type’ section. When all fields are marked 
appropriately, select Export. A ‘Confirmation’ window will appear when the export is complete. 
When all desired files are exported, select the Close button to return to the ‘Main Analysis’ 
window.

Export Electropherogram: Allows you to export electropherograms as image files to a 
specified folder (Figure 121).



116      GeneMarker®HID Software for Spectrum CE Systems | TM555 | Revised 1/23

Main Menu Options

16
81

7T
A

Figure 121. ‘Export Electropherograms’ window.

The ‘Export Electropherograms’ window (Figure 121) is separated into six sections: ‘Output 
Folder’, ‘Select Samples’, ‘Select Dyes’, ‘Dye Image Size’, ‘Export File Naming’ and ‘Export 
Format’. These areas allow you to specify the file export type, which samples and dye channels 
will be exported and file prefix and suffix. Select the appropriate file location by selecting the 
Change directory button to the right of the ‘Output Folder’ field. Select the desired samples 
from the ‘Select Samples’ list. Select the desired dye channels to be exported from the ‘Select 
Dyes’ section. Enter the desired image size in the ‘Dye Image Size’ fields. You also have the 
option to select whether or not to save ‘One image per sample’, apply ‘Auto Scale Size Range’ 
and apply ‘Auto Scale Marker Intensity’ by selecting the appropriate check boxes. Specify the 
prefix and suffix for the exported file name(s) in the ‘Export File Naming’ fields. The full file 
name will be PrefixSamplename_DyenameSuffix.file extension. Select the desired file format 
from the ‘Export Format’ drop-down menu: .png, .jpeg, .bmp or .pdf. When all fields are marked 
appropriately, select Export. A confirmation window will appear when the export is complete. 
When all desired files are exported, select the Close button to return to the ‘Main Analysis’ 
window.

Export Sample Information: Allows you to export the information displayed in the ‘Sample 
Information’ window of the Sample File Tree to a specified location. 

The ‘Export Sample Info’ window contains a list of all samples in the current project. Select 
desired samples by checking the box next to the sample file name, then select Export to 
open a browser window and choose the appropriate file location. Give the file an appropriate 
name, select the desired file format: Excel (.xlsx) or text (.txt), then select Save. A confirmation 
window will appear, indicating the file was exported successfully. Select OK to return to the 
‘Export Sample Info’ window. To exit the ‘Export Sample Info’ window, select the Close button to 
return to the ‘Main Analysis’ window. 
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Magic Wizard: Provides three prompts to guide you through the main phases of data 
processing: opening files, analyzing data, and saving and printing projects. Each time the Magic 
Wizard is activated the software will display the most appropriate prompt for that point in the 
data processing procedure. The three prompts of the ‘Magic Wizard’ window are: ‘Start your 
project’, ‘Run’ and ‘Report’. Use the Previous and Next buttons on the bottom of the window to 
toggle between the available prompts (Figure 122).
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Figure 122. ‘Start your project’ prompt of the ‘Magic Wizard’ window.

Start your project (Figure 122): Provides links to the two methods for opening files: ‘Open Data’ 
and ‘Open Project’ (Section 6.A). The arrow next to ‘Open Project’ allows you to open the four 
most recently opened projects. 

Run (Figure 123): Provides links to the two methods of processing data: ‘Run’ and ‘Auto Run’  
(Section 6.C).
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Figure 123. ‘Run’ prompt of the ‘Magic Wizard’ window. 

Report (Figure 124): Provides links to save a project and print a report (Sections 6.A and 9.A). 
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Figure 124. ‘Report’ prompt of the ‘Magic Wizard’ window.

You can manually activate the Magic Wizard at any time using the option in the ‘Tools’ menu or 
the icon in the toolbar of the ‘Main Analysis’ window. The user may also have the Magic Wizard 
prompts display automatically throughout the data processing procedure by selecting Wizard 
as the Run Method from the ‘Start up’ tab of the ‘Preferences’ window (Section 6.B).

Show Last Event: Opens the ‘Data Processing’ window and displays the last ‘Data Process’ 
action performed by the software. The ‘Show Last Event’ tool can be opened via the ‘Tools’ 
menu or the icon in the toolbar of the ‘Main Analysis’ window.
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6.F.	 ‘Help’ Menu

The ‘Help’ menu contains a searchable user manual, a ‘User Management’ feature and 
information on the installed software version (Figure 125).
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Figure 125. ‘Help’ menu.

Help: Opens a searchable version of this manual.

User Management: Opens the ‘User Manager’ window, which allows an administrator to assign 
access rights to different users and set up the password protection feature (Figure 126). 
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Figure 126.  ‘User Manager’ window.

	 There are three tabs to the ‘User Manager’ window: ‘User Manager’, ‘History’ and ‘Settings’.

	 User Manager: When an Administrator user is set up, this tab allows administrators to 
manage their password, add specific users and assign access rights to users. To set up 
the Administrator user, select the Add User button on the right side of the ‘User Manager’ 
tab. This opens the ‘Setup Adminstrator’ window where the administrator’s Organization, 
User Name and Password can be defined. The administrator can now add users to the 
software and manage their access rights. 

	 Note: Only the Administrator can add and delete users and change their access rights.
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	 To add a user, select the Add User button, enter the desired user name and password and 
select the desired User Type: Reviewer, Analyst, Lab Manager or Administrator (Figure 127). 
Each User Type comes with pre-assigned access rights that can be modified by the 
Administrator. Users can be deleted or their User Type modified by right-clicking on the 
User Name in the list and selecting the appropriate function. 
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Figure 127. ‘Add User’ window.

	 To manage the access rights of specific User Types, select the Access Rights button. The 
‘Access Rights of User Types’ window will open (Figure 128). Select a User Type from the 
‘User Type’ field to see the default rights assigned to that type. Each user name assigned 
that User Type will appear in the ‘Users’ field. To modify the rights of the selected User 
Type, select or deselect the rights in the ‘Access Rights’ field. To reset rights to the default 
setting, select Set Default. When all access rights are set, select OK to return to the ‘User 
Manager’ window. To require users to log into the software, check the Run User Protection 
box in the ‘User Manager’ window.

Figure 128. 
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‘Access Rights of User Types’ window.
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	 You can manage your password by clicking on My Password in the ‘User Manager’ window 
(Figure 126). This will open the ‘Change Password’ window. Changes made here apply to 
the user currently logged into the software. 

	 To change the logged-in user, select the Change User button. This will open a ‘Confirm’ 
window to verify that the current user will be logged out. Selecting Yes will log the user out 
and open a new login window. 

	 History: This tab lists user activity associated with the ‘User Manager’ function (Figure 129). 
There are four columns of information within the ‘History’ tab. 

1.	 Date Time: Records the computer’s date and time for the activity.

2.	 User: Identifies the User Name of the individual that performed the activity.

3.	 Events: Records the User Manager activity that was performed.

4.	 Comments: Gives additional information for the event that was performed. For 
example, if a user is added, then the User Name of the person that was added is 
recorded under Comments.

Figure 129. 
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 ’History’ tab of the ‘User Manager’ window.
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	 Settings: This tab contains additional options for the User Management function  
(Figure 130).
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Figure 130. ‘Settings’ tab in the ‘User Manager’ window.

	 Overtime Protection: Logs the user out of GMHID-Spectrum after the specified inactive 
time entered in the ‘Wait’ field. When the user is logged out, the status of the analysis 
remains unchanged until the user logs back in (with user name and password). 

	 Record Data Edit History: When selected, any changes made to allele calls within the 
project will be saved in the ‘Project History’ log (Section 6.B).

About…: Displays information specific to the version of GMHID-Spectrum running on the 
computer. Also contains links to the Promega web site and Promega Technical Services.
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As described in Section 4.A.2, a size standard template is needed for each internal size 
standard used for data analysis. Each size standard template defines the fragment sizes for 
a specific internal size standard. The Size Template Editor allows you to manage the size 
standard templates.

After a size standard template is applied to a dataset, the quality of each sample’s size 
standard can be assessed by comparing to the appropriate size standard template via the 
‘Calibration Charts’ window (Section 7.B). 

7.A.	 Navigating the Size Template Editor

In addition to reviewing and importing size standard templates (Section 4.A.2), the Size 
Template Editor allows you to create, edit and delete size standard templates. The Size 
Template Editor can be accessed through the ‘Tools’ menu (Section 6.E) or through the icon on 
the ‘Template Selection’ screen of the Run Wizard (Section 4.A).

The ‘Size Template Editor’ window (Figure 131) has a Menu Bar, Toolbar Ribbon, Size 
Standards File Navigator, Expected Size Standard Chart, Sample Size Standard Chart, Sample 
File Tree and Expected Size Standard Table.



123      GeneMarker®HID Software for Spectrum CE Systems | TM555 | Revised 1/23

Fragment Sizing Standards

17
11

2T
A

Menu Bar
Toolbar
Ribbon

Size Standards
File Navigator

Expected Size
Standard Table

Expected Size
Standard Chart

Sample Size
Standard Chart

Sample File Tree

Figure 131.  ‘Size Template Editor’ window.

Table 13. Toolbar Ribbon Icons of the Size Template Editor.
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A Create New Size Standard: Opens the ‘Input Dialog’ window with a field 

to enter a ‘New Size Standard Name’. Allows creation of a new size standard 
template.

16
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A Save Changes: Saves modifications to the ‘Size Standards’ directory  

(Section 6.B.6).
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A Delete: Deletes the size standard template that is highlighted in the Size 

Standards File Navigator. Note: This action is irreversible.

16
83

0T
A

Show Dye: Allows you to select a single dye channel to view in the Sample 
Size Standard Chart by clicking on the down arrow. To cycle through  
individual dye channels, click on the icon. 

16
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A Size Match: Automatically matches the selected Sample Size Standard 

with the chosen size standard template, and displays the green size marker 
triangles atop size standard peaks in the electropherogram. 
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Help: Provides shortcuts to the ‘Size Editor Action Help’ window descriptions 
of the display, editing and search functions of the Size Template Editor. 
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7.A.1	 Features of the Size Template Editor 
The menu bar of the Size Template Editor contains three options: File, Best Match and Help. 
Each is described in detail in Section 7.A.5.

The Size Standards File Navigator lists all size standard templates saved to the software 
directory as indicated in the ‘Others’ tab of the ‘Preferences’ window (Section 6.B.6). 

The Sample File Tree lists all samples within the open project. If the Size Template Editor is 
opened before sample files are imported, the Sample File Tree will be blank.

The Expected Size Standard Chart represents the expected pattern of size fragments for 
the selected size standard template. The peaks in this chart are always represented in red 
regardless of the dye color in which the actual size standard is represented in the data. Peaks 
that are used for both pattern recognition and sizing of sample peaks, enabled peaks, are 
indicated with green triangles at their apex. 

When the Size Template Editor is opened after sample files are imported, the Sample Size 
Standard Chart displays the electropherogram chart of the selected sample. To select a 
sample from the Sample File Tree, double-click the sample file name. By default, the dye 
channel assigned to the Standard Color in the ‘Template Selection’ window of the Run Wizard  
(Section 4.A.2) is displayed. Peaks in the Sample Size Standard Chart are compared to the 
peaks in the Expected Size Standard Chart for pattern recognition. Peaks in the Sample Size 
Standard that match the enabled peaks of the Expected Size Standard are marked with green 
triangles and are used to size sample peaks. A total score for the match between the expected 
pattern of size standard fragments and the observed pattern in the Sample Size Standard 
Chart is displayed in the upper right corner of the Sample Size Standard Chart. Perfect 
matches receive a score of 100; no correlation receives a score of 0. Refer to Sections 7.B and 
10.A.1 for further description of the Size Match Score.

The Expected Size Standard Chart and Sample Size Standard Chart are displayed with intensity 
in RFU along the y axis. The Expected Size Standard Chart is displayed with base pairs along 
the x axis, whereas the Sample Size Standard Chart is displayed with frames along the x axis. 
Use the same mouse functions to zoom or move within these charts as you do to zoom or 
move within the electropherograms of the ‘Main Analysis’ window. 
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The Expected Size Standard Table represents the expected size standard fragments in table 
format. There are four columns in the Expected Size Standard Table: ‘No.’, ‘Size’, ‘Enabled’ and 
‘Comments’. The fields of these columns are editable. 

	 No.: Displays the sequential number given to each peak in the size standard template.

	 Size: Displays the expected size of each peak.

	 Enable: Displays the enabled status of the peak. Enabled peaks are used for both pattern 
recognition and sizing of sample peaks. A number 1 in this column indicates an enabled 
peak. A number 0 indicates a disabled peak. Disabled peaks are used for pattern 
recognition only. 

	 Note: If you change the ‘Enabled’ value for a peak in the Expected Size Standard Table, you 
must select another cell in the table before saving the size standard or the change will not 
take effect.

	 Comments: Displays any comments that are made in the ‘Comments’ field of the ‘Edit Size’ 
window (Figure 134).  

7.A.2	 Creating a New Size Standard Template 
You can create a new size standard template within the software using one of two methods: 
entering fragment details into the Expected Size Standard Table or using peak information from 
the Sample Size Standard Chart. To begin either of these processes, select the Create New 
Size Standard icon from the toolbar. This opens the ‘Input Dialog’ window (Figure 132). 
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Figure 132. ‘Input Dialog’ window.

Enter a name for the new size standard template and select OK. The new template is listed 
and highlighted in the Size Standards File Navigator Tree. The Expected Size Standard Chart is 
blank.
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Method 1: Creating a New Size Standard Template in the Expected Size Standard Table
1. 	 To add expected size standard fragments to the size standard template from the Expected 

Size Standard Table, right-click anywhere in the table, and select Insert Size (Figure 133).

Figure 133. 
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 Inserting a fragment size in the Expected Size Standard Table.

2. 	 The ‘Edit Size’ window appears (Figure 134). Enter the size of the expected peak in the 
‘Size’ field.
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Figure 134. The ‘Edit Size’ window. 

3. 	 Ensure the ‘Enabled’ box is checked so the peak is used to size sample peaks. If the peak is 
only used for pattern recognition and not sizing, uncheck the “Enabled” box. Select OK to 
return to the ‘Size Template Editor’ window. 

	 Note: All peaks used for data sizing will appear as a red peak with a green triangle in the 
Expected Size Standard Chart. Enabled peaks are indicated with a green triangle at their 
apex and disabled peaks are not displayed in the Expected Size Standard Chart. 

4. 	 Repeat Steps 1–3 to enter the remaining size standard fragments of the new size standard 
template.

5. 	 Select the appropriate dye channel for the size standard using the Show Dye icon.

6. 	 Select the Save Changes icon.
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Method 2: Creating a New Size standard template from a Sample Size Standard Chart
If sample data files have been imported into the project, a new size standard template can be 
created using the Sample Size Standard Chart of one of the samples. 

1.	 Select the sample from the Sample File Tree. 

2. 	 Select the appropriate dye color for the new size standard template using the Show Dye 
icon. 

3. 	 To add the size standard fragments displayed in the Sample Size Standard Chart to the 
new size standard template, right-click on a peak and select Insert Size (Figure 135).
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Figure 135. Inserting a size in the Sample Size Standard Chart. 

4. The ‘Edit Size’ window appears (Figure 134). Enter the appropriate fragment size and select 
the appropriate Enabled status, as described in Method 1, above. 

5. Repeat Steps 3 and 4 to continue entering the remaining size standard peaks. 

6. When all peaks are entered, select the Save Changes icon. 

Note: Using this method, after one peak is inserted, the software will estimate, by interpolation, 
the size values for the other peaks in the Sample Size Standard Chart. Interpolated size values 
are displayed in the ‘Edit Size’ window when Insert Size is selected from the Sample Size 
Standard Chart. Edit the size value and Enabled status as needed before selecting OK.
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7.A.3	 Editing an Existing Size Standard Template 
You can edit or delete fragments within a size standard template and insert new fragments into 
an existing size standard template. 

1. 	 Select the size standard template to be edited from the Size Standard File Navigator.

2.	 To select a peak, click on the peak in the Expected Size Standard Chart or on the row for 
the peak in the Expected Size Standard Table. When a peak is selected, the triangle at the 
apex of the peak is yellow.

Figure 136. 
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Editing an existing fragment in the Expected Size Standard Chart.
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3.	 To edit the selected peak, right-click and select Edit Size (Figure 136). The ‘Edit Size’ 
window (Figure 134) will appear allowing you to edit the size and Enabled state of the peak 
as well as to add a comment. Select OK to apply the change and close the ‘Edit Size’ 
window. To apply the Enabled status of one peak to all peaks in a size standard template, 
select the Enabled cell of the peak in the Expected Size Standard Table, then right-click the 
cell and select Set Value to Column (Figure 136). 
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Figure 137. Editing an existing fragment in the Expected Size Standard Table.

4.	 To delete a fragment within a size standard template, select the desired peak in either the 
Expected Size Standard Chart or Expected Size Standard Table, right-click and select 
Delete Size (Figure 136 and Figure 137). 

5.	 To insert a fragment within a size standard template, select the desired peak in either the 
Expected Size Standard Chart or Expected Size Standard Table, right-click and select Insert 
Size (Figure 136 and Figure 137). The ‘Edit Size’ window will appear with the interpolated 
size listed in the ‘Size’ field and the “Enable”d box checked. If this is the intended size and 
Enabled state for the inserted size, select OK to the new size fragment, and close the ‘Edit 
Size’ window; otherwise, edit the ‘Size’ field and Enabled status to the desired settings 
before selecting OK. 

6.	 When all edits are completed, select the Save Changes icon. If you navigate away from an 
edited size standard template before saving, a ‘Confirm’ window will appear with the 
question, “Size Standard has been changed, save the changes?”. 

Note: If you select No in the ‘Confirm’ window, the changes will remain in both the Expected 
Size Standard Chart and Expected Size Standard Table until you choose Reload (Section 7.A.4) 
or the program is closed. 
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7.A.4	 Managing Size Standard Template Files
Once you create a size standard template, a file is saved to the ‘Size Standards’ directory as 
defined in the ‘Others’ tab of the ‘Preferences’ window (Section 6.B.6). You can delete, export 
and reload these files from within the software. Each of these functions is available by right-
clicking on the desired size standard template file from the Size Standards File Navigator.

1.	 To delete a size standard template file from the software and the ‘Size Standards’ directory, 
right-click on the size standard, then select Delete (Figure 138). 
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Figure 138. Deleting a size standard template file from GMHID-Spectrum and the ‘Size Standards’ directory.

A confirmation window will appear (Figure 139). Select Yes to delete the file and return to the 
main ‘Size Template Editor’ window. 

Note: This action is irreversible. 
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Figure 139. Confirmation window when deleting a ‘size standard template’ file.

2.	 To export a size standard template as an .xml file, right-click on the size standard, then 
select Export (Figure 138). This will open a ‘Save As’ window. Navigate to the desired 
location and save the exported file. A copy will still remain in the ‘Size Standards’ directory. 

3.	 You can undo edits to a size standard template and restore the file to its previous state by 
right-clicking on the size standard, then selecting Reload (Figure 138). 
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7.A.5	 Menu Options 
The Size Template Editor contains three menu options: ‘File’, ‘Best Match’ and ‘Help’. The ‘File’ 
menu allows the user to create, save and export size standards (Figure 140). The ‘Best Match’ 
menu contains options for matching a size standard template to the sample size standards 
in the open project (Figure 141). The ‘Help’ menu contains descriptions of the navigation and 
editing functions for the Size Template Editor (Figure 142).

	 ‘File’ Menu
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Figure 140. ‘File’ menu options in the Size Template Editor.

New Size Standard: Opens the ‘Input Dialog’ window with a field to enter a ‘New Size Standard’ 
name (Section 7.A.2). 

Delete Current Size Standard: Deletes the size standard template that is highlighted in the Size 
Standards File Navigator. Note: This action is irreversible.

Save Changes: Saves edits and changes to the size standard template and in the size standard 
directory. 

Save As New Size Standard: Allows you to save edits and changes to an existing size standard 
template as a new size standard template. When selected, the ‘Input Dialog’ window opens 
with a field to enter a ‘New Size Standard’ name. The new size standard template is added to 
the Size Standards File Navigator and saved in the ‘Size Standards’ directory.

Import Size Standard: Opens a browser window that allows you to navigate to a saved size 
standard (.xml) file. Use the ‘Import Size Standard’ option to find previously exported size 
template files (.xml) on local or network computers.

Export Size Standard: Exports the selected size standard template as an .xml file to the 
specified directory.

Import ABI Size Standard: Opens a browser window that allows you to navigate to a size 
standard file created for use with Applied Biosystems® GeneMapper® software. 
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Export ABI Size Standard: Exports the selected size standard template as an ‘ABI Size 
Standard Files’ .xml file to the specified directory. 

Export Project Size Standard: Exports the size standard template used to process the opened 
project to the specified directory. 

Exit: Closes the ‘Size Template Editor’ window.

	 ‘Best Match’ Menu
The ‘Best Match’ menu provides options for matching the sample size standards to size 
standard templates based on calculated match scores (Section 7.B). This feature is used for 
research purposes only, when analyzing data where the size standard template is unknown.
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Figure 141. ‘Best Match’ menu options in the Size Template Editor. 

Match Selected: Compares the size standard for each sample in the project to the currently 
selected size standard template in the Size Standards File Navigator. The ‘Data processing...’ 
window opens and the software makes the comparisons. The green triangles above the peaks 
in the Sample Size Standard Chart are adjusted to represent the best match to the selected 
size standard template. 

Match All: Compares the size standard for each sample in the project to each size standard 
template in the Size Template Editor. The ‘Data processing…’ window opens and the software 
makes comparisons. The software calculates the average match score across all samples 
in the project for each size standard template. The size standard template with the highest 
average size match score is considered the Best Match and is highlighted in the Size Standards 
File Navigator. 
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	 ‘Help’ Menu
The ‘Help’ Menu provides access to the ‘Size Editor Action Help’ window, which has 
descriptions of the display, editing and search shortcut functions (i.e., Hot Keys) of the Size 
Template Editor (Figure 142). 
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Figure 142. ‘Size Editor Action Help’ window.



134      GeneMarker®HID Software for Spectrum CE Systems | TM555 | Revised 1/23

Fragment Sizing Standards

7.B.	 Navigating the Calibration Charts

During data processing (Section 4.A), the size standard template is applied to the samples, a 
size calibration is performed and GMHID-Spectrum assigns a size match score to each sample 
based on how closely that size standard matches the pattern of the size standard template. 
Perfect matches receive a score of 100. No correlation receives a score of 0, and the sample 
size calling fails. A general quality assessment of each sample’s size match score is available 
in the Sample File Tree of the ‘Main Analysis’ window (Section 10.A.1). A more detailed 
assessment of each sample’s size match score is available in the ‘Calibration Charts’ window 
(Figure 144). To access the ‘Calibration Charts’ window, select the Size Calibration icon in the 
toolbar (Figure 143).  

Figure 143. 
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‘Size Calibration’ icon.

The ‘Calibration Charts’ window has a toolbar, Sample List, size statistics for disabled peaks 
(when present), Expected Size Standard Chart, Sample Size Standard Chart and Calibration 
Plots (Figure 144). 

Sample List 

Disabled Size
Statistics 

Calibration Plots 
Expected Size 
Standard Chart

Sample Size 
Standard Chart 
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Figure 144. ‘Calibration Charts’ window.
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Table 14. Toolbar Icons in the ‘Calibration Charts’ Window.
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A View Mode: Opens the ‘Options’ window, which allows you to change the 

layout of the ‘Calibration Plots’ section. Users can set the maximum  
number of plots to display by adjusting the number of rows and columns 
to a maximum of 5. The ‘Advanced Settings’ section allows users to adjust 
the size of the file generated when charts are saved or printed. A smaller file 
size will generate more .png files per dataset compared to a larger file size; 
however, the larger file size may produce images with lower resolution.

16
84

7T
A

Chart Synchronize: Synchronizes the display settings of the Expected 
Size Standard and Sample Size Standard Chart. This option is selected by 
default.
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Preprocess Raw Data: Smooths the samples’ raw data in the size  
standard dye channel. This affects data display in the ‘Calibration Charts’ 
window only.
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Auto Fit Y: Provides two options for scaling the y axis of the Sample 
Size Standard Chart. The default option automatically scales the y axis 
according to the maximum peak intensity of a peak that matches the 
Expected Size Standard Chart (Auto Fit Y by Matched Peaks). Alternatively, 
the y axis can be set to automatically scale to the maximum peak intensity 
of any peak in the Sample Size Standard Chart (Auto Fit Y by Max Data). 
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Print: Opens the ‘Calibration Print’ window to print or save the calibration 
data using the specified settings (Section 9.C). 
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Save: Opens a ‘Save As’ window to navigate to a location to save the 
Sample List and Calibration Plots as a .png file.
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Manual Calibration: Opens the ‘Manual Calibration’ window where size 
calibration information can be viewed and edited for the sample selected in 
the Sample List. The ‘Manual Calibration’ window displays three columns:  
(i) Standard Size (fragment sizes of the size standard template used for 
size calling), (ii) Peak position (in camera frames) of the selected sample 
size standard, and (iii) Size (in bp) of the selected sample size standard. 
You can edit the values listed in the ‘Size’ column. There are three buttons 
on the right side of the window that provide additional editing features: 
Restore, Clear and Auto. The ‘Restore’ button restores the values in the 
‘Size’ column to their initial state. The ‘Clear’ button clears all the values in 
the ‘Size’ column. The ‘Auto’ button automatically populates the values in 
the ‘Size’ column with the sizes listed in the applied size standard template. 
Select Apply to apply changes. Select Close to close the ‘Manual  
Calibration’ window. 
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Table 14. Toolbar Icons in the ‘Calibration Charts’ Window (continued).
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Show Other Color: Allows you to select all dye channels, hide all dye  
channels or choose a single dye channel to be overlaid with the size  
standard dye channel. To cycle through individual dye channels, select the 
Show Other Color icon.
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Help: Provides shortcuts to the ‘Calibration Action Help’ window descriptions 
of the display, editing and search functions of the ‘Calibration Charts’ 
window. 

7.B.1	 Features of the Calibration Charts
Sample List

The Sample List includes all samples in the project numbered in order by size match 
score. There are three columns in the Sample List: sample number (No.), sample file name 
(Sample Name) and size match score (Score) for each sample in the project (Figure 144). An 
additional column for each disabled peak is displayed if the selected size standard template 
contains disabled peaks (Section 7.A.1). You can sort samples by sample name or score 
by selecting the appropriate column header. When a sample is selected in the Sample List, 
the electropherogram of the sample size standard is displayed in the Sample Size Standard 
Chart and the sample name in the Calibration Plot is red. Use the up and down arrows on the 
keyboard to scroll through the samples. To disable a sample, right-click the sample name and 
select Mark As Failed. Select Unmark Failed to reverse the action.  

The names of samples disabled by the user (Section 3.C.1) or those automatically disabled by 
the software due to a poor size match score (Section 6.B.4) are displayed in light gray.

Disabled Size Statistics

If the selected size standard template contains disabled peaks (Section 7.A.1), the Disabled 
Size Statistics table is displayed in the bottom left corner of the ‘Calibration Charts’ window. 
This table lists the average base pair size, standard deviation and the difference between the 
maximum and minimum base pair size of each disabled size standard peak observed in the 
project. No statistics will be calculated for disabled peaks at the beginning or end of the size 
standard template.

Expected Size Standard Chart

The Expected Size Standard Chart displays the expected peak pattern for the selected size 
standard template. Enabled peaks are displayed in red; disabled peaks are displayed in gray. 
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Sample Size Standard Chart

The Sample Size Standard Chart displays the electropherogram of the size standard of the 
selected sample. Peaks that correspond to enabled peaks in the Expected Size Standard Chart 
have green triangle indicators at their apex with the peak size. Peaks with a question mark next 
to the green triangle indicate peaks that may be affected by spectral bleedthrough from other 
dye channels. 

For both the Expected Size Standard Chart and the Sample Size Standard Chart, the peak size 
in base pairs is displayed along the x axis and intensity in RFU is displayed along the y axis. Use 
the same mouse functions to zoom or move within these charts as you do to zoom or move 
within the electropherogram in the ‘Main Analysis’ window.

Calibration Plots 

The Calibration Plots chart the migration linearity of size standard peaks. A calibration plot 
(Figure 145) is displayed for each sample size standard as indicated by the sample name in 
the plot title. Use the scroll bar on the right to locate the calibration plot of a specific sample 
or select the sample in the Sample List. Each plot displays the peak size for each enabled 
peak in the sample size standard (in base pairs) on the y axis as a function of time (in camera 
frames) on the x axis. As linearity decreases so does the size match score for the sample. If 
the software misidentifies enabled peaks in the sample size standard, the sample size match 
score will be low. Samples with failed size match scores have blank calibration plots. Double-
clicking a specific Calibration Plot selects that sample in the Sample List and displays the 
sample in the Sample Size Standard Chart. 
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Figure 145. Calibration plot of the ‘Calibration Charts’ window.
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7.B.2	 Editing Size Calls
You can edit or delete peaks within the size standard for the selected sample. You can also add 
unlabeled peaks to the size standard. These edits will not affect the size standard template.

1.	 Select a sample in the Sample List to display the electropherogram for the sample size 
standard in the Sample Size Standard Chart and highlight the sample’s calibration plot. 

2.	 To select a peak within the size standard, click on the peak in the Sample Size Standard 
Chart. When a peak is selected, the triangle at the apex of the peak is yellow. Right-clicking 
on a specific peak in the electropherogram provides several editing options (Figure 146). 
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Figure 146. Editing size calls in the Sample Size Standard Chart of the ‘Calibration Charts’ window.

3.	 To edit the size of an existing peak, select the peak, hold down the Control key, left-click on 
the peak and drag the triangle to the desired position. Alternatively, edit a peak by right-
clicking on the peak and selecting Fix Size. This opens the ‘Calibration Editor’ window 
(Figure 147), allowing you to edit the size and change the Fixed state of the peak. Peaks 
defined as enabled in the size standard template are fixed peaks. Fixed peaks are set to the 
specified positions and remaining enabled size standard peaks are adjusted to correctly 
align with the chosen size standard template.

	 The ‘Fix Size’ feature is useful when the selected size standard template has uniformly 
spaced peaks and the sample size standard has additional peaks or artifacts that influence 
the pattern recognition algorithm.

	 Note: Only size fragments that occur in the selected size standard template can be entered 
in the ‘Calibration Editor’ size field. The ‘Fix Size’ functionality is not active for manually 
added peaks or peaks outside the range of the size standard template.
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Figure 147. Editing selected peak size in the ‘Calibration Editor’ window. 
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4.	 To delete an enabled size standard peak, right-click on the peak and select Delete Peak 
(Figure 146). The peak remains in the electropherogram; however, the green triangle peak 
indicator is removed and the peak is not used in the size match score calculation.

	 Note: Deleting an enabled size standard peak is irreversible. For those peaks to be 
recognized by the software again, you will need to re-analyze the data (Section 5.F).

5.	 To add a peak to the sample size standard, right-click the desired peak and select Add 
Peak (Figure 148). A green triangle peak indicator will appear at the selected position and 
the peak will be included in the match score calculation. 

	 Note: Add Peak is only available for peaks that do not already have a green triangle at their 
apex.
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Figure 148. Adding a peak in the Sample Size Standard Chart of the ‘Calibration Charts’ window.

6.	 To remove a manually added peak or peaks edited using the ‘Fix Size’ option, right-click 
anywhere in the Sample Size Standard Chart and select Reset Peaks. Deleted peaks or 
peaks edited using the Control + left click method are not reset by this feature.

When all desired edits are made, right-click anywhere in the Sample Size Standard Chart and 
select Update Calibration (Figure 146). The software will recalculate the size match score for 
the sample and update the calibration plots. If you navigate away from an edited size standard 
before updating the calibration, a ‘Warning’ window will open asking if the sample size standard 
calibration should be updated. Select Yes to update the calibration. Select No to undo all edits 
to the sample size standard. When you close the ‘Calibration Charts’ window, the Size Match 
Score indicators next to the file names in the Sample File Tree in the ‘Main Analysis’ window are 
updated.

Note: If the size standard of an allelic ladder sample is edited, a ‘Warning’ window will open 
asking if the ‘Auto Panel Adjustment’ and ‘Auto Select Best Ladder’ functions should be 
performed again. Select Yes to perform these functions again. Select No to keep the panel 
adjustment and best ladder selections the same.

You can copy the camera frame and base pair size of the calibration data for analysis in 
a spreadsheet or word processing program. To copy data from the selected Sample Size 
Standard Chart, right-click anywhere in the Sample Size Standard Chart and select Copy 
Current Calibration Data (Figure 146). The frame position and base pair size for each enabled 
peak will be copied.



140      GeneMarker®HID Software for Spectrum CE Systems | TM555 | Revised 1/23

8	�  
Advanced Use of the Panel Editor

To assign an allele designation to a peak, the software uses a panel file, which defines the dye 
channel and expected size range for each marker in an STR kit. Within each marker, the panel 
defines the expected bin size range for each allele within that marker. Panels also define peak 
amplitude thresholds and stutter filters. Preloaded and user-defined panel files are known as 
panel templates. The Panel Editor is where all panel templates are managed. The Panel Editor 
can be accessed through the ‘Tools’ menu (Section 6.E) or through the icon on the ‘Template 
Selection’ window of the Run Wizard (Section 4.A).

In addition to viewing and editing analysis parameters prior to processing data using the Panel 
Editor (Section 4.A.1), you can also create, save, delete, import and export panel templates. 
The ‘Panel Editor’ window has a Menu Bar, Toolbar Ribbon, Panel File Navigator, Chart Overlay, 
Sample File Tree and Panel Table (Figure 149). 

The Panel Table contains marker and bin information about the selected panel for the dye color 
displayed in the Chart Overlay.

Figure 149. 

Menu Bar Toolbar Ribbon Chart Overlay

Panel File 
Navigator

Sample File Tree

Panel Table
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‘Panel Editor’ window.
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Table 15. Toolbar Icons in the ‘Panel Editor’ Window.
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Create New Panel: Opens the ‘Create New Panel’ window. Follow the 
steps in Section 8.D.
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Save Changes: Saves modifications to the panel template file saved in 
the ‘Panel’ directory (Section 6.B.6).
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Delete Current Panel/Marker: Deletes the panel or marker that is 
currently selected in the Panel File Navigator. This action is irreversible.
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Show Dye: Allows the user to select a single dye color to view in the Chart 
Overlay. Click the icon to cycle through the colors or use the drop-down 
menu to select a specific dye color.

Trace Mode: Determines how electropherogram data are displayed in the 
Chart Overlay. Click the icon to cycle through the options or use the drop-
down menu. 

Trace Overlay: Displays the electropherogram for all samples selected in 
the Sample File Tree. To select the electropherogram for a single sample 
in this mode, click on the electropherogram plot line (trace). The plot line 
is bolded, and the corresponding sample is highlighted in the Sample File 
Tree.

Max and Average: Displays two plot lines in the Chart Overlay: the Max 
and the Average. The Max plot line is displayed in black and represents 
the maximum peak intensity observed at a base pair size for all selected 
samples. The Average plot line is displayed in the selected dye color and 
represents the average peak intensity observed at a base pair size for all 
selected samples.

Gel Image: Displays selected samples as a synthetic gel image. Bin 
ranges in the Gel Image mode appear as white vertical lines and can 
be adjusted by holding the Shift key, left-clicking and dragging the bin 
boundary left or right. 
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Check Range in Edit: When selected, the software will warn the user if 
an edit to one bin range overlaps with another bin range. This feature will 
prevent the user from setting bin boundaries too close to neighboring 
bins. This option is selected by default.  

Help: Provides shortcuts to the ‘Panel Editor Action Help’ window 
descriptions of the display, editing and navigation functions of the ‘Panel 
Editor’ window. 
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8.A.	 Navigating the Panel Editor

8.A.1	 Panel File Navigator
The Panel File Navigator contains two expandable folders of files, one for Project Panel and 
one for Panel Templates (Figure 150). 
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Figure 150. Expanded ‘Project Panel’ and ‘Panel Templates’ folders in the Panel File Navigator.

The ‘Project Panel’ folder includes the panel assigned for use with an open project. When Auto 
Select Best Ladder is selected in the ‘Additional Settings - HID Analysis’ window of the Run Wizard 
(Section 4.C), panels adjusted to each passing allelic ladder sample are also listed in the ‘Project 
Panel’ folder.  

The ‘Panel Templates’ folder includes a list of all preloaded and user-defined panels saved to 
the ‘Panel’ directory as defined in the ‘Others’ tab of the ‘Preferences’ window (Section 6.B.6). 

When a panel is selected from the Panel File Navigator, the marker and bin ranges for the 
selected dye color are displayed in the Chart Overlay and Panel Table. When a marker is 
selected from the Panel File Navigator, the marker range and bin ranges are displayed in the 
Chart Overlay and Panel Table (Figure 151). To select a marker within a panel, expand the panel 
in the navigator by selecting the + next to the panel name or by double-clicking on the panel 
name, and then selecting the marker name.  
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16
86

2T
A

Figure 151. Selecting a marker in the Panel File Navigator to display in the Chart Overlay and Panel Table.

Panels can be edited from the Panel File Navigator (Section 8.B). Edits made to a panel listed 
in the ‘Project Panel’ folder will apply only to the panels in the open project. To make changes 
that will apply to all future uses of the selected panel, edit the corresponding panel in the ‘Panel 
Templates’ list. Several editing options are available by right-clicking a panel name (Figure 152, 
left panel).

Rename: Opens the ‘Input Dialog’ window where you can enter a new panel name in the 
provided field.

Edit: Opens the ‘Edit Panel’ window where you can change the panel name and ploidy setting 
(Figure 152, right panel). Ploidy can be set from Monoploid (1) to Decaploid (10) or Unlimited 
(0). If the number of peaks within a marker exceeds the ploidy setting, the additional peaks with 
the lowest peak heights will be flagged with the Quality Reason ‘PL’, designating the marker is 
‘Beyond Ploidy’ (Section 10.A.3). When Unlimited is selected, peaks are not flagged. 

Figure 152. A
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ccessing panel editing options from the Panel File Navigator (left) and the ‘Edit Panel’ window (right).
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Delete: Deletes the panel file from the software and the ‘Panel’ directory. A confirmation 
window will appear. Select Yes to delete the file and return to the main window of the Panel 
Editor.  
Note: This action is irreversible. 

Export: Opens a ‘Save As’ window for users to navigate to the desired location to save the 
exported file as .xml. A copy will still remain in the ‘Panel’ directory. Exported panel files can be 
imported into other installations of the software. 

Reload: Undoes edits to a panel file and restores the file to its previously saved state. If you 
make changes to the panel and then answer “No” to “The Panel has been changed, save 
changes to file?”, the changes will remain visible in the Chart Overlay until you select Reload or 
the software is closed.

Set As Project Panel: Changes the panel applied to the project. The selected panel replaces 
the panel listed in the ‘Project Panel’ folder and is applied to the project samples when the 
Panel Editor is closed.

8.A.2	 Sample File Tree
The Sample File Tree lists all samples within an open project. If the Panel Editor is opened 
before sample files are imported, this file tree will be blank. Following analysis, selected 
sample(s) in this list will be displayed in the Chart Overlay. To select or de-select individual 
samples, double-click the Sample Name. Alternatively, right-click the Sample Name and 
choose Select or De-select (Figure 153). To display all samples in the Chart Overlay, right-click 
anywhere in the Sample File Tree and choose Select All. To clear the Chart Overlay, right-click 
in the Sample File Tree and choose De-select All. To overlay the electropherograms of samples 
grouped by their associated reference ladder, right-click in the Sample File Tree, choose Select 
All by Ladder, then choose the desired ladder from the list. 
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Figure 153. Right-click menu options for the Sample File Tree.

By default, samples are listed by sample file name, with designated control samples listed at 
the top followed by an alphabetical list of samples. To sort the samples in descending order 
by size match score (Section 7.B), right-click in the Sample File Tree, select Sort By, and then 
select Size Score.  
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After data processing, you can change which ladder is used for a specific sample from the 
Panel Editor. Right-click the sample file name, select Set to Ladder and then select the desired 
ladder. When you exit the Panel Editor the change will take effect. Alternatively, the ‘Additional 
Settings - HID Analysis’ window of the Run Wizard provides two options to select which allelic 
ladder is used to assign alleles to all samples in the project (Section 4.C.1).

8.A.3	 Chart Overlay
The Chart Overlay displays the electropherograms of all selected samples of an analyzed 
project by dye channel. To select the electropherogram for a single sample in this mode, 
click on a peak in the electropherogram plot line (trace). The plot line is bolded, and the 
corresponding sample file name is highlighted in the Sample File Tree. The marker ranges 
associated with the selected panel are displayed as a gray bar above the region for each 
marker. Bin ranges are displayed as dye-colored brackets at the top and bottom of the 
electropherogram. Allele labels are displayed below the electropherogram and correspond 
to the center of each called peak, which is also marked by a light gray vertical line in the 
electropherogram. In the Chart Overlay the size (in base pairs) is displayed along the x axis and 
peak intensity (in RFU) is displayed along the y axis. Use the same mouse functions to zoom or 
move within these charts as you do to zoom or move within the electropherogram of the ‘Main 
Analysis’ window.

Right-clicking on a peak or position within the Chart Overlay provides several editing options 
(Figure 154; see Section 8.B for more information on editing panels).

Figure 154. 
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 Right-click menu options in the Chart Overlay.
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Edit Allele: Opens the ‘Allele Editor’ window with information prepopulated based on the 
selected allele (Figure 155).

Figure 155. 
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‘Allele Editor’ window.

Insert Allele: Opens the ‘Allele Editor’ window (Figure 155) with information prepopulated 
based on the cursor position when Insert Allele was selected. 
Note: This option is only available when the cursor is not on an already designated allele. 

Delete Allele: Deletes the selected allele bin from the selected panel. A confirmation window 
will appear. Select Yes to delete the allele and return to the main window of the Panel Editor.

Set As Control or Set As Non-Control: Changes whether the allele bin is designated for a 
control allele in the ‘Control’ column of the Panel Table (Section 8.A.4). A “1” in this column 
indicates the bin is for a control allele; a “0” indicates the bin is for a virtual, non-control allele.

Right-clicking on the marker bar within the Chart Overlay provides several marker-editing 
options (Figure 156). See Section 8.B.1 for more information about editing markers. 
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Figure 156. Right-click menu options from the marker bar in the Chart Overlay.
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Figure 157. 
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‘Edit Marker’ window.

Edit Marker: Opens the ‘Edit Marker’ window (Figure 157; Section 4.A.1).

Update Alleles: Opens the ‘Update Marker Alleles’ window (Figure 158), allowing adjustment of  
the boundaries (in base pairs) of the marker. All other fields are uneditable in this view.  
Note: Any alleles that fall within the updated marker will be renamed according to the allele 
size (in base pairs). 

Figure 158. 
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‘Update Marker Alleles’ window.

Delete Marker: Deletes the selected marker from the panel. A confirmation window will appear. 
Select Yes to delete the marker and return to the main window of the Panel Editor.

Adjust Marker: Automatically moves the marker to align with the closest peaks.  
Note: This function is recommended for research use only and in situations where the marker 
needs only slight adjustment to the right or left.
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The default display of the Chart Overlay is the ‘Trace Overlay’ view described above. There are 
two other displays for the Chart Overlay that can be selected using the Trace Mode icon in the 
toolbar, �Max and Average and Gel Image (Table 15).

	 Max and Average displays two plot lines in the Chart Overlay: the Max and the 
Average. The Max plot line is displayed in black and represents the maximum peak 
intensity observed at a base pair size for all selected samples. The Average plot line is 
displayed in the selected dye color and represents the average peak intensity observed 
at a base pair size for all selected samples. 

	 Gel Image displays selected samples as a synthetic gel image. Bin ranges in the Gel 
Image mode appear as white vertical lines and can be adjusted by holding the Shift 
key, left-clicking and dragging the bin boundary left or right. 

8.A.4	 Panel Table
The Panel Table (Figure 159) displays detailed information about a panel based on the 
selections made in the Panel File Navigator and Chart Overlay. Each allele bin in a panel is 
given a number in sequential order, which is displayed in the No. column. There are 12 columns 
of information for each allele bin. The Panel Table is used to apply allele-specific stutter when 
Use Allele-Specific Values (From Panel) is selected in the ‘Edit Marker’ window (Section 4.A1). 

Figure 159. ‘
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Panel Table’ of the Panel Editor.

Dye: Indicates the bin dye color.

Marker: Indicates the marker that contains the bin.

Size: Indicates the size at the bin center in base pairs.

Left Range: Indicates the left boundary of the bin from the center in tenths of a base pair.

Right Range: Indicates the right boundary of the bin from the center in tenths of a base pair.
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Allele Name: Indicates the allele label for peak size within the designated allele bin range.

Stutter N–x (%): Indicates the allele-specific N–x stutter filter (if applied) for the allele bin.

Stutter N+x (%): Indicates the allele-specific N+x stutter filter (if applied) for the allele bin.

Stutter N–0.5x (%): Indicates the allele-specific N–0.5x stutter filter (if applied) for the allele bin.

Stutter N+0.5x (%): Indicates the allele-specific N+0.5x stutter filter (if applied) for the allele bin.

Control: Indicates whether the bin is a control (1) or non-control (0). Control bins correspond to 
size ranges that include a peak in the allelic ladder. The brackets for control bins are displayed 
in the selected dye color. Non-control, or virtual bins correspond to size ranges that do not have 
a peak in the allelic ladder. The bracket for virtual bins are displayed in white. 
Note: The designation of 0 and 1 in the Control column is used to assist with pattern 
recognition in the Auto Panel Adjustment algorithm. 

Comments: Provides a free-form text field to enter a comment regarding the bin.

All columns except Dye and Marker can be edited in the Panel Table by selecting a cell and 
typing a new value in the cell (Section 8.C.1 for further description of editing panels). Right-
clicking a highlighted cell provides several editing options, most of which are the same as 
those available in the right-click menu of the Chart Overlay (Figure 160). 
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Figure 160. Right-click menu options in the Panel Table.

Edit Allele: Opens the ‘Allele Editor’ window with information prepopulated based on the 
selected allele.

Delete Allele: Deletes the chosen allele bin from the selected panel. A confirmation window will 
appear. Select Yes to delete the allele and return to the main window of the Panel Editor. 

Set As Control or Set As Non-Control: Changes the state listed in the ‘Control’ column for the 
selected allele bin. 

Set Value to Column: Changes the values in the selected column to the value in the highlighted 
cell. This option is not available for the ‘Dye’, ‘Marker’, ‘Size’ or ‘Allele Name’ columns.



150      GeneMarker®HID Software for Spectrum CE Systems | TM555 | Revised 1/23

Advanced Use of the Panel Editor

8.B.	 Editing Existing Panels

Any panel listed in the Panel File Navigator can be edited at either the marker or bin level. To 
edit a panel, select the panel file from the Panel File Navigator. 
Notes: 
•	� Changes made to panels listed in the ‘Project Panel’ folder will apply to the current project. 

To make changes to a template that will be applied to all future uses of the selected panel, 
select the appropriate panel from the ‘Panel Templates’ folder. 

•	� The use of processed data, particularly allelic ladder samples, aid in the editing of panels. 
We recommend having at least one sample imported into the project and processed 
through the Run Wizard before editing a panel.

8.B.1	 Editing Markers 
Markers can be added to, edited or deleted from a panel. 

Adding Markers to a Panel 

To add a marker to an existing panel, hold down the control key, left-click and drag across the 
area in the Chart Overlay where the new marker should be added. A light-blue box will appear 
(Figure 161). Right-click in the light-blue box and select Create Marker. 

Figure 161. 

16
87

1T
A

Right-click menu from the light-blue box in the Chart Overlay.
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This opens the ‘Create Marker’ window (Figure 162) allowing you to adjust certain marker 
parameters. 

Figure 162. 
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‘Create Marker’ window.

Note: When the highlighted area overlaps with an existing marker, right-clicking in the light-blue 
box will provide a ‘Change Marker’ option, which opens the ‘Edit Group Allele’ window (Figure 163).

Figure 163. 
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‘Edit Group Allele’ window.

Marker Name: Defines the marker name displayed in the panel and marker bars. 

Boundary (bps): Defines the marker size range, which is displayed as the light-blue box. This 
option is inactive in the ‘Create Marker’ window.

To edit the Boundary, see Edit Marker in Section 4.A.1.

Nucleotide Repeat: The nucleotide repeat of the marker is automatically set in GMHID-
Spectrum; therefore, this field is inactive in the ‘Create Marker’ window. To edit the Nucleotide 
Repeat for a marker, see Edit Marker in Section 4.A.1.

Auto Binning

Fixed Bin Width: Check this option to enter the number of base pairs to the right and left of the 
bin center. If 0.5 is selected as the bin width, then the total bin range will be 1.0 base pair.

Auto Label: This feature is inactive in GMHID-Spectrum.

When the parameters are set for the new marker, select OK to add the marker to the panel. 
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Editing a Marker within a Panel

To edit a marker within the selected panel, double-click or right-click the marker bar in the 
Chart Overlay and select Edit Marker. Alternatively, you can expand the panel in the Panel File 
Navigator by selecting the + next to the panel name to reveal the list of all kit markers. Select a 
marker name, then right-click and select Edit. The ‘Edit Marker’ window appears (Figure 157). 
You can change marker-specific settings from this window, as described in Section 4.A.1. 

Deleting Markers from a Panel 

To remove a marker from a panel, either right-click the marker bar within the Chart Overlay 
and select Delete Marker, or highlight the marker in the Panel File Navigator and select Delete 
Current Panel/Marker (Shortcut = delete) in the toolbar (Table 15). A confirmation window will 
appear to confirm or cancel the deletion. 

8.B.2	 Editing Marker Bins
Bins can be added to, edited or deleted from a marker within a panel. 

Adding Bins to a Marker

To create a bin within a marker, right-click in the electropherogram at the exact position to 
place the new bin. Select Insert Allele. This opens the ‘Allele Editor’ window with parameters 
prepopulated based on the area selected in the electropherogram (Figure 164). Adjust these 
parameters as needed. The information entered in the ‘Allele Editor’ window is displayed in the 
Panel Table (Section 8.A.4).
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Figure 164. ‘Allele Editor’ window.

Allele: Indicates the label for peaks that migrate within the bin parameters. The default is the 
size in base pairs rounded to the nearest integer.

Size: Indicates the base pair position of the bin center.

Boundary: Indicates the bin width in base pairs. The ‘Left’ and ‘Right’ fields indicate how far the 
lower and upper boundaries of the bin are offset from the center of the bin, respectively.
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Marker: Indicates the marker associated with the bin. When a bin is inserted within an existing 
marker, the marker section is set to that marker and cannot be changed. When a bin is inserted 
between two existing markers, the markers to the left and right of the bin position are displayed 
as well as the option to create a new marker for the bin. All bins must be associated with a 
marker.  

Comments: Provides a free-form text field to associate a comment with the bin.

Control Gene: Indicates the control status of the bin (Section 8.A.4). When the box is selected, 
the bin is marked as a control bin and a “1” is listed in the ‘Control’ column of the Panel Table 
(Section 8.A.4). When the box is not selected, the bin will be marked as a non-control, virtual bin 
and a “0” is listed in the ‘Control’ column of the Panel Table. 

When parameters are set for the new bin, select OK to return to the main window of the Panel 
Editor. 

Editing Bins within a Marker

To edit all parameters of an existing bin within a marker, right-click the vertical grey bar in 
the center of the bin in the Chart Overlay and select Edit Allele. This opens the ‘Allele Editor’ 
window (Figure 164) and allows the user to adjust the bin parameters (see Adding Bins to a 
Marker, above). 

You can move an existing bin to a new location by holding down the Shift key, left-clicking the 
vertical gray bar in the center of the bin and dragging to the left or right to the desired position. 

You can edit a bin boundary by selecting Gel Image from the ‘Trace Mode’ icon in the toolbar. 
Then hold down the Shift key and place the cursor over the vertical white line of the left or right 
bin boundary. When a double-headed arrow appears, continue to hold down the Shift key, left-
click on the bin boundary and drag the bin boundary to the desired position. Repeat with the 
other bin boundary as necessary.

To assign bins at the edge of a marker to a different marker, hold down the Control key, left-
click and drag across the desired bins. A light-blue box will appear. Right-click in the light-blue 
box and select Change Marker. This will open the ‘Edit Group Allele’ window and allow you to 
keep the bins within the existing marker or create a new marker (Figure 165). You can keep the 
predefined name or create a new name. Select OK to place the highlighted bins into the newly 
created marker.
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Figure 165. ‘Edit Group Allele’ window.



154      GeneMarker®HID Software for Spectrum CE Systems | TM555 | Revised 1/23

Advanced Use of the Panel Editor

Deleting Bins from a Marker

To delete an existing bin, right-click the vertical grey bar in the center of the bin in the Chart 
Overlay and select Delete Allele. A confirmation window will appear to confirm or cancel the 
deletion. To delete multiple bins at once, hold down the Control key, left-click and drag across 
the desired bins in the Chart Overlay. A light-blue box will appear. Right-click in the light-blue 
box and select Delete Alleles. A confirmation window will appear to confirm or cancel the 
deletion. 

8.C.	 Adjusting Panels to Data—Manual and Automated Panel 
Calibration 

The panel alignment will shift due to variations in genetic analyzers or run conditions (such as 
temperature, polymer age or injection time). Panels can be automatically adjusted by selecting 
Auto Select Best Ladder and Auto Panel Adjustment from the ‘Additional Settings - HID 
Analysis’ window of the Run Wizard (Section 4.C). If the panel is shifted more than 5.0 base pairs 
from the defined parameters, the software cannot auto-adjust the panel, and the user may wish 
to manually adjust the panel to fit the ladder(s) of a project. 

Note: Manual alignment is used for research purposes only. 

If two or more bins within a marker are not aligned properly with alleles of the ladder, you can 
adjust the position and range of the marker. To move the marker position without changing the 
range, hold down the Shift key, then left-click on the marker bar. This will outline the marker bar 
in red to indicate the marker can be repositioned (Figure 166).
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Figure 166. Selecting a marker for manual adjustment.

Drag the marker left or right to the desired new position to align with the displayed ladder(s). 
To extend or shorten the range of the marker, hold down the Shift key while hovering over the 
edge of the Marker bar. When the double-headed arrow appears, right-click on the edge of the 
marker and drag to the desired position. 

Note: Extending the range of a marker increases the spacing between bins, while shortening 
the range decreases the spacing between bins. You can adjust both the marker position and 
range to achieve the best fit to the data. Manual adjustment is used for research purposes only.
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If single bins are not aligned with alleles of the ladder, you can adjust the position of individual 
bins. To align a bin with a ladder peak, hold down the Shift key and then left-click the vertical 
gray bar of the bin. The bar will change to blue with a red outline (Figure 167). Drag the bar left 
or right to align the bin with the peak.
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Figure 167. Selected bin outlined in red.

When all adjustments are made to the panel, select Save Changes from the File menu to save 
the changes to the selected panel file or select Save As New Panel to save as a new panel file.

8.D.	 Custom Panel Creation

Custom panels can be created from within the software. The use of sized data, particularly 
allelic ladder samples, aids in the creation of custom panels. To create a custom panel, first 
import the desired data and analyze using the Run Wizard with no panel applied (select None 
from the ‘Panel’ drop-down list of the ‘Template Selection’ screen). This will apply the size 
standard template to the data and assign sizes to the peaks in the project samples. Next, open 
the Panel Editor and select Create New Panel from the ‘File’ menu or toolbar. This opens the 
‘Create New Panel’ window (Figure 168). 
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Figure 168. ‘Create New Panel’ window.
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There are three fields in the ‘Create New Panel’ window: 

Name: Allows you to name the new panel. 

Method: Provides two options for panel creation: manual and automatic   
(Sections 8.D.1 and 8.D.2). 

To access additional options from this window, select the >> button in the bottom right corner. 

Parameters: Allows you to apply a fixed bin width by checking the Fixed Bin Width box and 
entering the desired width.   

8.D.1	 Manual Panel Creation
The manual panel creation method allows you to create a panel by manually entering 
information. Select Manually Create in the ‘Create New Panel’ window (Figure 168), then 
select OK to return to the main window of the Panel Editor. The newly created panel file will be 
listed in the Panel File Navigator. The Chart Overlay will display the electropherograms of all 
samples with no marker or bin labels. The Panel Table will be blank. Follow the instructions in 
Sections 8.B.1 and 8.B.2 to create markers and bins, respectively. 

8.D.2	 Automatic Panel Creation 
The automatic panel creation method allows the software to automatically determine the 
position of markers and bins based on the imported data. Select Automatically Create in the 
‘Create New Panel’ window (Figure 168). You can build the new panel from all samples in the 
project (Use All Samples) or from just those selected in the Sample File Tree (Use Selected 
Samples). Select OK to return to the main window of the Panel Editor (Figure 169).  

Figure 169. ‘
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Panel Editor’ window after automatic panel creation.
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The newly created panel file is listed in the Panel File Navigator. The Chart Overlay displays the 
electropherograms of the selected samples, with the positions of the automatically created 
markers and bins labeled. The Peak Table contains the details for each automatically created bin 
position. By default, the markers are listed alphanumerically by dye channel (e.g., Blue_1, Blue_2, 
etc.), and every bin is designated as a control bin (1) in the ‘Control’ column. To make changes to 
any of these marker and bin positions, follow the instructions in Sections 8.B.1 and 8.B.2.

Note: When creating new panels, the software preferentially uses the more intense peaks to 
position bins when peaks do not overlap perfectly with bins.

8.D.3	 Menu Options 
The Panel Editor contains three menu options: File, Tools and Help. The ‘File’ menu allows 
you to create, delete, save, import and export panels (Figure 170). The ‘Tools’ menu contains 
options for projects with at least one allelic ladder and exporting a panel (Figure 172). The 
‘Help’ menu contains descriptions of the navigation and editing functions of the Panel Editor 
(Figure 173).

	 ‘File’ Menu 
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Figure 170. ‘File’ menu of the Panel Editor.

Create New Panel: Opens the ‘Create New Panel’ window with the options to create a new 
panel automatically or manually.

Delete Current Panel/Marker: Deletes the panel or marker that is currently highlighted in the 
Panel File Navigator.

Save Changes: Saves edits and changes to the panel file in the ‘Panel’ directory  
(Shortcut = Control + S).

Save As New Panel: Saves edits and changes to the panel as a new panel template. When 
selected, the ‘Input Dialog’ box opens with a field to enter a new panel name. The panel is 
added to the Panel File Navigator and saved in the ‘Panel’ directory.



158      GeneMarker®HID Software for Spectrum CE Systems | TM555 | Revised 1/23

Advanced Use of the Panel Editor

Import Panels: Opens a browser window that allows you to navigate to a saved panel file 
(.xml). Use the ‘Import Panels’ option to find previously exported panel files (.xml) on local or 
network computers.

Import Pre-defined Panels: Opens a browser window to the ‘Panel’ directory to allow you to 
import a saved panel file (.xml) from that location. 

Import ABI Panels: Opens the ‘Import Panels from GeneMapper’ window (Figure 171). 
Select the ...(browse) button in the ‘Panel File’ field to locate a panel file created for use in 
GeneMapper® software. If a GeneMapper® bin file is available for the selected panel file, choose 
Load From File in the ‘Bin’ section, then select the ...(browse) button in that field to locate the 
file. If a GeneMapper® bin file is not available, choose Auto Build in the ‘Bins’ section. When this 
method is selected, GMHID-Spectrum creates the bin boundaries based on the selected panel 
file, the bins are named by their size, not their allele designation, and all bins are designated as 
controls.  
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Figure 171. ‘Import Panels from GeneMapper’ window.

When the files are successfully loaded, their panel name, number of markers and number of 
bins will be displayed in the table of the ‘Import Panels from GeneMapper’ window. For panel 
files that contain panel information for multiple chemistries, each chemistry will be listed in the 
table and can be selected or deselected for import into GMHID-Spectrum. Select OK to convert 
the GeneMapper® files into GMHID-Spectrum files and return to the main window of the Panel 
Editor. The imported GeneMarker® panels will be listed in the Panel File Navigator. 

Export Panel: Exports the selected panel in the Panel File Navigator as an .xml file to a 
specified directory on a local or network computer.

Exit: Closes the ‘Panel Editor’ tool.
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	 ‘Tools’ Menu

Tools Menu: 16
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Figure 172. ‘Tools’ menu of the Panel Editor.

Match Ladder: Adjusts panels with no virtual bins to match the allelic ladder in a project. 

Note: This feature should only be used for research purposes. Large differences between peak 
and bin positions cannot be resolved with the Match Ladder function.

Virtual Panel: Allows you to create a new panel based on the selected panel. When Virtual 
Panel is selected, the ‘Create virtual panel’ process window opens, and the software scans the 
dataset to identify the best ladder. A confirmation window will appear. Select Yes to create a 
virtual panel that matches the allelic ladder identified as the best allelic ladder. The new virtual 
panel will be added to the Panel File Navigator and labeled VPanel_PanelName to reflect that 
this is a virtual copy of the original panel. Select No in the confirmation window, and a virtual 
panel is created but is not adjusted to match the best allelic ladder.

Note: We recommend using the Virtual Panel only when small adjustments to the marker and 
bin placements are required. This feature functions similarly to selecting an allelic ladder from 
the drop-down list in the ‘Additional Settings - HID Analysis’ screen of the Run Wizard  
(Section 4.C.1).

Export the Project Panel: Exports the selected panel in the Panel File Navigator as an .xml file 
to a specified directory on a local or network computer. 

Auto Build Bins for Markers: Redefines the bins within each marker. A series of 1.0 base pair 
bins is created across the entire marker.

Note: The Auto Build Bins for Markers should only be used for research purposes. Selecting 
this tool will overwrite existing bin designations; therefore, be sure to save the original panel as 
a new panel before using this tool. 

	 ‘Help’ Menu 
Hot Keys: Opens the ‘Panel Editor Action Help’ window, which describes the display, editing 
and navigation shortcut functions (i.e., Hot Keys) of the Panel Editor.
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Figure 173. ‘Help’ menu of the Panel Editor.
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GMHID-Spectrum software provides several options to print project-related information. Print 
menus are available from the following areas in the software: 

•	 ‘Main Analysis’ window (Section 9.A)

•	 All Color Browser (Section 9.B)

•	 ‘Calibration Chart’ window (Section 9.C)

•	 ‘Show Edit History’ window (Section 9.D)

•	 ‘User Management History’ window (Section 9.E)

Each of these print menus also provides the option of saving a file instead of printing.

9.A.	 Printing from the ‘Main Analysis’ Window

The main print feature of the software is the ‘Print Report’ window accessible from the ‘Main 
Analysis’ window. This feature prints an Allele Report containing electropherograms, Peak 
Table information or both for all or selected samples in a project. To access the ‘Print Report’ 
window, select Print Report from the ‘Project’ menu (Section 6.C) or select the Print Report 
icon in the toolbar. If the Magic Wizard is selected as the Run Method (Section 6.B.1) or if you 
activate the Magic Wizard from the ‘Tools’ menu or the toolbar, the software will prompt you to 
save, print or both after the Run Wizard is complete by providing a ‘Print Report’ link. Clicking 
on this link will open the ‘Print Report’ window, which allows you to select the information in the 
report.
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9.A.1	 Navigating the ‘Print Report’ Window
The ‘Print Report’ window is divided into two sides (Figure 174). The left side of the window 
allows the user to create a new or select an existing print template. The default setting is to use 
the most recent template. The right side of the window contains two settings tabs: Standard 
and Advanced. 
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Figure 174. ‘Standard’ tab of the ‘Print Report’ window.

	 The ‘Standard’ Tab
In the ‘Standard’ tab, there are four sections to specify your print preferences (Figure 174). 

Print Type

	 Normal: All options of the ‘Print Report’ window are available when Normal is selected 
as the Print Type.

	 Chart Overlay: Displays an overlay of the electropherograms for all selected dyes.  

Samples

	 All Samples: Displays all the samples in the project.

	 Selected Samples: Displays only those sample files that are selected in the Sample 
File Tree of the ‘Main Analysis’ window.
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Contents

	 Electropherogram: Displays the electropherogram chart for each dye color and 
sample selected.

	 Note: The zoom setting of the electropherogram in the ‘Main Analysis’ window will be 
reflected in the Allele Report. Zoom out fully to include all peaks in the Allele Report.

	 Peak Table: Prints the Peak Table for each dye color and sample selected. The 
following ‘Peak Table’ options are available: 

		  Follow Trace Chart: The Peak Table for each dye channel will immediately follow 		
	 that channel electropherogram.

	 �Start after All Charts Finished: The Peak Table for all samples will begin after the 
last electropherogram.

		�  Start on Separate Page: The Peak Table for all samples will begin after the last 
electropherogram, but will start on a new page.

		  Forensics Table: Prints genotype tables for the selected samples. This option is 		
	 not active when Peak Table and Follow Trace Chart are selected.  

	 Note: If neither Electropherogram or Peak Table is selected, the Allele Report will 
contain a list of each dye color for each selected sample and the allele count within 
each dye color.

Dyes

	 Dyes: Allows you to select the dye colors included in the Allele Report. 

	 Mix Dyes: Displays all selected dye colors overlayed on one electropherogram. 

	 Hide Bins: Does not display bin markers on the x axis of electropherograms in the 
Allele Report.
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	 The ‘Advanced’ Tab
The ‘Advanced’ tab contains four sections to further define how information is displayed in the 
Allele Report (Figure 175).  
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Figure 175. ‘Advanced’ tab of the ‘Print Report’ window.

Header

The checkboxes included in the ‘Header’ section show the information present in the header of 
the Allele Report.

	 Print Project Comments: Includes information recorded in the Project Comments 
(Section 6.C). This option is selected by default. Select Each Page to display the 
Project Comments on every page of the Allele Report. When the ‘Each Page’ option is 
not selected, the Project Comments are only displayed on the first page of the Allele 
Report. Select Word Wrap to display Project Comments that exceed one line in their 
entirety as multiple lines in the Allele Report.

	 Print Report Header: Includes the Institution and User ID as defined in the ‘User 
Manager’ window (Section 6.F) as well as the Template Name and Panel, as defined in 
the Run Wizard Template (Section 4.A). Select Each Page to display the Report Header 
on every page of the Allele Report.  

	 Label Dyes & Peak Numbers: Displays the dye color name and number of peaks 
observed in the dye channel above the electropherogram for each dye channel. This 
feature is inactive when the Chart Overlay Print Type is selected from the ‘Standard’ 
tab. 

	 File Name: Includes the file name in the header of the respective electropherogram 
chart for each dye channel.

	 Sample Name: Includes the sample name in the header of the respective 
electropherogram chart for each dye channel. 
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Marker

The checkboxes included in the ‘Marker’ section define how markers are displayed in the Allele 
Report. 

	 Print Markers: Displays the marker bars above the electropherogram. This option is 
selected by default. 

	 Abide by Panel: Displays only the alleles found within the range of the applied panel. 
Alleles that are outside of the panel are not included in the report. 

	 Auto Scale Markers: The software adjusts the peak heights of the lower peaks to 
match the peak height of the highest peak in the dye color. The scaling factor (2X–8X) 
is noted in the electropherogram below the marker bar. This option is only active when 
Print Markers is selected. 

Allele

	 Print Alleles: Displays the allele labels below the peaks in the electropherogram. This 
option is selected by default.

	 Print Edited Peak Only: Includes only edited peaks in the Peak Table, if the Peak Table 
is being printed. This option is only active when both Print Alleles and Peak Table are 
selected in the ‘Standard’ tab. 

	 Mark Deleted/Edited Peaks: Displays an “X” above a deleted peak and an “E” above an 
edited peak in the electropherogram. This option is only active when Print Alleles is 
selected.

Other

	 Grouped by Dye: Lists the electropherograms in the Allele Report by dye color selected 
(i.e., lists all samples in blue first, then all samples in green, etc.).

	 Note: If this option is selected, New Page for Each Sample should not be selected.

	 New Page for Each Sample: Begins each sample on a new page instead of continuing 
on the same page as the previous sample. 

	 Note: If this option is selected, Grouped by Dye should not be selected. 

	 Implement Y Axis Settings: Applies the y-axis settings selected using the Set Axis 
icon in the ‘Main Analysis’ window to the electropherogram in the report. 

	 Print Samples With Grouping: Groups samples in the report following the rules 
defined using the File Name Group Editor (Section 12.A). Use this setting to save a 
separate .pdf file for each sample by selecting Apply Sample Grouping in the ‘Main 
Analysis’ window and making each sample its own group (Section 6.C), then selecting 
Print Samples With Grouping in the ‘Print Report’ window. This setting is only active if 
sample grouping has been applied.

	 Label Peak Ratio: Labels peak ratios on the electropherogram in the report. This 
selection is only available when the peak label position is set to top in the ‘Display’ tab 
of the ‘Preferences’ window (Section 6.B).
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	 Chart Height (mm): Use to adjust the height of each dye channel of the 
electropherogram in the report. The range of possible heights is 30–300mm.

	 To save the selections made in the ‘Standard’ and ‘Advanced’ tabs as a template for 
future use, type a name in the ‘Template Name’ field on the left side of the ‘Print Report’ 
window, then select Save. The newly created print report template is now included in 
the list of templates. Changes made to an existing template can be saved in the same 
manner. To delete a print report template from the list, select the template, then select 
Delete. 
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9.A.2	 Navigating the Print Preview Window
When the desired report settings are selected, print the report by selecting OK. A ‘Print’ 
window will open, allowing you to select a printer, the page range and the number of copies. 
Alternatively, preview the report by selecting the Preview button. This will open a separate 
‘Preview’ window displaying a print preview of the Allele Report. The ‘Preview’ window has a 
toolbar ribbon that provides shortcuts to adjust report settings as well as printing and saving. 

Table 16. Icons and Functions of the Print ‘Preview’ Window Toolbar.
16

74
9T

A

Print: Opens the ‘Print’ window. Select a printer, the page range and the 
number of copies.

Export to Files: Opens the ‘Export Report to Files’ window. The Export 
Format drop-down menu provides two options for file format: .png or .jpg. 
You can name files by sample name, file name or page number, by selecting 
the  
appropriate radio button in the ‘File Naming Methods’ section. When naming 
files by sample or file name, you also can include the page number for the 
selected sample in the file name. To do so, select either Named by sample 
name or Named by file name and then Start by Page Number.

17
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When Print Samples With Grouping in the ‘Advanced’ tab is selected, the 
option to ‘Save Grouped Samples as One File’ will be active. To select a  
location for the exported file, choose the … (browse) button in the ‘Export 
Directory’ field and navigate to the desired directory. The ‘Export Report to 
Images’ process box will appear. When the export is complete, select OK to 
return to the ‘Preview’ window. 

(continued next page)
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Table 16. Icons and Functions of the Print ‘Preview’ Window Toolbar (continued).

Export to File (continued):

Examples of File Naming Methods: 

Named by Sample Name 
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Named by File Name

16
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Named by Page Number 
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Page Setup: Opens the ‘Page Setup’ window. Choose the paper size,  
margins and orientation (Portrait or Landscape). 
16
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A
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Table 16. Icons and Functions of the Print ‘Preview’ Window Toolbar (continued).
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Content Options: Opens the ‘Print Report’ window. See Section 9.A.1.

16
89

1T
A

Zoom to Fit: Zooms out to view the entire print preview page.

16
89

2T
A Zoom to Width: Zooms in to view the print preview page at maximum 

width while still displaying the entire page.
16

89
3T

A

Zoom Ratio: Allows you to enter percentage numbers to increase or  
decrease the zoom aspect of the print preview page.

16
89

4T
A Close: Closes the ‘Preview’ window.

Note: Selections in the ‘Display’ tab of the ‘Preferences’ window (Section 6.B) will affect how 
the Allele Report is displayed.

An example of an Allele Report is shown in Figure 176. The standard page header displays the 
SoftGenetics logo, software version, date and time the report was generated and page number. 
To add a customized logo to the page header, see Section 9.A.3. A Print Report Header is 
displayed listing the institution’s name and project information. For each sample, the sample 
number (based on order in the project) is displayed followed by the reference ladder (best 
match) used for the sample, then the run date and time. 
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9.A.3	 Including a Customizable Logo in the Allele Report
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Figure 176. Example of an Allele Report with a customized logo.

GMHID-Spectrum allows you to include a customized logo (Figure 176) in an Allele Report 
generated from the ‘Main Analysis’ window or the All Color Browser (Section 9.B). To add a logo 
to the page header, save the desired logo as a .jpg, .jpeg, .bmp, .ico, .emf or .wmf file (Note: 
.png is not permitted) and rename the file “PartnerLogo” (no space).

Move the file to the following directory:  
C:\Program Files(x86)\SoftGenetics\GeneMarker_HID\[your version number]

Once the file is placed in this directory, the logo will appear at the top of all Allele Reports 
generated from the ‘Main Analysis’ window or the All Color Browser. For best results, use 
images that are rectangular. To disable the logo, simply delete the PartnerLogo file, or name the 
file something other than “PartnerLogo”.
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9.B.	 Printing from the All Color Browser

The print options in the All Color Browser are similar to those provided through the ‘Print 
Report’ window but are more limited. Selecting the Print icon in the toolbar opens the ‘All Color 
Browser Settings’ window (Figure 177). 
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Figure 177. ‘All Color Browser Settings’ window.

There are three sections to the ‘All Color Browser Settings’ window. By default, all options are 
selected. 

	 Contents
Electropherogram: Displays the electropherogram for the selected dye channels in the report.

Peak Table: Displays the Peak Table for each selected dye channel below the associated 
electropherogram in the report.

	 Electropherogram
Print Markers: Displays the marker bars above the electropherogram in the report. 

Print Alleles: Displays the allele labels below the peaks in the electropherogram in the report.

Implement Y Axis Settings: Applies the y-axis settings selected using the Set Axis icon in the 
‘All Color Browser’ window to the electropherogram in the report.

Note: The zoom setting of the electropherogram in the ‘All Color Browser’ window will be 
reflected in the Allele Report. Zoom out fully to include all peaks in the Allele Report.
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	 Sample Title
Label Dyes & Peak Numbers: Displays the dye color name and number of peaks observed in 
the dye channel in a header above each electropherogram.

When the desired settings are selected, select OK to print. A ‘Print’ window will open, allowing 
the user to select a printer, the page range and the number of copies. Alternatively, preview 
the printed report by selecting the Preview button. This will open a separate ‘Preview’ window 
displaying a print preview of the Allele Report. This ‘Preview’ window has the same toolbar 
ribbon as the ‘Preview’ window of the ‘Print Report’ window (Section 9.A.2). Each toolbar icon 
functions in the same manner as described above, except the ‘Content Options’ icon will open 
the ‘All Color Browser Settings’ window. 

The following icons are available in the print ‘Preview’ window of the All Color Browser. Refer to 
Section 9.A.2 for detailed descriptions.

Table 17. Icons and Functions of the Print ‘Preview’ Window of the All Color Browser.
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Print: Opens the ‘Print’ window. Select a printer, the page range and the 
number of copies.

16
77

2T
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Export to File: Opens the ‘Export Report to Files’ window. 

16
88

8T
A

Page Setup: Opens the ‘Page Setup’ window. Choose the paper size,  
margins and orientation (Portrait or Landscape).

16
89

0T
A

Content Options: Opens the ‘All Color Browser Settings’ window  
(Figure 159).

16
89

1T
A

Zoom to Fit: Zooms out to view the entire print preview page.

16
89

2T
A Zoom to Width: Zooms in to view the print preview page at maximum 

width while still displaying the entire page.

16
89

3T
A Zoom Ratio: Allows you to enter percentage numbers to increase or  

decrease the zoom aspect of the print preview page.

16
89

4T
A Close: Closes the ‘Preview’ window.
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9.C.	 Printing from the ‘Calibration Charts’ Window

The print options from the ‘Calibration Charts’ window allow you to define the layout and order 
of the calibration charts in the printed or exported file. To print or export the calibration charts, 
select the Print icon in the toolbar. This opens the ‘Calibration Print’ window, which has two 
sections to define print preferences (Figure 178). 

16
89

7T
A

Figure 178. ‘Calibration Print’ window.

	 Print Icon Select
Calibration Charts: Allows you to enter a number in the ‘Max Col’ field to define the maximum 
number of calibration charts displayed across a printed page.

Sample List: Adds information from the ‘Sample List’ section of the ‘Calibration Charts’ window 
to the printed pages.

Max Chart: Defines the maximum number of sample calibration charts displayed per printed 
page.

	 Sort Samples
Sort by Score: Sorts calibration charts by score from highest to lowest 

Sort by Filename: Sorts calibration charts alphanumerically by sample file name.

When the desired settings are selected, select OK to print the calibration charts. A ‘Print’ 
window will open, allowing you to select a printer, the page range and the number of copies. 
Alternatively, preview the report by selecting the Preview button. This ‘Preview’ window has the 
same toolbar ribbon as the ‘Preview’ window of the ‘Print Report’ window (Section 9.A.2). Each 
toolbar icon functions in the same manner as described above, except the Content Options 
icon will open the ‘Calibration Print’ window.
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The following icons are available in the print ‘Preview’ window of the ‘Calibration Charts’ 
window.

Table 18. Icons and Functions for the Print ‘Preview’ Window of Calibration Charts.

16
74

9T
A

Print: Opens the ‘Print’ window. Select a printer, the page range and the 
number of copies.

16
77

2T
A

Export to File: Opens the ‘Export Report to Files’ window. 
16

88
8T

A

Page Setup: Opens the ‘Page Setup’ window. Choose the paper size,  
margins and orientation (Portrait or Landscape).

16
89

0T
A

Content Options: Opens the ‘Calibration Print’ window (Figure 160).

16
89

1T
A

Zoom to Fit: Zooms out to view the entire print preview page.

16
89

2T
A Zoom to Width: Zooms in to view the print preview page at maximum 

width while still displaying the entire page.

16
89

3T
A Zoom Ratio: Allows you to enter percentage numbers to increase or  

decrease the zoom aspect of the print preview page.

16
89

4T
A Close: Closes the ‘Preview‘ window.
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9.D.	 Printing from the ‘Show Edit History’ Window

An Edit History Report can be printed or exported from the ‘Show Edit History’ window of the 
Peak Table (Section 5.B.3). To print or export the report, select the Print button at the bottom of 
the window. This opens a ‘Preview’ window. 

The following icons are available in the print ‘Preview’ window of the ‘Show Edit History’ 
window.

Table 19. Icons and Functions in the Print ‘Preview’ Window of Show Edit History.

16
74

9T
A

Print: Opens the ‘Print’ window. Select a printer, the page range and the 
number of copies.

16
77

2T
A

Export to File: Opens the ‘Export Report to Files’ window. 

16
88

8T
A

Page Setup: Opens the ‘Page Setup’ window. Choose the paper size,  
margins and orientation (Portrait or Landscape).

16
89

1T
A

Zoom to Fit: Zooms out to view the entire print preview page.

16
89

2T
A Zoom to Width: Zooms in to view the print preview page at maximum 

width while still displaying the entire page.

16
89

3T
A Zoom Ratio: Allows you to enter percentage numbers to increase or  

decrease the zoom aspect of the print preview page.

16
89

4T
A Close: Closes the ‘Preview’ window.

The ‘Edit History’ report contains the standard page header as well as a project header with 
organization, user, run and data analysis information. The report provides a record of each Edit 
Time, Organization, User and Operation (Figure 179).

16
89

8T
A

Figure 179. Example of an ‘Edit History’ report. 
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9.E.	 Printing from the ‘User Manager’ Window

When user management is enabled, a ‘User Management History’ report can be printed or 
exported from the User Manager (Section 6.F). 

To print or export the report, select the Print button at the bottom of the ‘History’ tab of the 
‘User Manager’ window. This opens a print ‘Preview’ window for the report. The following icons 
are available in the print ‘Preview’ window of the ‘User Manager’ window. See Section 9.A.2 for 
details.

Table 20. Icons and Functions in the Print ‘Preview’ Window of the User Management History Report.

16
74

9T
A

Print: Opens the ‘Print’ window. Select a printer, the page range and the 
number of copies.

16
77

2T
A

Export to File: Opens the ‘Export Report to Files’ window. 

16
88

8T
A

Page Setup: Opens the ‘Page Setup’ window. Choose the paper size,  
margins and orientation (Portrait or Landscape).

16
89

1T
A

Zoom to Fit: Zooms out to view the entire print preview page.

16
89

2T
A Zoom to Width: Zooms in to view the print preview page at maximum 

width while displaying the entire page.

16
89

3T
A

Zoom Ratio: Allows you to enter percentage numbers to increase or  
decrease the zoom aspect of the print preview page.

16
89

4T
A Close: Closes the ‘Preview’ window.

The ‘User Management History’ report contains the standard page header. The report provides 
a record of each event that occurred from login including: Date, Time, User, Events and 
Comments (Figure 180).

Figure 180. 

17
53

3T
A

Example of a ‘User Management History’ report.
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GMHID-Spectrum provides several options to assess the quality of STR data within a project. 
Users can define the parameters by which the software will process the data and flag samples 
that do not meet the quality criteria as well as set up conditions for contamination checks. 

10.A.	 Profile Quality

Profile quality can be assessed at three levels within GMHID-Spectrum: size match (as defined 
by the chosen size standard template, Section 7.B), size standard quality (Section 10.A.2) 
and analysis quality (Section 10.A.3). A fourth level of assessment is available for STR kits 
containing two quality indicator peaks in GMHID-Spectrum software version 3.2.0 or later 
(Section 10.A.4). Samples designated as positive controls, negative controls or ladders are 
assessed by the additional metric of concordance to an expected result.

A summary of the quality assessment is displayed in the Project Summary Bar at the bottom of 
the ‘Main Analysis’ window. Controls or ladders that do not meet the concordance criteria will 
be counted as an error in their respective boxes (Figure 181). 

Note: Positive control profiles are defined in the Positive Control Template Editor (Section 6.E); 
negative controls are expected to be void of labeled peaks, and allelic ladders are defined 
by parameters of the applied panel (Section 4.A.1). Samples with failed size standards or 
failed injections will be tallied in the ‘#Failed’ box as will failed controls (Figure 181). Samples, 
including controls and ladders that do not meet defined analytical measures, will be tallied in 
the ‘#Flagged’ box (Figure 181).

The Sample File Tree also provides a visual display of quality measures as described in 
Section 5.A. 

10	�  
Quality Assessment
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Sample File
Tree

Project 
Summary
Bar

Electropherogram Chart Report Table

16
74
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Figure 181. Assessing STR data quality.

10.A.1	 Size Match Score
After a size standard template is applied to a dataset, a size match score is assigned to each 
sample based on how closely the sample size standard matched the size standard template. 
Perfect matches receive a score of 100. Samples with no correlation receive a score of 0 and 
fail size calling. Each sample’s size match score is available in the Sample File Tree of the ‘Main 
Analysis’ window. Samples with a high match score (greater than 80) are indicated by a green 
sheet (Figure 182). Those with a low match score (1–80) will have a yellow sheet. Samples for 
which size calling failed (size match score of 0) receive a red strike-through. A more detailed 
assessment of each sample’s size match score is available in the ‘Calibration Charts’ window 
(Section 7.B). 

16
90

1T
A

Figure 182. Size match score displayed in the Sample File Tree.
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10.A.2	 Size Standard Quality
In addition to assessing the match between a sample’s size standard and the size standard 
template, the software can also assess the quality of size standard peaks. To choose this 
option, known as SQ (Size Quality) flagging, select the flagging option in the Low ILS Quality 
Flag ‘SQ’ section in the ‘Sample Quality’ tab of the ‘Preferences’ window (Section 6.B). When 
this option is selected, the software will evaluate the three criteria listed below to determine 
whether a sample size standard meets the size quality requirements. If the sample size 
standard does not meet all three criteria, the sample is marked with a red SQ flag in the 
Sample File Tree of the ‘Main Analysis’ window and in the upper left corner of the sample 
electropherogram.

1.	 The sample size standard contains all peaks that are marked as “Enabled” in the chosen 
size standard template. 

2.	 All of the expected size standard peaks are called in the ‘Main Analysis’ window.

3.	 All of the expected size standard peaks are of high quality such that the absolute 
difference in size between the actual size standard peaks and the expected, Enabled size 
standard peaks is less than 0.2bp. 

To display the reason for the SQ flag, hover over the SQ flag in the electropherogram. Samples 
that will receive an SQ indicator include:

•	 Samples with one or more size standard fragments outside of the expected linear range 
for size calibration (Figure 183).

17
66

6T
A

Figure 183. Sample size standard with two peaks (red circle) outside of the expected size calibration linear range.
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•	 Samples in which all ILS fragments are detected for pattern recognition and are in the 
linear range (Figure 184), but one or more peaks are of low quality and not called in the 
‘Main Analysis’ window (Figure 185).

Figure 184. 

16
90

3T
A

Example where all of the ILS fragments are detected in the ‘Calibration Charts’ window.

Figure 185. 

16
90

4T
A

’Main Analysis’ window of the sample in Figure 166 showing one or more low-quality peaks not called 
by the software.
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10.A.3	 Analysis Quality
Samples, including controls and ladders, have defined analysis parameters that are applied 
during data processing. When one or more parameters are not met, a sample is flagged for 
Analysis Quality with a red question mark (Section 5.A) before the file name in the Sample File 
Tree and the Report Table of the ‘Main Analysis’ window. The parameter(s) not met, including 
the peaks that triggered the Analysis Quality flag, and the corresponding quality reasons are 
indicated in the allele label within the electropherogram and listed in the associated Peak Table 
(Section 5.B.2). If all peaks triggering the Analysis Quality flag are addressed through allele 
editing (Section 5.B.3), the red question mark will be replaced with an “E” in the Sample File 
Tree.

Also flagged are samples with null marker(s) and samples with Amelogenin and Y-STR marker 
conflict(s) for STR multiplexes that amplify Amelogenin and Y-STR markers. Samples are 
evaluated for Amelogenin and Y-STR marker conflicts only when “Allele Peak Issues Flag ‘?’” is 
applied in the ‘Sample Quality’ tab of the ‘Preferences’ window (Section 6.B).

The following situations will cause an ‘Analysis Quality’ flag. 

Controls and Ladders 

Ladders: The software compares all allelic ladder peaks to the expected bin positions as 
defined by the applied panel. Allelic ladders are flagged for Analysis Quality when there is an 
error in bin shifting (Section 4.C.2; Figure 186), when peaks in virtual bins have greater than 
expected peak heights (i.e., resemble real peaks, Figure 187) or if the expected peaks cannot 
be identified in a marker. When expected peaks cannot be identified in a marker, the marker bar 
will be shaded dark green, indicating the marker failed analysis.

Figure 186. 

16
90

5T
A

Example of a ladder that failed analysis.
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When errors in bin shifting occur or when peaks in virtual bins have higher than expected peak 
heights, the marker bars will be outlined in red (Figure 187). 

16
90

6T
A

Figure 187. Example of higher than expected peak height for a ladder peak in a virtual bin.

Any peaks that cause an Analysis Quality flag are indicated in the electropherogram and Peak 
Table. File names for allelic ladders that pass all quality metrics and are available for use as 
best ladders for the Auto Select Best Ladder function (Section 4.C.1) are shown in bold.

When Flag Variant Alleles in Ladder is selected in the ‘Display’ tab of the ‘Preferences’ window 
(Section 6.B), peaks in virtual bins with higher than expected peak heights are indicated by 
yellow vertical bars and green allele labels (Figure 187). You can set your preferences to 
automatically delete these peaks by selecting Auto-Delete Alleles in Virtual Bins in Allelic 
Ladder in the ‘Forensics’ tab of the ‘Preferences’ window.

Peaks that are not present in the expected bins are marked with red vertical bars and red allele 
labels (Figure 188).
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16
90
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Figure 188. Example ladder peaks not in the expected bins, highlighted in red.

Positive controls: Positive control samples are compared to the positive control template(s) 
designated in the ‘Additional Settings - HID Analysis’ window of the Run Wizard (Section 4.C). 
When peaks in a positive control sample match the peaks in the positive control template, the 
positive control is concordant (Figure 190). Positive controls are flagged for Analysis Quality 
if expected peaks migrate outside of the expected bins, extraneous peaks are detected or 
any sample quality criteria are not met (see below). If extraneous peaks are detected or an 
expected peak does not fall within the appropriate bin, the marker bar will be outlined in red. 
Peaks that migrate outside of the expected bin are marked with red vertical bars (Figure 189).

16
90

8T
A

Figure 189. Example of positive control peaks outside of the expected bins marked with red vertical bars.

Extraneous peaks detected in the positive controls are marked with yellow vertical bars and 
green allele labels (Figure 191). Positive controls that do not meet Analysis Quality criteria 
are flagged with a red question mark before the file name in the Sample File Tree and Report 
Table. The parameter(s) not met, including which peaks triggered the Analysis Quality flag 
and the corresponding quality reasons (Table 21), are indicated in the allele label within the 
electropherogram and listed in the associated Peak Table (Section 5.B.2).
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In Figure 190, the negative controls and one of the positive controls do not exhibit Analysis 
Quality flags. One of the positive controls is discordant and exhibits an Analysis Quality flag in 
the Sample File Tree.

16
90
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A

Figure 190. Examples of a concordant positive control (top) and negative control (bottom) that do not exhibit 
‘Analysis Quality’ flags.

16
91
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Figure 191. Discordant positive control (top) and negative control (bottom) that exhibit flags for extraneous peaks.



184      GeneMarker®HID Software for Spectrum CE Systems | TM555 | Revised 1/23

Quality Assessment

Negative controls: To be considered concordant, negatives must be devoid of called peaks. 
Negative controls will be flagged if peaks are present in the sample (Figure 191).

Samples 

Sample quality is assessed using the settings established in the Run Wizard (Section 4), 
including the applied panel (Section 4.A.1). Each sample peak that does not meet a quality 
criterion is flagged by a colored allele label in the electropherogram, by a colored allele symbol 
in the Report Table (Section 5.E) and by colored font in the ‘Quality’ column of the Peak Table 
(Section 5.B.2). Yellow flags indicate peaks with a quality designation of “Check”. Red flags 
indicate a quality designation of “Undetermined”. Peaks with quality designations of “Check” or 
“Undetermined” should be evaluated. 

Each peak with a “Check” or “Undetermined” designation is assigned a quality reason  
(Table 21). The “PL”, “OB” and “OL” quality reasons are associated with a quality designation of 
“Undetermined” (red flags). All other quality reasons are associated with a quality designation 
of “Check” (yellow flags). 
Note: Peaks that exceed the maximum peak intensity threshold set in the ‘Data Process - HID 
Analysis’ window of the Run Wizard (Section 4.B.3) are assigned a Pass quality designation; 
however, they will be denoted as “HI” for the quality reason. 

You can view the quality reason by hovering over the allele label of the flagged peak in the 
electropherogram or in the ‘Quality Reason’ column of the Peak Table. Table 21 lists quality 
reasons in the software. Definitions of these abbreviations are available by selecting the Help 
icon in the Report Table.
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Table 21. Quality Reason Acronyms in GMHID-Spectrum.

Acronym Name Comments

BC Bin Conflict Peak overlaps two or more bin ranges.

HI High Intensity Peak intensity approaches or exceeds the maximum peak  
intensity threshold set in the ‘Data Process - HID Analysis’  
window (Section 4.B.3).

IHE Inconclusive 
Heterozygous

Peak intensity is within the heterozygous inconclusive range 
for the marker set in the ‘Edit Panel’ window of the Panel Editor 
(Section 4.A.1).

IHO Inconclusive 
Homozygous

Peak intensity is within the homozygous inconclusive range 
for the marker set in the ‘Edit Panel’ window of the Panel Editor 
(Section 4.A.1).

IMB Heterozygote 
Imbalance

The balance of heterozygous peaks is below the maximum 
value set in the ‘Edit Marker’ window of the Panel Editor 
(Section 4.A.1). 

LO Low Intensity Intensity of a single peak is below the ‘Minimum Homozygote 
Intensity’ threshold set in the ‘Edit Marker’ window of the Panel 
Editor because a second peak was detected above the N–X 
stutter filter percentage value (Section 4.A.1).

LS Low Score Peak has a peak score below the threshold for a passing peak 
score (Section 4.C.4).

OB Out of Bin Peak is within the marker range but outside of a bin.

OL Off Ladder Peak is outside of the marker range.

PL Beyond Ploidy The number of peaks identified within a marker exceeds the 
maximum number of peaks expected as set in the ‘Edit Panel’ 
window of the Panel Editor (Section 4.A.1).

SD Saturation 
Detection

Peak intensity exceeds the linear range of the CE instrument. 
Peak exhibits a morphology characteristic of a saturated peak 
or exhibits pull-up peaks associated with saturated peaks.

SP Saturated 
(Pull-up)

Pull-up peak associated with a Saturated (Repaired), SR, peak 
(see below). 

SR Saturated 
(Repaired)

Peak has a peak morphology characteristic of saturated peaks 
but was “repaired” for allele calling (Section 4.B.1).
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10.A.4	 Quality Indicators
Analysis parameters can be set for assessing the quality indicators peaks, in STR kits 
containing them. To choose this option, known as Q (Quality Indicator) flagging, select 
the “Sample Quality Peak(s)” box in the ‘Additional Settings - HID Analysis’ window of the 
Run Wizard, then select the appropriate peaks for the Small Allele and Large Allele quality 
indicators. (Section 4.C.4). Set the threshold for quality indicator flagging in the ‘Preferences’ 
window (Section 6.B). 

Samples with quality indicator peak ratios below the ‘Minimum intensity ratio’ are marked with 
a red Q over the Size Match Score in the Sample File Tree of the ‘Main Analysis’ window and in 
the upper left corner of the sample electropherogram (Figure 192). 

Hover over the Q flag in the electropherogram to display the reason (‘Q- Peak imbalance, e.g. 
PCR inhibition’). Select the Q flag in the electropherogram, to display the ‘Sample Quality Detail’ 
window with the calculated ‘Quality Intensity Ratio’ (Figure 192).

Figure 192.  

18
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Example of quality indicator flagging in the ‘Main Analysis’ window.
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10.B.	 Contamination Check 

You can compare analyzed profiles within a project against each other and against the 
laboratory’s established Contamination Database (Section 11) using the Contamination Check 
feature. Before using the Contamination Check feature, process data through the Run Wizard 
and review the data, editing as necessary. To access this feature, select Contamination Check 
from the ‘Project’ menu of the ‘Main Analysis’ window. This opens the ‘Contamination Check’ 
window, which allows you to define search and display parameters as well as to save the 
results of the contamination check (Figure 193).

10.B.1	 Navigating the ‘Contamination Check’ Window 
The ‘Contamination Check’ window contains five sections to define search and display options, 
a toolbar and a list of search results. 

16
91
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Figure 193. ‘Contamination Check’ window.

Exclude Sample Setting: Excludes certain samples from the search: ladders, negative controls 
(NC), positive controls (PC), samples with greater than the specified number of null markers 
or samples with greater than the specified number of markers with greater than the specified 
number of alleles.

Other Settings: Refines the comparison parameters. 

	 Export Similarity Ratio Greater Than: Defines the percent similarity required for the 
comparison sample and reference sample to be considered a match. Setting this to zero 
will display all possible matches.
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Similarity Ratio 
is calculated as:

Number of reference sample alleles included in the 
comparison sample   

Total number of reference sample alleles
× 100

Percent similarity is calculated using only the called alleles observed in each sample.

	 Specified Sample as Comparison: You can select a specific sample from the project 
as the comparison sample. To activate this option, check the box in the field and select 
the desired sample from the drop-down list. To compare all samples in the project, 
leave this box unchecked.

Match Type: Specifies the type of search to perform: “Within Project” or “With Database”. When 
the With Database type is selected, use the drop-down menu to select the Contamination 
Database. 
Note: It is also possible to select and perform a search against the Relationship database. 
Genotypes must be submitted to the respective database (Section 11.A) before a 
contamination check can be performed. 

By default, samples in the project are the comparison samples and the database samples 
(i.e., samples with “DB” in the sample name) are the reference samples for a With Database 
search. To run the reverse search (database samples as the comparison samples and project 
samples as the reference samples), check the “DB as Comparison” box. In a Within Project 
search, samples within a project are compared to each other. Each project sample is both a 
comparison sample and a reference sample.

Highlight Groups: Highlights groups of matches based on one of two criteria. 

	 By Order: Samples are displayed in groups based on the number entered into this field, 
and groups have alternate shading of white and gray. In the example shown in  
Figure 194, samples are highlighted in groups of 2. 

16
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Figure 194. Highlight Groups By Order.

	 By Similarity Range: Samples are displayed as groups based on their similarity ratios. 
For example, if the user enters 5 in this field (Figure 195), groups include samples with 
similarity ratios in increments of 5%. All matches with 100% similarity ratios are 
grouped together, followed by all matches with 95–99% similarity ratios, matches with 
90–94% similarity ratios, etc. Groups are indicated by alternate shading.
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Figure 195. 
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Highlight Groups by Similarity Range. 

Display Name: You can choose to display samples by File Name or Sample Name.

Search: After customizing these search and display options, be sure to select the Search icon 
to initiate the contamination check. If you change any of these options, be sure to select the 
Search icon to refresh the search results.

The ‘Contamination Check’ window also includes a toolbar, which has the following icons and 
functions.

Table 22. Icons and Functions of the ‘Contamination Check’ Window.

16
91
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Save to Database: Opens the ‘Submit Genotypes’ window, which enables 
saving of genotypes to the Contamination Database. Upload genotypes 
from samples in the current project or samples saved in a .txt file or .cmf 
file (Section 11.A).

16
91

5T
A Edit Database: Opens the ‘Contamination Database Editor’ window from 

which to manage, edit and delete genotypes in the Contamination Database 
(Section 11.B).

16
91
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Search: Initiates the contamination check and refreshes search results if 
search or display options are changed.

16
77
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Save Report: Opens the ‘Save Report’ window. You can export the results 
of the contamination check as an Excel (.xlsx), text (.txt) or CSV (.csv) file.

The ‘Contamination Check’ window includes a list of search results. The name of the tab 
indicates the type of match search (‘Within Project’ or ‘With DB’). Each list contains six columns 
of information. You can sort the list by each column, except ‘Group No.’, by clicking on the 
column header.

Group No.: Displays the sequential number assigned to each profile comparison. Samples are 
displayed numerically by group number.

Comparison Sample: Lists the sample being used for comparison.
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Reference Sample: Lists the reference sample being used for comparison.

Matched/Total Reference: Lists the number of matched markers and number of total markers 
in the reference sample. For example, a “47/47” in this column indicates that 47 of the markers 
in the comparison sample matched the 47 markers in the reference sample.

Similarity Ratio: Lists the calculated similarity ratio (see equation above).

Matched Markers (Alleles): Lists the markers that matched between the comparison and 
reference samples, with the matching allele(s) listed in parentheses.

10.B.2	 Performing a Contamination Check
You can perform a contamination check between samples within a project once the raw 
data is processed and quality flags are addressed. The example below details the process 
using two samples: a two-person mixture (Mix01_1ng_M-F_19-1) and a single-source sample 
(Mix01_1ng_M-F_1-0).

The search and display parameters were set as follows (Figure 196):

Exclude Sample Setting: Exclude ladders and controls as well as samples with 3 null markers. 

Export Similarity Ratio Greater Than: Display all samples with similarities greater than 0%.

Match Type within Project: Perform all sample-to-sample comparisons within the project.

Match Type with Database: Check for matches within the Contamination Database.

Highlight Groups: Not selected.

Display Name: Display the samples by file name.

The example in Figure 196 shows the matches within the project. In Group No. 1, 100% of the 
reference sample alleles (i.e., the single-source sample alleles) are included in the comparison 
sample (i.e., the mixture sample). In Group No. 2, 65.33% of the reference sample alleles (i.e., 
the mixture sample alleles) are included in the comparison sample (i.e., the single-source 
sample alleles). The last column of each row contains the shared genotype. 

16
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Figure 196. Example of the ‘Contamination Check’ window showing matches within the project.
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The example in Figure 197 shows matches with samples in the selected Contamination 
Database. For the purposes of this demonstration, the single-source file in the above example 
and several other single-source files were previously saved to the Contamination Database 
to provide matches to the two samples within this project. The results indicate that 100% of 
alleles in the Mix01_1ng_M-F_1-0 sample are included in the single-source sample (comparison 
sample for Group No. 1) and in the mixture sample (comparison sample for Group No. 2). The 
comparison samples for group numbers 3–6 share less than 50% of the alleles present in two 
reference samples in the Contamination Database (NIST 2391 C-C and NIST 2391 C-A). 
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Figure 197. Example of the ‘Contamination Check’ window showing matches with the Contamination Database.

10.B.3	 Submitting Genotypes to the Contamination Database from the ‘Contamination 
Check’ Window

You can save profiles to the Contamination Database from within the ‘Contamination Check’ 
window. To add samples to the database, select the Save to Database icon (Table 22). This 
opens the ‘Submit Genotypes’ window, with a list of all project samples (Figure 198). By default 
all samples are marked for submission. To remove samples from the list, deselect the check 
box in that sample row. The ‘Name’, ‘Department’ and ‘Comments’ columns can be edited. 
Information added to these columns will be saved with the sample(s) in the database. When 
all samples are marked appropriately, select the Submit button. The selected samples are now 
included in the Contamination Database. Samples that are not part of the current project also can 
be added to the Contamination Database from this window following instructions in Section 11.A.
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Figure 198. ‘Submit Genotypes’ window.
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GMHID-Spectrum contains two databases for profile searching: contamination and 
relationship. The Contamination Database allows you to store profiles to be searched using the 
‘Contamination Check’ feature (Section 10.B). The Relationship Database allows you to store 
profiles to be searched using the Relationship Testing application. For further information on 
using the Relationship Testing application, contact Promega Technical Services at:  
genetic@promega.com. You can manage the information contained within each database 
through the Database Manager, which is accessible via the ‘Tools’ menu in the ‘Main Analysis’ 
window (Figure 199). There are three options for database management: Submit Genotypes to 
DB, Contamination DB and Relationship DB. 
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Figure 199. ‘Database Manager’ menu.

11.A.	 Submitting Genotypes to a Database

You can submit genotypes to a database by selecting Submit Genotypes to DB from the 
Database Manager in the ‘Tools’ menu. This opens the ‘Submit Genotypes’ window  
(Figure 200). There are three fields shown at the top of the window:

Species: Displays “Human” by default and cannot be changed in GMHID-Spectrum.

Submit by: Displays “GeneMarker” by default and cannot be changed in GMHID-Spectrum. 

Submit to: Provides a drop-down menu to select the appropriate database for the sample(s).

Note: Genotypes also can be submitted directly to the Contamination Database from the 
‘Contamination Check’ window (Section 10.B.3).
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Figure 200. ‘Submit Genotypes’ window.

To submit a sample to the Contamination Database, you must first import samples into the 
‘Submit Genotypes’ window. Samples can be imported from either .cmf or .txt files.

Importing genotypes from a .cmf file:

1. 	 Select Load from CMF on the right side of the window.

2. 	 This opens the ‘Open CMF Files’ window. Select Add… to open a navigation window to 
locate the desired file(s). 

3. 	 Select OK to return to the ‘Submit Genotypes’ window. 

4. 	 The genotypes from the selected file(s) are listed in the window. Select Submit to add 
the genotypes to the selected database.
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Figure 201. Required spreadsheet format for importing genotypes as .txt files.
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Importing Genotypes from a .txt File

Genotypes imported as a text (.txt) file must first be entered into a Microsoft Excel® spreadsheet 
or another spreadsheet program. Samples must have the exact format shown in Figure 201.

1. 	 The term “AID” (accession ID number) must be written in the upper left corner of the 
spreadsheet. 

2. 	 List each marker name twice (once for each allele). 

3. 	 For samples that have no data at certain markers, type ** into those marker cells. 
Blank cells are not allowed. 

4. 	 When all genotypes are entered, save the file as a tab-delimited text file.

5. 	 In the ‘Submit Genotypes’ window, ensure the appropriate text file delimiters are 
represented in the Column and Genotypes field of the TXT Delimit section. 

	 a. 	 Ensure that \t is entered in the Column field to indicate the columns are 
		  tab-delimited.

	 b. 	 Leave the Genotypes field blank. 

6. 	 Select Load from TXT from the right side of the ‘Submit Genotypes’ window to open a 
navigation window. 

7. 	 Browse to and select the appropriate text file. Select Open to start the import process. 
A ‘Load data from text file...’ window will track the file import process and indicate how 
many samples were imported successfully. 

8. 	 Select OK to return to the ‘Submit Genotypes’ window (Figure 202). The genotypes 
from the selected file will be listed in the window. 

9. 	 Select Submit to add the genotypes to the selected database.
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Figure 202. ‘Submit Genotypes’ window after the .txt file shown in Figure 200 was used to import genotypes.
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Samples with the same name but genotyped using different STR chemistries can be submitted 
to (and combined in) the database. When you submit a sample with the same name as a 
sample already present in the database, a confirmation window opens to ask you if want to 
overwrite the original sample (Figure 203). To accept the second sample into the database and 
combine the results of the two records, select No. To overwrite the existing sample with the 
new data, select Yes. Select Cancel to skip the sample(s) with the same names. Select Abort 
to cancel the genotype submission.

Figure 203. 
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Choices presented if a genotype exists in the database when submitting.

11.B.	 Database Editors

Each GMHID-Spectrum database has its own database editor, which allows you to manage, 
edit or delete genotypes from the database. To edit a database, select the appropriate 
database from the list next to Database Manager in the ‘Tools’ menu (Figure 199). This opens 
the database editor for the selected database. The options for each database editor are the 
same (Table 23). The ‘Contamination Database Editor’ window is shown in Figure 204. 
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Sample
Details

Sample
List

Figure 204. ‘Contamination Database Editor’ window.

The Contamination Database Editor contains a toolbar, sections to define directory and search 
display options, a Sample List section and a Sample Details section. 
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GeneMarker Projects Directories: Lists the file path for the directory of the chosen database. 

List Conditions: Allows you to search for a specific sample or restrict the samples displayed in 
the list. 

	 ID Range: Allows you to specify the samples displayed by defining the desired range of ID 
numbers. You can also limit samples in the list by Name, Sex or Sample Name. Choose the 
desired options, then select the Refresh icon in the toolbar to refresh the Sample List  
(Table 23).

Sample List (upper right corner of Contamination Database Editor): Displays all samples in the 
specified directory that meet the criteria specified in the ‘List Conditions’ section. Each sample 
is assigned a number, which is displayed in the first column. The remaining six columns 
contain sample information included when the sample was added to the database. Select the 
row of a specific sample to display its genotype in the ‘Sample Details’ section at the bottom of 
the screen. 

If the list spans multiple pages, the total number of pages is listed at the bottom of the section 
and the arrows can be used to navigate through the pages. Use the < > buttons to move 
forward and backward one page, or use the |< >| buttons to move directly to the first and last 
page, respectively. 

Sample Details (bottom of Contamination Database Editor): All fields in the Sample Details 
section are editable. To edit information on the left side of the section (ID, Name or Sample 
Name), click in the field and edit as needed. Use the drop-down list in the Sex field to select the 
appropriate designation. To edit information in the genotypes table on the right side, double-
click on a cell and edit the value. 

Table 23. Icons and Functions of the Contamination Database Editor.
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Save: Saves any changes that were made to a sample in the database. A 
confirmation window shows that the database was updated. 
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Refresh: Updates the Sample List section. The search criteria specified 
in the ‘List Conditions’ section are not applied until you select the Refresh 
icon.
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Export CODIS: Opens the ‘CODIS Export’ window (Section 6.D), which can 
be used to export genotypes in CODIS format.
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Export Database (available only in the Contamination Database): Opens 
a ‘Save As’ window to create and export a report representing the sample 
information and genotypes displayed in the Sample List as either an Excel 
file (.xlsx) or text (.txt) file.

You can remove a sample from a database by right-clicking on the sample entry and 
selecting Delete. To select and delete multiple samples, hold down the Control key while 
selecting individual samples or hold down the Shift key while selecting groups of samples. 
A confirmation window will appear. Select Yes to remove the sample from the database and 
return to the Contamination Database Editor.
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12.A.	 File Name Group Editor
The File Name Group Editor (Figure 205) can be used to group samples in the dataset based on 
their file names for simplified reviewing of results and printing. The group designations defined 
in this editor are reflected in the Sample File Tree. This window is also used to modify file 
groups to allow profile comparison both between projects (Section 12.B) and within projects 
(replicate comparison, Section 12.C).

In addition to grouping samples by file name, you can define groups of samples using defined 
control match criteria (Figure 205). For example, samples can be grouped by their designation 
as controls or reference samples. In GMHID-Spectrum, control groups are typically defined only 
for use in the ‘Relationship Testing’ application (Section 6.D).

12.A.1	 Navigating the File Name Group Editor
To use the File Name Group Editor, ensure “Enable Sample Grouping” is checked in the ‘Others’ 
tab of the ‘Preferences’ window, then select Apply Sample Grouping from the ‘Project’ menu 
(Section 6.B.6). This opens the ‘File Name Group Editor’ window. The ‘File Name Group Editor’ 
window contains a toolbar, two list sections, a section to define match criteria and a section to 
define control or reference samples (Figure 205). The File Name List section displays the file 
name for all samples loaded into the File Name Group Editor. The Matched Groups List section 
displays all groups that meet the specified match criteria.

Figure 205. 
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Match
Criteria
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‘File Name Group Editor’ window.
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Table 24. Icons and Functions of the File Name Group Editor Toolbar.
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name from the instrument is not optimal for sorting. Any edits made to the 
file name are only applied in the File Name Group Editor. The file names 
remain unchanged outside of this window.
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Save Groups to File: Saves the file names of the samples grouped in the 
Matched Groups List section. Samples identified as controls are in the first 
column of the resulting Matched Groups text (.txt) file.

Samples can be grouped by sections of their file names (Match by Sections), fixed positions 
within the file names (Matched by Fixed Position) or group size (Group by Order) by selecting 
the corresponding tab in the match criteria section.

	 Match by Sections
The ‘Match by Sections’ tab allows you to group samples based on the designated section of 
their file names (Figure 205). File names are split into sections based on a Section Separator 
defined by the user. The user also must specify which section of the file name is used to group 
the samples.

Section Separators: Allows you to define which delimiter(s) (e.g.,. hyphens, underscores, 
periods and commas) define sections of a file name. For example, a sample with the file name 
A01_Sample 1_1ng.fsa would have three sections if an underscore was defined as the section 
separator.

Section 1 Section 2 Section 3

1 A01 Sample 1 1ng.fsa

If both an underscore and period are defined as section separators, the same file name would 
have four sections: 

Section 1 Section 2 Section 3 Section 4

1 A01 Sample 1 1ng fsa

Group Identification: Use the Compare by Section field to identify the section of the file names 
used to group the samples (i.e., first section, second section, third section, etc.). The specified 
section is highlighted in red in the File Name List, and the column heading includes “(G)”  
(Figure 206).
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Figure 206. Example of samples grouped by the second file name section.

Control Identification: Use the ‘Match to Identifier by Section’ field to define the range of 
characters within a file name that identify a sample as a control or reference sample. The 
specified section of the file name is highlighted in green in the File Name List, and the column 
heading includes “(C)”. Leave this field blank unless you are assessing paternity trios. Please 
contact Promega Technical Services at: genetic@promega.com for assistance in using the 
‘Relationship Testing’ application for paternity trios.
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	 Match by Fixed Position
The ‘Match by Fixed Position’ tab allows you to group samples by the character at the specified 
position within the file name (Figure 207). Each character, including section separators, is 
counted from left to right, starting at 1.
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Figure 207. Samples grouped by characters at the specified position of the file name.

Group Identification: Use the Compare Character field to define the range of characters 
within a file name used to group the samples. The specified characters in the file name are 
highlighted in red in the File Name List (Figure 207).

Control Identification: Use the Match to Identifier field to define the range of characters within 
a file name that identify a sample as a control or reference sample. The specified characters 
within the file name are highlighted in green in the File Name List. Leave this field blank unless 
you are assessing paternity trios. Please contact Promega Technical Services at:  
genetic@promega.com for assistance in using the ‘Relationship Testing’ application for 
paternity trios.
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	 Group by Order 
The ‘Group by Order’ tab groups samples by group size (Figure 208). Enter a number or 
use the arrows to adjust the number in the Group Size field to the desired group size. For 
example, if the dataset contains three replicates of each sample and the project is ordered 
so that replicates follow in succession, these three replicates will be grouped with a group 
size of 3. Because Group Size is set to 3, this group of replicates and any other groups of 
three, regardless if they are replicates or not, are displayed as groups in the File Name List 
and Matched Groups List sections. You can also group samples designated as positive and 
negative controls. You can define a control group using the fields in the Control Match Criteria 
section (Figure 205).

Figure 208. 
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Samples arranged by group size.

Control Match Criteria 

When using the Group by Order method to group control samples, the user completes the 
‘Control Match Criteria’ section to define a control group. The software uses this information to 
group control samples based on characters within the file name. Enter the desired characters 
in the field to the right of the ‘Control’ drop-down field. Check the “Case Sensitive” box if the 
upper- or lowercase letters of the match criteria must match exactly. 

Select Whole Words to look for file names that contain an exact match to the characters 
entered into the Control field.

Select Include to look for file names that include the characters in the Control field. An exact 
match is not required.

In the example shown in Figure 208, the user defined a control group as all samples that 
included “02” in the file name. The criteria are not case-sensitive.
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12.A.2	 Applying File Name Grouping
File name grouping can be applied to samples in the current open project. When the File Name 
Group Editor is opened, the software automatically loads file names for all project samples into 
the File Name List. You can add additional samples to the list by selecting the Load File button 
at the bottom of the editor (Figure 208).

Choose the desired match or group method, define the necessary identifiers and then select 
the Match button to apply the group matching criteria. The resulting groups will be displayed 
in the Matched Groups List. The first column in the Matched Groups List is labeled “Control” 
regardless of whether a control group was defined or not. When samples are grouped correctly, 
you can save the group matching criteria as a text (.txt) file by selecting the Save Groups to 
File icon (Table 24). You can apply previously saved match criteria to the same file names by 
selecting the Load File button at the bottom of the editor. To apply the match criteria to the 
project samples and return to the ‘Main Analysis’ window, select OK. The group designations 
are now displayed in the Sample File Tree.

12.B.	 Project Comparison Tool 

The Project Comparison tool can be used to compare data analyzed in two different projects. 
Users may want to perform such a comparison to assess differences in: analyses between 
analysts, changes in run or analysis parameters or results generated from two different 
capillary electrophoresis instruments. 

12.B.1	 Navigating the Project Comparison Tool
To use the Project Comparison tool, open the project that will be used as the reference project, 
ensure file name grouping is applied such that reference samples are matched with their 
corresponding comparison samples (Section 12.A), then select Project Comparison from the 
‘Tools’ menu of the ‘Main Analysis’ window (Section 6.E). This opens the ‘Project Comparison’ 
window, which contains a Toolbar, Electropherogram Charts (with optional Peak Table display), 
the Peak Comparison Table and the Comparison Report Table (Figure 209).
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Figure 209. ‘Project Comparison’ window.

Select the Open Project to Compare icon (Table 25) in the toolbar to select the project to be 
compared to the reference project.

The Electropherogram Charts section displays the electropherogram for the selected reference 
profile (top) and the sample comparison profile (bottom). The display reflects the display 
settings chosen in the ‘Preferences’ window of the ‘Main Analysis’ window (Section 6.B) 
and from the toolbar of the ‘Project Comparison’ window (Table 25). The same zoom and 
navigation features available in the electropherogram of the ‘Main Analysis’ window are 
also available in this window. The same options are available by right-clicking within the 
electropherogram and Peak Table as are available in the ‘Main Analysis’ window.

Select the Project Comparison Settings icon (Table 25) to open the ‘Project Comparison 
Settings’ window (Figure 210). Information selected in this window is displayed in the Peak 
Comparison Table for the reference sample (ref) and comparison sample (sam) profiles.
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Figure 210. 
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‘Project Comparison Settings’ window.

The ‘Project Comparison Settings’ window (Figure 210) allows you to specify the parameters 
to be compared between the reference and comparison profiles. This window is split into three 
sections:

Peak Matched By: Allows you to define which peak identifiers are used during the comparison. 

	 Marker Name + Allele Name: When selected, compares peaks with the same allele name 
within the same marker.

	 Marker Name + Peak Size: When selected, compares peaks with the same size within the 
same marker.

	 Dye + Peak Size: When selected, compares peaks with the same size in the same dye channel.

Peak Compare Items: Allows you to choose which parameters are compared. When these 
parameters are different between the reference and comparison profiles, these differences are 
indicated in the Comparison Report Table and Peak Comparison Table (Figure 209). 

Peak Comparison Threshold: Allows you to specify the maximum acceptable differences 
in peak attributes, including peak size, peak area, peak height and peak score. Samples 
that exceed the specified Peak Comparison Thresholds will be highlighted in yellow in the 
Comparison Report Table. 

Note: Peak Comparison Threshold fields will be inactive unless the corresponding identifier is 
selected in the Peak Compare Items section.
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The Comparison Report Table displays the genotypes for all samples in both projects, with 
the reference and comparison profiles grouped together. Peaks that differ by more than the 
thresholds set in the ‘Project Comparison Settings’ window are marked with “#DIFF” followed 
by the threshold that was exceeded (Size, Area, Height or Score). Peaks detected in one 
profile but not the other are marked with “#LOSS”. Cells that contain “#DIFF” or “#LOSS” are 
highlighted in yellow in the Comparison Report Table. Selecting a cell within the table displays 
that marker in the Electropherogram Charts, with the chosen peak highlighted in both the 
reference and comparison profiles.

Table 25. Icons and Functions of the ‘Project Comparison’ Window.
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Open Project to Compare: Opens a directory window to allow you to 
identify the project to be compared (the comparison project) to the project 
already open in GMHID-Spectrum (the reference project). 
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Project Comparison Settings: Opens the ‘Project Comparison Settings’  
window (Figure 191) allowing you to specify the parameters to be 
compared between the reference and comparison profiles.
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Edit File Groups: Opens the File Name Group Editor to change group  
settings as necessary to better reflect the project file names (Section 12.A).
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A Save Results: Opens a ‘Save As’ window to save the Comparison Report 

Table as a .xlsx or .txt file. The arrow allows a choice of whether to save the 
whole comparison (Save whole result) or only the differences between the  
projects (Save difference result).
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Show Dye: Allows you to view all colors, hide all colors or choose any 
combination of dye layers by clicking on the down arrow. To cycle through 
individual dye channels, click on the icon.
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Zoom In: Zooms in on the center point of the electropherogram.
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Zoom Out: Zooms out from the center point of the electropherogram. 
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Set Axis: Provides options for setting the x and y axes of the 
electropherogram charts. The default setting automatically sets the y axis 
according to the maximum peak intensity of the samples (Auto Fit Y) and 
the x-axis analysis range (Auto Fit X). You can also set specific ranges for 
the x and y axes by selecting Fixed X and Fixed Y.   

Open Charts Group: Opens the Electropherogram Charts of the first 
sample in each comparison group.
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Size Calibration: Opens the ‘Calibration Charts’ window, allowing you to 
review and edit size standard calibrations for the dataset (Section 7.B).
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Show Chart/Table: Displays the Peak Table below each electropherogram, 
which includes information such as peak size, height and user comments. 
Right-click on the table to modify the contents.
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12.B.2	 Comparing Projects with the Same File Names 
Projects that contain samples with the exact same file names are compared automatically 
without adjusting file name groups. The software will automatically match the reference profile 
to the sample comparison profile based on identical file names and display the results in the 
‘Project Comparison’ window. The profile from the first project opened in GMHID-Spectrum is 
the reference profile (marked as R==> next to the sample name in the electropherogram), and 
the profile from the second project opened in the ‘Project Comparison’ window is the sample 
comparison profile (marked as S==>).

12.B.3	 Comparing Projects with Different File Names 
Projects that contain samples with different file names must be grouped using the File Name 
Group Editor tool prior to comparison. The software cannot automatically compare profiles 
that do not have identical file names. To access the File Name Group Editor tool and group files 
appropriately, select the Edit File Groups icon from the toolbar (Table 25). Set the grouping 
criteria (Section 12.A) to appropriately compare the samples across the two projects, then 
select OK to return to the ‘Project Comparison’ window. The samples can now be compared, 
with the profile from the first project opened in GMHID-Spectrum as the reference profile 
(labeled “Reference” and marked R==>), and the profile from the second project opened as the 
sample comparison profile (labeled “Sample” and marked S==>).

12.C.	 Replicate Comparison Tool 

The Replicate Comparison tool allows the user to compare the results of replicate samples 
within a single project to check for concordance, contamination and reaction failure. Before 
using the Replicate Comparison tool, process data through the Run Wizard and review the data, 
editing as needed. Peaks cannot be edited from the ‘Replicate Comparison’ window; however, 
they can be edited using the shortcut to the ‘All Color Browser’ window from the Replicate 
Comparison tool (Table 26). 

Disabling Allelic Ladders

Because the Comparison Report Table expands to include every allele call for the selected 
replicate group, we recommend disabling all allelic ladders prior to using this tool. 

To disable an allelic ladder sample, right click on an allelic ladder sample in the Sample File Tree of 
the ‘Main Analysis’ window and select Disable (Figure 211 and Section 3.C.1). 

Note: If the disabled ladder was used during the analysis you may be prompted to reprocess your 
samples. Select No.
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Figure 211. Disabling an allelic ladder from the Sample File Tree.

12.C.1	 Navigating the Replicate Comparison Tool 
To use the Replicate Comparison tool, open the project that contains the replicate samples, 
ensure file name grouping is applied such that replicate samples are grouped (Section 12.A), 
then select Replicate Comparison from the ‘Tools’ menu of the ‘Main Analysis’ window 
(Section 6.E).

Figure 212. ‘
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Replicate Comparison’ window.
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This opens the ‘Replicate Comparison’ window (Figure 212), which contains a Toolbar, 
Electropherogram Charts (with optional Peak Table display), Peak Comparison Table and a 
Comparison Report Table. The Electropherogram Charts section displays the electropherogram 
for each replicate group. The display reflects the display settings chosen in the ‘Preferences’ 
window of the ‘Main Analysis’ window (Section 6.B) and from the toolbar of the ‘Replicate 
Comparison’ window (Table 26). The same zoom and navigation features available in the 
electropherogram of the ‘Main Analysis’ window are also available in this window. Some, but 
not all, of the same options available by right-clicking within the electropherogram and Peak 
Table of the ‘Main Analysis’ window are available in this window.

The ‘Replicate Comparison Setting’ window (Figure 213) allows you to specify the parameters 
compared between replicate samples. These same settings are available in the ‘Project 
Comparison Settings’ window (Section 12.B). This window is divided into three sections:

Peak Matched By: Allows you to define which peak identifiers are used during the comparison.

Note: The data must be analyzed with a panel file before the replicate comparisons are made.

	 Marker Name + Allele Name: When selected, compares peaks with the same allele 
name within the same marker.

	 Marker Name + Peak Size: When selected, compares peaks with the same size within 
the same marker.

	 Dye + Peak Size: When selected, compares peaks with the same size in the same dye 
channel.

Figure 213. 
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‘Replicate Comparison Setting’ window.

Peak Compare Items: Allows you to choose which parameters are compared. When these 
parameters are different between replicate samples, these differences are indicated in the 
Comparison Report Table. 

Peak Comparison Threshold: Allows the user to specify the maximum acceptable differences 
in peak attributes, including peak size, peak area, peak height and peak score. Samples 
that exceed the specified Peak Comparison Threshold will be highlighted in yellow in the 
Comparison Report Table.
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Note: ‘Peak Comparison Threshold’ fields will be inactive unless the corresponding identifier is 
selected in the ‘Peak Compare Items’ section.

The Comparison Report Table displays the genotype report for each replicate, grouped by 
matched samples, as well as a final “consensus” genotype for each replicate group. Peaks that 
differ by more than the peak comparison thresholds set in the ‘Replicate Comparison Settings’ 
window are highlighted in yellow in the Comparison Report Table. Loci with peak identifiers that 
differ between replicates are marked with a D (discordant) and highlighted yellow in the Status 
column. 

Double-clicking on a cell within the table displays that marker in the electropherograms. 
Likewise, selecting a peak within the electropherogram will highlight the corresponding 
cell in the Report Table. Right-clicking on an allele in the electropherogram provides an 
abbreviated list of the same options available in the electropherogram of the ‘Main Analysis’ window 
(Section 5.B.3).

Table 26. Icons and Functions of the ‘Replicate Comparison’ Window.
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Replicate Comparison Settings: Opens the ‘Replicate Comparison 
Settings’ window where you can determine which parameters are used for 
comparison. These are the same settings available in the ‘Project 
Comparison’ tool (Section 12.B).
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Edit File Groups: Opens the File Name Group Editor to change group  
settings as necessary to better reflect the project file names (Section 12.A).
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Show Dye: Allows you to view all colors, hide all colors or choose any 
combination of dye layers by clicking on the down arrow. To cycle through 
individual dye channels, click on the icon.
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Zoom In: Zooms in on the center point of the electropherogram.

16
70

8T
A

Zoom Out: Zooms out from the center point of the electropherogram. 

16
71

0T
A

Set Axis: Provides options for setting the x and y axes of the 
electropherogram charts. The default setting automatically sets the y axis 
according to the maximum peak intensity of the samples (Auto Fit Y) and 
the x-axis analysis range (Auto Fit X). You can also set specific ranges for 
the x and y axes by selecting Fixed X and Fixed Y. 
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Browse by All Color: Opens the All Color Browser, which allows you to 
see the alignment of each separate dye trace for a given sample. Use the 
sample drop-down menu in the upper right corner to change samples. 

Open Charts Group: Opens the Electropherogram Charts of the first 
sample in each replicate group.16
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Table 26. Icons and Functions of the ‘Replicate Comparison’ Window (continued).

Comparison Report Table Icons
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Size Calibration: Opens the ‘Calibration Charts’ window, where you can 
review and edit size standard calibrations for the dataset (Section 7.B).
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Show Chart/Table: Displays the Peak Table below each electropherogram, 
which includes information such as peak size, height and user comments. 
Right-click on the table to modify the contents.

Save Report: Allows you to save the Comparison Report Table as a text 
(.txt) file. Select the arrow to switch between export formats. All exports 
contain a header with project and analysis information.

Whole Report: When selected, exports the entire Comparison Report Table.

Final Report: Exports a header, the Status column and the Final Genotype 
column only. 

Final Report With Only Valid Allele: Exports the final report but excludes 
markers with “None” selected as the final genotype (see below) from the 
export.

Note: You will receive a warning if you attempt to export the Comparison 
Report Table if discordant (D) allele calls are present. Select Yes to export 
the Report Table with discordant allele calls. Select No to return to the  
‘Replicate Comparison’ window to resolve discordant allele calls before 
exporting the Report Table.
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Sort Report: Allows sorting of replicate groups in the Comparison Report 
Table. Select the preferred sorting option from the drop-down, and then 
choose the Sort Report icon to apply the sorting. There are two sorting 
options:

Sort by Group Sequence: Sorts replicate groups according to their order in 
the Sample File Tree of the ‘Main Analysis’ window. 

Sort by Status: Sorts replicate pairs with discordant allele calls (D) or null 
allele calls (N) to the top of the Comparison Report Table. Concordant (C) 
replicate pairs appear at the bottom of the Comparison Report Table.
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12.C.2	 Performing a Replicate Comparison
Sample replicates within the same analyzed project file can be compared. Be sure to analyze 
and edit all samples to be compared before making replicate comparisons. Samples 
are grouped in the Comparison Report Table based on the file name grouping applied 
(Section 12.A). Each group is assigned the number displayed in the ‘No.’ column. The genotype 
for each replicate is displayed in two columns of the Comparison Report Table, one column for 
each allele at a locus. Results for the first replicate (Rep 1) are in the rightmost two columns, 
followed by the second replicate, etc. The final consensus genotype is displayed in the ‘Final 
Genotype’ column.

The ‘Status’ column in the Comparison Report Table displays the concordance status for each 
locus across all replicates within a group (Figure 214). The replicates can be designated as 
discordant (D), concordant (C) or null (N).

Status

C (Concordant): All match criteria are met across all replicates. The concordant genotype is 
displayed in the Final Genotype column.

D (Discordant): The software is unable to determine a consensus genotype, and the ‘Final 
Genotype’ column is left blank. The user can manually populate the final genotype at a locus by 
right-clicking on a cell and choosing an allele from the drop-down menu. The drop-down menu 
includes all alleles that were detected at that marker in all sample replicates. Alternatively, the 
user can choose None. If the user chooses one of the alleles, the status for the locus changes 
to E (Edit) to indicate the locus was manually changed. When exporting the results to a final 
report, markers designated as “None” are not exported if the Final Report with Valid Alleles 
Only option is selected (Table 26).

N (Null): One or more replicates have no allele calls at that locus. In cases where only one 
replicate has an allele call at a locus, the Final Genotype column is populated with the results 
from that one replicate.
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Figure 214. Example of a concordant locus, D16S539, within a replicate group.
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Disabling Entire Replicates

The ‘Replicate Comparison’ tool allows you to remove entire replicate groups from the 
comparison. Right-click the ‘Sample Name’ column of a replicate group and select Disable. 
Allele calls and the status of disabled replicates are colored dark gray (Figure 215). This 
process can be reversed by right-clicking the ‘Sample Name’ column and selecting Enable.

Disabled replicates are never exported, regardless of the reporting option selected. 
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Figure 215. Example of disabling a replicate group (top). Allele calls and the status of all disabled replicates are 
colored dark gray in the ‘Replicate Comparison’ window (bottom).
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13	�  
Validation Assistance Tools

The Validation Assistance tools allow you to perform calculations pertinent to internal 
validation of an STR chemistry. There are four calculations available in the Validation 
Assistance tool menu: LOD (limit of detection), stutter ratio, height ratio and migration 
precision, which are accessible via the ‘Tools’ menu of the ‘Main Analysis’ window (Section 6.E). 
Process data with the Run Wizard before using the Validation Assistance tools. Peaks cannot 
be edited from within the Validation Assistance tools. 

13.A.	 Performing an LOD Calculation

The LOD tool analyzes each sample in the dataset for the presence of noise peaks. Peaks 
recognized as alleles and/or stutter are excluded from this calculation. The software 
determines the LOD by calculating the average peak height (AVE.PH) and standard deviation 
(SD.PH) of observed noise peaks, and then adding a user defined number of standard 
deviations to the average. The number of standard deviations to apply to the calculation is 
selected using the LOD Equation icon in the toolbar (Table 27). 

To use the LOD tool, import and analyze the samples to be used for the LOD calculation. Select 
Validation Assistance then LOD from the ‘Tools’ menu of the ‘Main Analysis’ window. This 
opens the ‘LOD Settings’ window (Figure 216), which allows you to select the raw data analysis 
parameters (Section 4.B.1) to apply to the dataset when calculating the LOD. Select the same 
settings used to process the samples through the Run Wizard. 

Note: All Enabled samples in a project are used in the LOD calculation. To omit samples, such 
as ladders, from the LOD calculation, disable the sample(s) in the Sample File Tree (Section 3.C.1) 
before initiating the LOD tool. If a disabled ladder was used during the analysis of the dataset, 
you may be prompted to reprocess your samples. Select No.
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Figure 216. ‘LOD Settings’ window.
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An ‘LOD Process’ window opens and displays the progress of the calculation. When 
calculations are complete, select OK to display the ‘LOD’ window (Figure 217). The ‘LOD’ 
window contains a toolbar, electropherogram, Sample File Tree and LOD Report Table section.

Figure 217. 
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‘LOD’ window. 

The Sample File Tree and electropherogram function in the same manner as those in the ‘Main 
Analysis’ window (Sections 5.A and 5.B). When a sample is selected in the Sample File Tree, its 
electropherogram opens within the ‘LOD’ window (Figure 218).
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Figure 218. Example of an electropherogram opened in the ‘LOD’ window.
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The zoom and navigation features available in the electropherogram of the ‘Main Analysis’ 
window are also available in this field. There are two tabs to the LOD Report Table: Noise Peak 
and LOD Table (Figure 219).
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Figure 219. ‘Noise Peak’ and ‘LOD Table’ tabs of the LOD Report Table.

The ‘Noise Peak’ tab displays the peak height for each observed noise peak within each 
sample. The ‘LOD Table’ tab displays the average peak height and standard deviation for noise 
peaks, and the resulting LOD (based on the value selected in the toolbar), for each sample 
across all dye channels and the average peak height, standard deviation and LOD for each dye 
channel within each sample. The total average peak height, standard deviation and LOD across 
all samples for all dye channels as well as for each dye channel is displayed at the bottom of 
the ‘LOD Table’ tab.

Table 27. Icons and Functions of the ‘LOD’ Window.

Sample File Tree Icon
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LOD Settings: Opens the ‘LOD Settings’ window where you can specify 
which raw data analysis parameters are applied to the dataset when 
calculating LOD.

Electropherogram Chart Icons
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Show Dye: Allows you to view all colors, hide all colors or choose any 
combination of dye layers by clicking on the down arrow. To cycle 
through individual dye channels, click on the icon.
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Zoom In: Zooms in on the center point of the electropherogram.
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Zoom Out: Zooms out from the center point of the electropherogram. 

LOD Report Table Icons
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A Save: Allows you to save the LOD Report Table as a text (.txt) file. 
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LOD Equation: Displays the equation used in the LOD calculation.  
Select the desired number of standard deviations (SD) used to calculate 
the LOD using the up or down arrow.
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13.B.	 Performing Stutter Ratio Calculations

The Stutter Ratio tool analyzes the stutter for each allele at each marker for every sample in the 
data set for the N–x, N+x, N–0.5x, and N–0.5x positions. The number of stutter peaks detected 
at each position is displayed (Count).The maximum observed stutter ratio at each position 
at each marker in a sample is reported (Max). The average stutter ratio (Mean) and standard 
deviation (SD) for each position at each marker across the data set is also calculated.

Note: Partial stutter positions (N+0.5x and N–0.5x) are not calculated for trinucleotide and 
penta-nucleotide repeat markers.

To use the Stutter Ratio tool, import and analyze the samples to be used for the stutter ratio 
calculation. Note: Samples should be analyzed with all stutter filters set to zero in the applied 
panel editor. In addition, the peak detection thresholds may need to be lowered (e.g. 10RFU) to 
capture sufficient stutter data. Select Validation Assistance then Stutter Ratio from the Tools 
menu of the ‘Main Analysis’ window. This opens a ‘Stutter Ratio Process’ window that displays 
the progress of the calculation (Figure 220).

Figure 220. 

16
95

6T
A

‘Stutter Ratio Process...’ window.

When the calculations are complete, select OK to display the ‘Stutter Ratio’ window.

The ‘Stutter Ratio’ window displays a table of the calculated results (Figure 221). Cells with ** 
recorded indicate no stutter peak was detected at that position []. You can save this table as a 
tab-delimited text (.txt) file by selecting Save at the bottom of the window. To return to the main 
analysis window, select OK.
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Figure 221. 
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‘Stutter Ratio’ window.



218      GeneMarker®HID Software for Spectrum CE Systems | TM555 | Revised 1/23

Validation Assistance Tools

13.C.	 Performing Height Ratio Calculations 

The Height Ratio tool calculates the peak height ratio by comparing the peak heights of the two 
sister alleles at each marker. The ratio is expressed as the lower peak height of the two alleles 
divided by the higher peak height of the two alleles. The software then calculates the average 
peak height ratio (Ave HR), standard deviation (Std Dev) and minimum and maximum peak 
height ratios (Min HR, Max HR) observed at each marker across the dataset. The values are 
reported in the ‘Height Ratio’ window (Figure 222). 

Figure 222. 
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‘Height Ratio’ window.

To use the ‘Height Ratio’ tool, import and analyze the desired samples for the height ratio 
calculation. Select Validation Assistance then Height Ratio from the ‘Tools’ menu of the ‘Main 
Analysis’ window. This opens a ‘Height Ratio Process’ window (Figure 223), which displays the 
progress of the calculation.

Samples that are designated as allelic ladders (Sections 3.C.1 and 4.C.1) are not used in the 
calculations. When calculations are complete, select OK to display the ‘Height Ratio’ window 
(Figure 222). The ‘Height Ratio’ window displays a table of the calculated results. Cells with “**” 
indicate a marker with one or fewer called peaks. You can save this table as a text (.txt) file by 
selecting Save at the bottom of the window. To return to the ‘Main Analysis’ window, select Close.
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Figure 223. 
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‘Height Ratio Process’ window.

13.D.	 Performing Migration Precision Calculations

The ‘Migration Precision’ tool calculates sizing precision of alleles present in all allelic ladders 
within a dataset. The software reports the observed peak size (in base pairs) for each allelic 
ladder peak in the ‘Migration Precision’ window (Figure 224). The software then calculates the 
average size (Ave Migration) and standard deviation for each allelic ladder peak and marker  
(Std Dev Per Allele, Std Dev For The Marker) across the entire dataset. 

Figure 224. 
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‘Migration Precision’ window.
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To use the ‘Migration Precision’ tool, import and analyze the desired samples for the migration 
precision calculation. Ensure the desired allelic ladders are designated as ladders in the Sample 
File Tree (Sections 3.C.1 and 4.C.1). Select Validation Assistance then Migration Precision 
from the ‘Tools’ menu of the ‘Main Analysis’ window. This opens a ‘Migration Precision Process’ 
window (Figure 225), which displays the progress of the calculation. Samples that are not 
designated as allelic ladders are not used in the calculations.

Figure 225. 
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‘Migration Precision Process’ window.

When calculations are complete, select OK to display the ‘Migration Precision’ window  
(Figure 224). The ‘Migration Precision’ window displays a table of the calculated results. Cells 
with “**” indicate a bin with no peaks detected, typically a virtual bin.

Note: Peaks in virtual bins with higher-than-expected peak heights will be used in the 
calculation unless “Auto-Delete Alleles in Virtual Bins in Allelic Ladder” is selected in the 
‘Forensic’ tab of the ‘Preferences’ window (Section 6.B).

You can save this table as a text (.txt) file by selecting Save at the bottom of the window. To 
return to the ‘Main Analysis’ window, select Close.

	 Additional Information
For more information about GMHID-Spectrum, visit: www.promega.com/gmhid/

For information on the Spectrum CE Systems, visit: www.promega.com/spectrumsystem/

For more information on PowerPlex® Systems for amplification of STRs, visit:  
www.promega.com/products/forensic-dna-analysis-ce/str-amplification/

For Technical Services support, please contact your local Promega representative or:  
genetic@promega.com
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14	�  
Summary of Changes

The following changes were made to the 1/23 revision of this document:

1.	 Revised Sections 2.B and 2.C.

2.	 Updated images in Sections 4.A, 4.C and 8.A.

3.	 Inserted new Sections 4.C.6 Sample Quality Peak(s) and 10.A.4 Quality Indicators.

4.	 Updated Table 6 in Section 5.A.

5.	 Edited Sections 5.B.1, 5.E.2, 6.B.3, 6.B.4, 10.A and 13.

6.	 Inserted new Section 13.B Performing Stutter Ratio Calculations, and renumbered 
subsequent sections.

7.	 Moved document to a new template.



222      GeneMarker®HID Software for Spectrum CE Systems | TM555 | Revised 1/23

GeneMarkerHID is licensed by SoftGenetics, LLC, for use with the Promega Spectrum CE Systems. 

© 2021–2023 Promega Corporation. All Rights Reserved.

GenePrint and PowerPlex are registered trademarks of Promega Corporation. 

Applied Biosystems is a registered trademark of Applied Biosystems, LLC. GeneMapper is a registered trademark of Thermo Fisher Scientific. 
Excel, Microsoft and Windows are registered trademarks of Microsoft Corporation. GeneMarkerHID and SoftGenetics are registered trademarks 
and MaSTR is a trademark of SoftGenetics. STRMix is a trademark of the Institute of Environmental Science and Research Ltd. (ESR).

Products may be covered by pending or issued patents or may have certain limitations. Please visit our Web site for more information.

All prices and specifications are subject to change without prior notice.

Product claims are subject to change. Please contact Promega Technical Services or access the Promega online catalog for the most up-to-date 
information on Promega products.


	1 Description
	1.A.	Product Listing 

	2 Installing GeneMarker®HID Software for Spectrum CE Systems
	2.A.	Computer System Requirements
	2.B.	Installation and Licensing Options
	2.C.	Managing Program Template Files
	2.D.	Uninstalling the Software

	3 Preparing for STR Analysis
	3.A.	Getting Started: Overview
	3.B.	Importing Data Files
	3.C.	Raw Data Analysis

	4 Processing Data
	4.A.	Template Selection 
	4.B.	Data Process – HID Analysis 
	4.C.	Additional Settings - HID Analysis
	4.D.	Process Data

	5 Reviewing Processed Data
	5.A.	Navigating the Sample File Tree 
	5.B.	Navigating the Electropherograms with Peak Table
	5.C.	Navigating the ‘All Color Browser’ Window 
	5.D.	Navigating the Profile Comparison View
	5.E.	Navigating the Report Table
	5.F.	Re-Analyzing Processed Data

	6 Main Menu Options
	6.A.	‘File’ Menu
	6.B.	‘View’ Menu 
	6.C.	‘Project’ Menu 
	6.D.	‘Applications’ Menu 
	6.E.	‘Tools’ Menu 
	6.F.	‘Help’ Menu

	7 Fragment Sizing Standards
	7.A.	Navigating the Size Template Editor
	7.B.	Navigating the Calibration Charts

	8 Advanced Use of the Panel Editor
	8.A.	Navigating the Panel Editor
	8.B.	Editing Existing Panels
	8.C.	Adjusting Panels to Data—Manual and Automated Panel Calibration 
	8.D.	Custom Panel Creation

	9 Printing
	9.A.	Printing from the ‘Main Analysis’ Window
	9.B.	Printing from the All Color Browser
	9.C.	Printing from the ‘Calibration Charts’ Window
	9.D.	Printing from the ‘Show Edit History’ Window
	9.E.	Printing from the ‘User Manager’ Window

	10 Quality Assessment
	10.A.	Profile Quality
	10.B.	Contamination Check 

	11 Database Management
	11.A.	Submitting Genotypes to a Database
	11.B.	Database Editors

	12 File Name Grouping and Profile 
Comparisons
	12.A.	File Name Group Editor
	12.B.	Project Comparison Tool 
	12.C.	Replicate Comparison Tool 

	13 Validation Assistance Tools
	13.A.	Performing an LOD Calculation
	13.B.	Performing Stutter Ratio Calculations
	13.C.	Performing Height Ratio Calculations 
	13.D.	Performing Migration Precision Calculations

	14 Summary of Changes

